4.5 Science Software Integration and Test (SSI&T)

This section describes the tools used by DAAC operations personnel who are Science Software
Integration and Test (SSI&T) specialists. The function of SSI&T is to prepare the science
software received from the Instrument Teams for DAAC production. The tools that are available to
the specialist cover a broad spectrum. Some are COTS tools that fall into the category of “Office
Automation” such as spreadsheet and word processing packages. Others are COTS but are more
specialized, such as graphic display packages. All the COTS tools/products are documented in
separate product specific documentation. These tools are only identified in this section. Operators
will have to verify that COTS documentation matches the product version in use. Finally, there are
custom applications that are unique to the SSI&T activity. These tools are described in the
following subsections.
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4.5.1 Science Software Integration and Test (SSI&T) Manager

The SSI&T Manager is the starting point for use by the SSI&T specialist to check in and verify the
science software delivered by the instrument teams at the Science Computing Facilities (SCFs).
The SSI&T Manager application provides access to all COTS tools and custom applications that are
part of the SSI&T environment. The SSI&T Manager GUI is capable of kicking off instrument-
specific compilation and execution scripts, configuration management scripts, custom code
checking, file display and comparison tools, and COTS tools such as analysis environment
programs. The SSI&T Manager GUI contains a checklist of SSI&T steps in delivery and testing
of science software, and a display of a log file recording SSI&T events. The checklist and log are
the only inherent functionality to SSI&T Manager. All other programs run from the Manager can
also be invoked from the Unix command line.

The terms Process Control File (PCF) and Object Description Language (ODL) are used in the
following sections. The PCF is a file that tells an executable where to find its various inputs and
outputs, as well as the values for any specific runtime parameters. Different variants of these files
are used both by the SSI&T Manager and by PGEs. ODL is a “parameter = value” format for
input files. It is used to define the PGEs to the Planning and Data Processing Database.

Table 4.5.1-1 presents a summary of the capabilities provided via the SSI&T Manager GUI.

Table 4.5.1-1. Common ECS Operator Functions Performed through the
SSI&T Manager GUI (1 of 3)
Operating Command/Script Description When and Why to Use
Function or GUI
Prepare SSI&T | SSI&T Manager GUI * SSI&T Manager GUI e During normal SSI&T
checklist. requires a checklist that it operations, used to keep
can access. track of activities pending
« The checklist contains all and completed.
the operational » Checklist of operational
procedures for science procedures must first be
software integration and prepared using a text
test. editor.

* SSI&T Manager must then
be linked to the checklist
before invoked.

Change SSI&T | SSI&T Manager GUI e SSI&T Manager GUI » Update tracking of activities
Checklist. requires to change the pending and completed.
checklist. « Checklist of operational
» The checklist contains all procedures must first be
the operational prepared using a text
procedures for science editor.
software integration and « SSI&T Manager must then
test. be linked to the checklist
before invoked.
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Table 4.5.1-1. Common ECS Operator Functions Performed through the
SSI&T Manager GUI (2 of 3)
Operating Command/Script Description When and Why to Use
Function or GUI
Open xterm » Open xterm window via | Standard Unix command As needed for ad hoc use.

session.

Tools pull-down menu.

« Also can be opened
via Unix command
xterm.

line window.

Code analysis.

Select SPARCworks via
Tools: Code Analysis
pull-down menu.

Used for ad hoc analysis of
science software.

Used to debug problems
(e.g., memory leaks).

Check for Select the following via e Check FORTRAN 77 * To ensure that science
standards Tools: Standards science software. code conforms to ECS
compliance. Checkers pull-down e Check if certain functions standards.

menu: are used in the science » To ensure that the

e FORCHECK software which conflict delivered PCF is of the

e Prohibited Function with the production proper syntax.

Checker environment. » To extract prologs from
« Process Control File » Check the syntax of the science software.
(PCF) Checker data in the Process
« Prolog extractor Control File.
 Extract prologs from
science software.

Product select the following via Opened via Tools pull- < Ad-hoc graphical analysis.
Examination. Tools:Product down menu. « For viewing an arbitrary file

Examination pull-down (e.g., standard product) in

menu: HDF format.

<DL

* EOSView
File select the following via Compares the outputs of Ensures that the output that
Comparison. Tools: Product the science software was generated at the SCF

Examination File
Comparison

* ASCII files
 Binary files
« HDF files (GUI)
» HDF files (hdiff)

between the DAAC and
SCF.

when running the science
software is the same output
that is generated at the
DAAC.
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Table 4.5.1-1.

Common ECS Operator Functions Performed through the
SSI&T Manager GUI (3 of 3)

Tools: Data Server pull-
down menu:

1. Acquire DAP

2. Insert Static

3. Insert Test Dynamic
4. Insert EXE TAR

5. Edit SSAP

6. Get MCF

Archive Package (DAP).
2. Inserts static input file.
3. Inserts test dynamic
input file.

4. Inserts tar file with files
needed for processing.

5. Edits Science Software
Archive Package (SSAP)
components.

6. Acquires Metadata
Configuration Files (MCFs)
from the Data Server.

Operating Command/Script Description When and Why to Use
Function or GUI
Edit text. Select the following via Text editors. Edit arbitrary text file.
Tools: Text Editors pull-
down menu:
* Emacs
» Xedit
PDPS Select the following via  Creates an ODL file To initialize and update the
Database Tools: PDPS Database template from the Planning/Production (PDPS)
pull-down menu: science software PCF. databases:
 PCF ODL Template « Check the ODL file e SSI&T version
« Check ODL Files updates PGE and ESDT | «  Production version
« SSI&T Science SCIENCE metadata in the
Metadata Update PDPS /SSI&T database.
« SSI&T Operational * Updates PGE
Metadata Update GUI OPERAT'QNAL )
metadata via GUI in the
PDPS /SSI&T database.
Data Server Select the following via 1. Acquires Delivery 1. After DAP notification

received by email.

2. After ESDT is registered in
Data Server, before test PGE
run.

3. After ESDT is registered in
Data Server, before test PGE
run.

4. After PGE compilation,
before test PGE run.

5. After PGE testing is
complete, at time of
promotion to Production, as
needed to edit/review SSAP
components.

6. As needed to retrieve
MCF.

4.5.1.1 Quick Start Using SSI&T Manager

The SSI&T Manager provides a common interface to the SSI&T tools.
SSI&T Manager GUI is provided in Section 4.5.1.2.
accessed via this GUI from an ECS standpoint is provided in subsequent sections.

An overview of the

A more detailed discussion of the tools

Further

information on tools such as xedit, Emacs, ghostview, etc. can be found on the web by doing a
web search on “toolname manual”.

The following assumptions are made with regard to the use of the SSI&T Manager application:
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* The operator is located at a workstation or server to which the SSI&T Manager has been

configured

* The operator has proper authorization to access the PDPS/SSI&T database and the Data

Server

* Toaccess files in ClearCase, the operator has a ClearCase view already set

* The operator’s environment has been configured as documented in the pertinent sections of
the Help menu, available from the main window of the SSI&T Manager (see Figure 4.5.1-
1) The Index submenu of the Help menu provides access, through the Netscape browser,
to a number of topics that help the operator in the environment configuration. Refer to
section 4.5.1.2.10 for additional details on the Help Menu. A list of topics that can be
searched through the Help menu is shown in Figure 4.5.1-36.

To start SSI&T Manager at the Unix command line, enter:

$ECS_HOME/<mode>/custom/utilities/EcDpAtMgrStart<mode>

where:

mode is the ECS mode of operation, e.g., OPS, TS2

4.5.1.1.1.1 Sun Platform
Table 4.5.1-2 lists the SSI&T command line interfaces for the Sun workstation.

Table 4.5.1-2.

Command Line Interfaces (Sun) (1 of 3)

Command Line Interface

Description and Format

When and Why Used

EcDpAtMgrStart Startup script for SSI&T Manager. | To do SSI&T, and record items
accomplished in the log.
EcDpAtMgrLogDump Used to dump/print a log file to the | As needed.
screen.
xterm Open a Unix command line As needed.

window.
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Table 4.5.1-2.

Command Line Interfaces (Sun) (2 of 3)

Command Line Interface Description and Format When and Why Used

sparcworks Ad hoc code analysis As needed.

ghostview Postscript file viewer As needed.

netscape WWW browser Netscape As needed.

acroread PDF file viewer Adobe Acrobat As needed.

DpAtMgrForcheck FORTRAN 77 code analysis Determine whether FORTRAN 77
science software adheres to
standards.

EcDpAtBadFuncGui Prohibited function checker (GUI) | Determine whether science
software adheres to standards.

EcDpAtBadFunc Prohibited function checker Determine whether science

(command line) software adheres to standards.

EcDpAtCheckPCF Process Control File checker (GUI) | Determine whether PCF is valid.

EcDpAtMgrPrologs Prolog extractor Extract science software code
prologs.

/data/IDL/idl_4/bin/idl IDL As needed.

EOSView EOSView HDF file viewer.

EcDpAtMgrXdiff ASCII file comparison Compare 2 text files.

EcDpAtBInDiffGui Binary file difference environment | Compare 2 binary files.

DpAtCheckHdfFile HDF file comparison (GUI) Compare 2 HDF files.

DpAtHdiff HDF file comparison (command Compare 2 HDF files.

line)

xedit Text editor As needed.

emacs Text editor As needed.

EcDpAt CreateODLtmplate Create PGE metadata ODL Before running

template file. EcDpAtDefinePGE.
EcDpAtVerifyODL Verify PGE metadata ODL Before Running

template file. EcDpAtDefinePGE.

Update PDPS/SSI&T database Before executing PGE in SSI&T

EcDpAtDefinePGE with SCIENCE metadata. environment.

DpAtOpDbGui Update PDPS/SSI&T database Before executing PGE in SSI&T

with OPERATIONAL metadata. environment.
Acquires DAP from the Data After email subscription notification

EcDpAtStageDAP Server. received.

DpAtinsertStatic

Inserts static input file into the Data
Server.

Before executing PGE in SSI&T or
Production environment.

DpAtinsertTest

Inserts test dynamic input file into
the Data Server.

Before executing PGE in SSI&T
environment.
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Table 4.5.1-2. Command Line Interfaces (Sun) (3 of 3)

Command Line Interface Description and Format When and Why Used

DpAtinsertExeTar Inserts tar file of executables, etc. | Before executing PGE in SSI&T or
needed to run PGE file into the Production environment.
Data Server.

EcDpAtSSAPGuI Edit and inserts a single SSAP After SSI&T is finished, before
component into the Data Server. official promotion to Production.

netscape <html page name> HTML pages for acquiring SSAP During SSI&T, to get test outputs;
components from the Data Server, | After SSI&T is finished.
including test outputs.

EcDpAtaCQUIREMCF Get ESDT from the Data Server Before inserting MCF in the Data
and insert MCF. Server.

4.5.1.1.1.2 SGI Platform

It is intended that the SSI&T tools be most often run from the SSI&T Manager. A small number
of SSI&T tools run only on the SGI platform. Because of security considerations, these tools
cannot be run from the SSI&T Manager on the Sun. They may only be run from the Unix
command line on the SGI platform as indicated in Table 4.5.1-3.

Table 4.5.1-3. Command Line Interfaces (SGl)

Command Line Description and Format When and Why Used
Interface
usr/shin/cvproj ProDev Workshop: Used for ad Used to determine causes of problems (e.g.,
hoc analysis of science software. | memory leaks).

DpAtRusage Measures PGE performance. Output of this tool is to be typed into the
“Performance Statistics” section of the
PROFILE screen of the PDPS/SSI&T
Database Update GUI.

Table 4.5.1-4 lists SGI platform tools associated with the SSI&T process.
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Table 4.5.1-4.

SGI Tools Description

Categories/

Tool Description & Use

Further Information

Tools
ProDev « ProDev Workshop is a COTS package developed e ProDev Workshop includes
Workshop by SGI online documentation
« This tool is targeted within ECS for applications describing its features
running on the SGI science processors = Other ProDev Workshop
« ProDev Workshop is a software development documentation is delivered
support tool which includes several tools that may with ECS.
have applicability to SSI&T * ProDev Workshop is not
« Among these tools is the capability to perform static available from the SSI&T
code analysis to aid in the detection of memory menu. This tool must be
leaks started from the Command
Line Interface: see Table
4.5.1-3.
PGE * DpAtRusage is a custom tool developed by ECS A help message is printed if the
Performance tool is invoked without input

« It measures performance parameters such as CPU
time used for a PGE linked to the SDP Toolkit, SCF
version.

parameters.

4.5.1.2 SSI&T Manager

Figure 4.5.1-1 illustrates the SSI&T Manager.
activities. It provides access to a collection of tools that are used in the SSI&T process.

This screen is the starting point for SSI&T

The

procedures for SSI&T using these tools are defined in other documentation in conjunction with the
DAAC SSI&T personnel and the instrument teams.
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Receive and process the delivery
Enable deliver script
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Figure 4.5.1-1.

SSI&T Manager Main Screen

The SSI&T Manager Window includes two windows of information, a menu bar at the top of the
screen, and two buttons at the bottom of the window.
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The Checklist Window

The top window is the SSI&T Checklist. This lists a configurable set of steps to be completed
during the SSI&T process. It is displayed as a line of text for each item, with a check box that is
checked or unchecked. A checklist may be tailored specifically to a science software suite being
delivered. The checklist is manual, in that the operator must check it with a mouse click. The
checklist is configurable by editing a checklist text file as explained under the Checklist topic of
Help/Index menu.

The SSI&T Log Window

The lower window is a log of activities accomplished in the SSI&T process. As steps in the
process are accomplished, a log entry is automatically added. Each time a box on the checklist is
checked or unchecked, the log is updated. The user is required to annotate any changes.

The Menu Bar

The menu bar includes a simple selection of options:

e File - Offers the option to exit from the SSI&T Manager application.

* Tools - Provides access to a collection of tools that are of use in the SSI&T process. The
tools that are available are described in the following section.

* Run - User-customizable menu, intended for programs such as scripts to run science
software.

* Help - Provides context-sensitive help.
SSI&T Manager Buttons

There are also two buttons at the bottom of the screen.

e Edit - The checklist items may be edited by the SSI&T specialist to include additional detail
on the SSI&T process. Clicking the Edit button brings up the text editor for this purpose.

e Change State - This toggle button allows the SSI&T specialist to switch between
“checked” and “unchecked” for the selected checklist item.

4.5.1.2.1 SSI&T Manager Tools

There are several tools that are accessible through the SSI&T Manager. After selecting the Tools
menu, a set of options is presented as shown in Figure 4.5.1-2.

The first item on the list, the Xterm option, will start an Xterm window session. Selecting any of
the other options displays a secondary list of particular tools within that category.

Many of the items accessed through the Tools menu are COTS products for which documentation
exists. Some items are custom applications from other ECS subsystems (e.g., EOSView). The
complete description and documentation for these items is provided in other parts of this document.
The remaining items are custom applications and are described in the following subsections. Note,
since SSI&T is a collection of various tools, there is no specific order in which they must be run.
Most tools can be brought up from the SSI&T Manager Main screen as well as be started on their
own. The File menu provides the capability to exit the manager, and the Tools menu gives access
to variou tools that make up SSI&T.
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Figure 4.5.1-2. SSI&T Manager Main Screen - Tools Menu

Table 4.5.1-5 describes the SSI&T Manager Tools.
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Table 4.5.1-5.

SSI&T Manager Tools Description (1 of 5)

Category Tools Tool Description & Use Further Information
UNIX Access | Xterm This tool’s option allows the operator | Unix documentation is available
to open an Xterm window and enter | online via ‘man’ command.
Unix commands, as needed.
The other SSI&T Manager windows
remain available while an Xterm
window is open.
Code SPARCworks | SPARCworks is a COTS package * SPARCworks includes online
Analysis developed by Sun Micro Systems documentation describing its
Selecting this option from the Tools features
list will start the SPARCworks tool e Other SPARCworks
which opens a separate window. documentation is delivered with
Among the tools that are available in ECS. This documentation
SPARCworks is the code analysis includes:
tool which allows for static code - SPARCworks Browsing
analysis to aid in detecting memory Source Code
leaks. - SPARCworksDebugging a
For the SGI systems the ProDev Program 3.0.1
Workshop product provides similar - SPARCworks Tutorial
functionality. 3.0.1SPARCworks
Performance Tuning an
Application 3.0.1
Office GhostView Selecting Ghostview from the Tools | Ghostview includes online
Automation menu item starts the Ghostview documentation on its use.
application. Since this is a freeware product,
Ghostview is a freeware tool. there is no other documentation
This is used for displaying Postscript | provided by ECS for Ghostview.
format files.
Netscape Netscape is a COTS package Documentation on Netscape is

developed by Netscape Corp.

This tool is a ‘Browser’ which is used
to access Internet WWW web sites.

EOSDIS has adopted the WWW and
Netscape as an internal standard for
the publication and exchange of
various types of documentation,
schedules, etc.

ECS documentation is available
through the WWW, including
documentation related to SSI&T.

available online.

Documentation on ECS use of
Netscape is available in this
document in Section 4.12.3,
Netscape Communicator, and
4.12.4, Netscape Enterprise
Server.
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Table 4.5.1-5. SSI&T Manager Tools Description (2 of 5)
Category Tools Tool Description & Use Further Information
Acrobat Adobe Acrobat Reader is a COTS Documentation on Adobe
package developed by Adobe Acrobat products is available
Systems Inc. online.
This product is used to view Other documentation for this
electronic documents that have application is delivered with ECS.
been created in the Portable
Document Format (PDF) file format.
Many of the ECS documents have
been created or converted to this
format.
Standards FORCHECK FORCHECK is a COTS tool used to Documentation on FORCHECK is
Checkers verify that software follows certain available online.
coding standards. Other documentation for this
FORCHECK will analyze source application is delivered with ECS.
code that is written in Fortran 77 with | This includes FORCHECK for
ANSI extensions. Sun/SunOS, A Fortran Verifier
When selected from the SSI&T and Programming Aid, User
Manager window, and xterm window | Guide.
is created in which the program runs.
There is no GUI associated with
FORCHECK.
Note that FORCHECK is configured
to check for the non-ANSI
FORTRAN 77 extensions which are
approved for use in ECS science
code, according to “Data Production
and SCF Standards and Guidelines.”
Prohibited The Prohibited Function Checker is | On-line help is provided with the
Function a custom application used to Prohibited Function Checker
Checker determine if the science software A description of the use of the
has been developed using coding | tool is provided in the following
standards established by the ESDIS | sections.
Project (*Data Production and SCF | 1 tool is described in detail in
Standards and Guidelines”) in section 4.5.1.2.4.2.
conjunction with the instrument
teams responsible for developing
the software.
These coding standards are limited
to prohibitions against the use of
certain types of functions that may
cause problems in the production
environment.
The Prohibited Function Checker
checks for functions defined in a
science software source code.
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Table 4.5.1-5.

SSI&T Manager Tools Description (3 of 5)

Category Tools Tool Description & Use Further Information
Standards Process The Process Control File (PCF) On-line help is provided with the
Checkers Control File checker is a custom application used | PCF Checker.

Checker to verify that the format of the PCF is | A description of the use of the
correct. tool is provided in the following
A PCF is a part of the delivered sections.
science software delivery package. | Note that this tool consists of a
The PCF specifies the names and GUI front end added to an ECS
locations of files used by the science | SDP Toolkit utility.
software executables, and defines Documentation of the utility is
the correspondence between (1) found in the SDP Toolkit Users
the file specifications and (2) the Guide for the ECS Project.
logical identifiers used by the This tool is described in detail in
science software to reference the section 4.5.1.2.5.3.
specified files.

Prolog Custom application which extracts Online help is provided.

extractor code prologs from science software.

Product IDL IDL (Interactive Data Language) is a Documentation on IDL is available
Examination COTS product, developed by online.

Research Systems Inc. Other documentation for this
It is used to interactively visualize applications is delivered with
and analyze scientific and ECS.
engineering data products.
IDL can be used with data files of an
arbitrary format.

EOSView EOSView is a custom application Documentation on EOSView is

used to display HDF format files and
the metadata associated with those
files.

EOSView is expected to be primarily
by the EOS scientific community,
but will also be used by the
operations community to support
the SSI&T process (for file
inspection, etc.) and by the DAAC
quality assurance groups to view and
analyze problems arising from
production operations.

available online.
EOSView is integral with the ECS

Desktop; for more information,
see Section 4.12.5, “EOSView".
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Table 4.5.1-5. SSI&T Manager Tools Description (4 of 5)

Category Tools Tool Description & Use Further Information
Product File File comparison tools, which are Documentation on the file
Examination | Comparison custom products of ECS, are comparison tools is available

provided with the SSI&T Manager. online.

Tools are provided to support file These tools are described more
comparison in three different fully in following subsections of
formats: ASCII, Binary, and HDF. this document.

These tools would be used by the
SSI&T Specialists to compare the
benchmark data products generated
at the SCFs with the data products
generated as a part of the SSI&T
process at the DAAC.

All standard data products will be
produced in HDF format, for which
the HDF file comparison utility will be
used.

For intermediate or other data
products that may not adhere to the
standards, the binary or ASCII file
comparison tools may be used.

In the case of binary files, the DAAC
operator must write code to do the
comparison, for which a support
environment is provided.

Text Emacs Emacs is a freeware text editing tool | Documentation on Emacs is

Editors most frequently used by the SSI&T | available online.
specialists in developing scripts or Since this is a freeware product,
ad hoc programs to be run in the there is no other documentation
SSI&T environment. provided by ECS.

Xedit Xedit is a freeware text editing tool Xedit includes online

most frequently used by the SSI&T | documentation on its use
specialists in developing scripts or Since this is a freeware product,
ad hoc programs to be run in the there is no other documentation
SSI&T environment. provided by ECS.

PDPS PCF ODL Creates a PDPS PGE SCIENCE This tool is described in detail in

Database Template metadata ODL file from a science section 4.5.1.2.8.1.

software PCF.

Check ODL Parses ODL file and records errors. This tool is described in detail in
This tool accesses the PDPS DB for | section 4.5.1.2.8.2.
information on PGE/ESDT whose
ODL is already available.

SSI&T Updates PDPS/SSI&T database with | This tool is described in detail in
Science PGE and ESDT SCIENCE metadata | section 4.5.1.2.8.3.

Metadata read from ODL files.

Update

4.5.1-14 609-CD-600-001




Table 4.5.1-5. SSI&T Manager Tools Description (5 of 5)
Category Tools Tool Description & Use Further Information
SSI&T Updates PDPS/SSI&T database with | This tool is described in detail in
Operational PGE OPERATIONAL metadata input | the following 4.5.1.2.8.4 section.
Metadata by user.
Update GUI
Data Server | Acquire DAP | Acquires a DAP from the Data This tool is described in detail in
Server. section 4.5.1.2.9.1.
Get MCF Gets information about the ESDT This tool is described in detail in

the MCF is acquired for and interface
with the Data Server to get the
desired MCF.

section 4.5.1.2.9.2.

Insert Static

Inserts a static input file to the Data
Server.

This tool is described in detail in
section 4.5.1.2.9.3.

Insert Test Inserts a test dynamic input file to the | This tool is described in detail in
Dynamic Data Server. section 4.5.1.2.9.4,
Insert EXE Inserts tar file of executables, etc. This tool is described in detail in
TAR needed to run science software to section 4.5.1.2.9.5.

the Data Server.
SSAP Editor Read/Write Metadata and record This tool is described in detail in

errors.

section 4.5.1.2.9.6.

4.5.1.2.2Xterm

Xterm is a COTS product that activates an Xterm window. This allows the operator to use the
Unix environment and resources from a PC. The Xterm window as shown in Figure 4.5.1-3 has
all the properties of a PC window while the “screen” portion is essentially a Unix terminal. The
user will need environment parameters for the PC, such as the IP Address, to use Xterm.

There is no submenu for the Xterm menu.
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Figure 4.5.1-3. Xterm Unix Terminal Window

4.5.1.2.3Code Analysis

The Code Analysis menu as shown in Figure 4.5.1-4 provides the SPARCworks tool to assist in
analyzing C code.
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Figure 4.5.1-4. SSI&T Manager Main Screen with Code Analysis
Tool Menu Displayed

451.2.3.1 SPARCworks

SPARCworks is a COTS product. This function is not documented for operators. Analysis of the
program code in the operational environment will result in significant performance reduction.
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4.5.1.2.4 Office Automation

The Office Automation menu as shown in Figure 4.5.1-5 provides tools to assist operators in

documentation and administrative tasks.
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Figure 4.5.1-5. SSI&T Manager Main Screen with Office Automation
tool menu displayed

4.5.1-18 609-CD-600-001




45.1.2.4.1 GhostView

GhostView is a COTS product. GhostView as shown in Figure 4.5.1-6 provides the operator
with a tool for viewing and editing graphics files. The popular PostScript format (.ps) is used to
capture screen images and other pictures used in documentation. The operation of this tool follows
standard PC application rules. Images displayed in GhostView may be cut & pasted into MS

Word C_ddcuments.

More information about GhostView is available on the Web free from the URL,
“ftp://prep.ai.mit.edu/pub/gnu/”
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Figure 4.5.1-6. GhostView Main Screen
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4.5.1.2.4.2 Netscape

Netscape is a COTS product. Netscape is the project Internet Browser, it is described in section
4.12.3, “Netscape Communicator”.

4.5.1.2.4.3 Acrobat

Acrobat is a COTS product. Adobe Acrobat is a documentation package oriented to storing data as
graphics files. The main window is shown in Figure 4.5.1-7. The package is geared to fast
printing by not requiring translation of text files to printer format. The popular Acrobat (.pdf) file
format is native to this package. Images or text displayed in Acrobat may be cut & pasted into

Word [C_ddcuments.

More information about Acrobat is available on the Web free from http://www.adobe.com/.

F

e e e B R T e e T

Figure 4.5.1-7. Acrobat Main Screen
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4.5.1.2.5 Standards Checkers

The Standards Checkers menu shown in Figure 4.5.1-8 provides tools to assist operators in
validating DAPs.

~2 55IT Manager

Figure 4.5.1-8. SSI&T Manager, Tools Menu, Standards Checker
Submenu Choices

4.5.1.2.5.1 FORCHECK

FORCHECK, shown in figure 4.5.1-9, is a COTS tool that checks science software written in
FORTRAN 77. FORCHECK may be configured to determine whether the ANSI FORTRAN 77
extensions used in science software are allowed by the official NASA/ESDIS standard. The
NASA/ESDIS standards are implemented through use of a FORCHECK configuration file, which
is pointed to by the SFCKCNF parameter. Note: FORCHECK does not process FORTRAN 90
code.

FORCHECK does not have a GUI, it is command line driven. The FORCHECK interface is via a
spawned Xterm window.
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Figure 4.5.1-9. FORCHECK Program Running in an Xterm Window

When invoked, FORCHECK produces a query prompt to solicit changes to the default global
options and the list (output) file. The default output file is the UNIX stout file, normally
configured as the Xterm window. FORCHECK provides numerous Global and Local options to
tailor the code analysis and the resulting output. See the FORCHECK for Sun/SunOS A Fortran
Verifier and Programming Aid version 12 User's Guide for more information.

4.5.1.2.5.2 Prohibited Function Checker

The document, Data Production Software and Science Computing Facility (SCF) Standards and
Guidelines, Revision A, October 1996 (423-16-01), mandates that science software delivered to
the DAACs for integration into the ECS should be free of prohibited functions which may cause
errors in the production environment. The Prohibited Function Checker (PFC) is an SSI&T tool
that offers a GUI interface to check source code for prohibited function calls.

The PFC GUI provides the following functionality:
« Allows the user to select file(s) to be checked for presence of prohibited functions.
e Provides a toolkit to scan program and text files for prohibited functions.
e Writes output to a log.

e Allows the user to scan through any prohibited functions found.
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Table 4.5.1-6 lists the language and associated file extensions that can be checked for prohibited
function calls using the PFC Tool.

Table 4.5.1-6. File Name Extensions

Language File Name Extensions
Ada .a, .ada
C .C, .h
C++ .CcC
Fortran 77 g, 77, ftn, .inc
Fortran 90 .foo0
C shell .csh
Korn shell .kh
Bourne Shell .sh
Perl .pl
Text files ixt

4.5.1.2.5.2.1 Checking for Prohibited Functions

From the SSI&T Manager Main Screen (Figure 4.5.1-8), select the Tools->Standards
Checkers->Prohibited Function Checker option to bring up the screen shown in Figure
4.5.1-10. This displays the Prohibited Function Checker Pop-up.
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Figure 4.5.1-10. Prohibited Function Checker Pop-up

Table 4.5.1-7 describes the fields on the Prohibited Function Checker Pop-up.

Table 4.5.1-7 Prohibited Function Checker Pop-up Field Descriptions

(1 of 2)
Field Name Data Description
Type
Analyze button Clicking the Analyze button brings up the File Selector Pop-up for

selecting files to be checked for prohibited functionality. Following
selection of files and analysis, the files containing prohibited
functionality are listed in the data area of the Prohibited Function
Checker pop-up window.

View button Highlighting a particular file in the data area of the window and then
clicking the View button brings up the Source Code Pop-up
window shown in Figure 4.5.1-12. Prohibited functionality found in
the file is highlighted.

Report button Clicking the Report button brings up the Report Pop-up shown in
figure 4.5.1.13. This window allows for displau/printing of a
summary of the prohibited functionality found.
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Table 4.5.1-7 Prohibited Function Checker Pop-up Field Descriptions

(2 of 2)
Field Name Data Description
Type
data area file names | The untitled large blank area in the Prohibited Function
containing a Checker window contains a list of those files analyzed and
list of files found to contain prohibited functionality.
that contain
prohibited
functions
Quit Button Clicking Quit terminates the Prohibited Function Checker.
Help Button The Help button brings up the Help Pop-up for obtaining an
explanation of the use of this tool.

The File Selector pop-up, shown in Figure 4.5.1-11, is brought up when the user hits the
Analyze button on the Prohibited Function Checker pop-up. With the File Selector pop-up, the
user specifies a list of the files to be checked for the presence of prohibited functionality.
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Figure 4.5.1-11. File Selector Pop-up

Table 4.5.1-8 describes the fields on the File Selector pop-up window.
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Table 4.5.1-8. File Selector Pop-up Field Descriptions

Field Name Data Type Description
Directory: directory name | User enters the name of the directory where files to be
checked for prohibited functions are located.
Directories: list of Displays the list of subdirectories within the current
directories directory. Double clicking on a subdirectory results in
moving into that directory and displaying its
subdirectories in the Directories field and its file content
in the Files field.
Files: file names Contains the list of files within the currently selected
within directory | directory. Clicking on a listed file designates it for
analysis and moves it to the Selections field. To
choose groups of contiguous files, hold down the left
mouse button and drag downward. To choose non-
contiguous files, hold down the Ctrl key while clicking
on desired file names.
Selections: list of file Contains the list of files selected for analysis.
names
Ok button On building the list of files to be analyzed, click on the
Ok button to initiate analysis. The File Selector pop-up
disappears and the Prohibited Function Checker pop-
up appears with the list of files checked and found with
prohibited functionality present.
Cancel button To abort the building of a list of files to be analyzed,
click on the Cancel button.
Help button Brings up a Help window explaining File Selector
operation.

Following selection of the file(s) to be analyzed and clicking Ok, the File Selector pop-up
disappears, the prohibited function analysis is performed on each source file, and the list of
selected files found to contain prohibited functions is displayed on the Prohibited Function Checker

Pop-up.

The results of the Prohibited Function Checker can be examined using the View button (only one
source file can be selected at a time to view the code) or Report button. To initiate a view,
highlight one of the files listed and click on the View button. The Source Code pop-up, shown in
Figure 4.5.1-12, appears.
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Figure 4.5.1-12. Source Code Pop-up

As shown in the Source Code pop-up, occurrences of prohibited functions found in the source
code are highlighted. Click on the Next button to bring into the window successive occurrences
of prohibited functions within the same source file. Click on the Done button to close the Source
Code pop-up. All prohibited functions can be viewed similarly, by examining one source file at a
time.

Use the Report button on the Prohibited Function Checker pop-up to display the Report Pop-up
shown in Figure 4.5.1-13. It displays for each source file, a list of prohibited functions found.
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Figure 4.5.1-13. Report Pop-up

The results of the prohibited function analysis showing prohibited functions can be saved or
printed from the Report Pop-up.

Clicking on the Save button brings up the Save To File Pop-up for specifying where to save the
report.

Clicking on the Print button prints the results on the default printer.
The Help button within any window brings up the HELP pop-up explaining the use of the
window.

4.5.1.2.5.3 Process Control File Checker

This section describes how the Process Control File (PCF) Checker tool is used by the SSI&T
Specialist during the SSI&T process.

The PCF Checker verifies that the PCF provided by the Science Software development teams, as
part of the DAP (Delivery Archive Package), is syntactically correct.

Before this program is used, the following condition must be met:

The PCFs to be checked are available, accessible, and have read permission for the user.

4.5.1.2.5.3.1 Process Control File Checker

The PCF Checker POP-UP allows the user to select a PCF and have it scanned by Science Data
Processing (SDP) Toolkit routines for any irregularities such as format or structure.
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4.5.1.2.5.3.2 Quick Start Using This Tool

The Process Control File (PCF) Checker tool, shown in Figure 4.5.1-14, is started from the
SSI&T Manager by selecting the Tools-> Standards Checker-> Process ControlFile
Checkeroption as shown in Figure 4.5.1-8.

>+ Process Control File Checker

Filter

/usr/ecs/RCCLABSDPS/CUSTOH/data/DPs/%

Directories Files

T - |sToM/data/DPS/DpAtMgrBinDiffTemplate.sh |-
a/DPs/ . . STOM/data/DPS/DpAtMgrBinDiffTemplateDri
a/DPS/helpFiles STOM/data/DPS/DpaAtMgrBinDiffTemplateDri:
a/DPs/0DL STOM/data/DPS/DpaAtMgrBinDiffTemplateDri

a,/DPS/ResourceCatalogs 8TOM/data/DPS/DpAtMgrcheckHdfFile . defau
STOM/data/DP3/DpAtMgrCheckHdfFile. hlp
STOM/data/DP3/DpAtMgrCheckHdfFile. pro
STow/data/bps/bpattigrinternal pof____ I
STOM/data/DP3/DpAtHgrInternal . pef. templ:
8TOM/data/DPS/DpPrEmFailPgeMetFile
STOM/data/DPS/ESDT_ODL.template
8TOM/data/DP3/0ORBIT_ODL.template

¥ ]
= JE—— [ i =

PCF To Check
/usr/ecs/RCCLAB30PS/CUSTOM/data/DPS/DpAtMgrinternal . pef]

Check PCFl Filter | Cancel | Help |

Figure 4.5.1-14. PCF Checker Pop-up

Table 4.5.1-9 describes the PCF Checker’s fields.
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Table 4.5.1-9.

PCF Checker Field Description

Field Name [Data Type| Size Entry Description

Filter ASCII N/A Read from configuration | Displays the selected directory

characters file/ user input (from the Directories field).
(optional).

Directories ASCII N/A Read from database. Displays the existing directories in
characters the database.

Files ASCII N/A Read from database Displays the files existing in the
characters (local disk). selected directory.

PCF To Check ASCII N/A Read from database Displays the selected file to be
characters (Iocal dISk) checked.

The PCF Pop-up allows the user to work through the directory structure on the local machine in
order to select PCFs to be checked, by selecting the desired directory in the Directories window.
The Filter window allows users to limit the files that are displayed. From the File window, the
user can select the PCF file to be checked. Only one PCF can be checked at a time. Selecting the
Check PCF button initiates the checking process on the PCF specified in the PCF To Check
window. The result is displayed in a Pop-up labeled PCF Checker Results, Figure 4.5.1-15.

If the selected file does not exist, an error dialog is displayed to inform the user. Similarly, if the
specified PCF exists but can not be opened, an error dialog pops up to inform the user. Dialogs
also pop up to inform the user of any fatal system errors or errors encountered in calls to toolkit

functions.
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~ PCF Checker Results

Figure 4.5.1-15. PCF Checker Results Pop-up

From the PCF Check Result Pop-up the user has options to save the results to a file, send the
results to the default printer, check another PCF, or quit the Results Pop-up. Selecting the Save
button will bring up a pop-up labeled Save (shown in Figure 4.5.1-16) that allows the user to
specify the directory and file name in which to save the results file.
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Figure 4.5.1-16. The PCF Checker Save Pop-up

The PCF Check Save window displays a default output directory and its contents on the file
selector. The description fields of the Save Pop-up are identical to the PCF Checker Pop-up’s (see
table 4.5.1-14). The user may select a listed file or may enter his/her own selection. Selecting the
Filter button brings up another screen that allows the user to limit the number of files listed. Figure
4.5.1-17 shows the filter screen.
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Figure 4.5.1-17. The Pop-up Display for Filtering Files from the
Save Pop-up

Messages are displayed to inform the user of successful/ unsuccessful completion of save
operations.

The Cancel button terminates the running (open) application.

The Help button in all of the PCF Checker Pop-ups provides a description of all the functional
buttons for the pop-up. For example, Figure 4.5.1-18 shows the Help on PCF Checker Results

screen.
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Figure 4.5.1-18. The Help on PCF Checker Results Pop-up.

4.5.1.2.5.4 Prolog Extractor

The Prolog Extractor extracts prologs from science software source code modules.
By default, these prologs are assumed to be surrounded by standard delimiters, according to the

official NASA/ESDIS standards document, Data Production Software and Science Computing

Facility (SCF) Standards and Guidelines, Rev A, October 1996, 423-16-01. The starting
delimiters are listed in Table 4.5.1-10.
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Table 4.5.1-10. Prolog Extractor standard delimiters

Language Type Delimiter
FORTRAN 77 source IF77
FORTRAN 90 source IF90
C source IC
Ada source IADA
FORTRAN 77 include IF77-INC
FORTRAN 90 include IF90-INC
C include IC-INC
any language any IPROLOG

The end delimiter is always 'END.
Other delimiters may be specified through use of command line flags (see below).

The Prolog Extractor program will return a warning if the module contains no prologs at all. It

does not warn of functions within a particular file that are missing prologs.

In order for this tool to work, the file must have one of the file extensions listed in Table 4.5.1-11.

Table 4.5.1-11.

Prolog Extractor file extensions

Language extension
FORTRANTY7: f, f77, ftn, for, F, F77, FTN, FOR
FORTRANO9O0: fo0, FOO, f, F
FTN. INCLUDE: inc, INC
C: C
C include h
Ada: a, ada

The Prolog Extractor is invoked from the SSI&T Manager under the TOOLS menu item Standards
Checkers.

Output from this tool is always written to a file.

By default, the SSI&T Manager internal PCF specifies that this output file be named prologs.txt in
the local directory. You may change this by editing the internal PCF, item #650.

The PCF value of the output filename is overridden by the "-0" option on the command line.

45.1.2.6 Product Examination

Product examination tools are used to view, examine, or compare files used in science processing.
Figure 4.5.1-19 shows the Product Examination tool menu options on the SSI&T Manager Main
screen. These tools assist in the maintenance of the science software by allowing the operator to
view programs in different languages, view science data, or compare program or data output files.
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Figure 4.5.1-19. SSI&T Manager Main Screen with Product Examination
Tools Displayed

4.5.1.2.6.1 IDL

IDL does not provide a GUI. IDL is a powerful visualization package in common use throughout
the science community. This COTS package includes a language, also called IDL, that provides
capabilities for data visualization and comparison of various file formats. IDL is provided so that
DAAC operators can write data visualization and comparison tools, and execute them on an "as
needed" basis.

The IDL language is an interpreted computer language, allowing applications (written in IDL) to
look at binary (unformatted) files as well as HDF files.

Once inside this environment, user written programs can be compiled and executed.

Documentation for IDL is obtained by typing idlhelp on the UNIX command line.
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4.5.1.2.6.2 EOSView

EOSView is a custom Hierarchical Data Format (HDF) file verification tool. It is for use by
anyone who wishes to verify or inspect EOS data products in HDF EOS or HDF format. Users
include EOS instrument team science software developers and data product designers, DAAC
personnel, and end users of EOS data products, i.e., scientists and researchers.

EOSView is described in Section 4.12.5, “EOSView”.

4.5.1.2.6.3 File Comparison Tools

This section describes how the File Comparison tools are used by the SSI&T specialist during the
SSI&T process.

The File Comparison tools are selected from the Tools item on the menu bar, and appear under the
Product Examination option. Four alternatives are then offered:

e ASCII - Text file comparison tool; X windows based xdiff utility

e Binary — Custom development environment which assists in the generation of DAAC-written
code which compares binary files

e HDF (GUI) -- IDL program which compares HDF format files

e HDF(hdiff) — “hdiff” CHUI (CHaracter oriented User Interface) utility which compares HDF
format files, written by MODIS

These tools would be most frequently used to insure that the data products generated from the
PGEs run in the SSI&T environment are identical (within tolerance) to the files that were produced
by the PGEs at the SCF.

4.5.1.2.6.3.1 ASCIl File Comparison Tool

When the ASCII File Comparison tool is started by selecting the Tools->Product
Examination->Eile Comparison->ASCII menu option from the SSI&T Manager, an Xterm
is spawned, which prompts the user for input. The user enters two ASCII filenames, and the
differences between the files are displayed. The comparison tool is based on the X-Window
application, “xdiff”.

4.5.1.2.6.3.2 Binary File Difference Environment

When the Binary File Difference Environment is started by selecting the Tools->Product
Examination->Eile Comparison->Binary menu option from the SSI&T Manager, the pop-
up shown in Figure 4.5.1-20 is displayed. The button functions are described below in the order
they should be used.
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Figure 4.5.1-20. Binary File Comparison Pop-up
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The Binary File Difference Assistant assists the user in development of custom code that compares
two binary files.

Since there is an unwieldy number of possibilities for binary file formats, this tool cannot compare
two binary files without some custom code written at the DAAC, hence, the “Assistant” in the
name.

e The Select Language box provides a choice of languages.
e The choice depends largely on preference.

» It does not necessarily have to be the language that was used to create the files being compared.
The user clicks “COPY” to generate three files: a main driver code module, a template
comparison code module, and a makefile in the selected language [C, FORTRAN 77 or IDL
(Interactive Data Language)].

e The operator then edits this template to add code that compares files for the specific binary file
format, compiles the code, and executes it as appropriate; these operations are all independent
of the pop-up.

The Code Examples section of the pop-up displays simple code examples that do binary file
comparison. The operator may copy and paste these in their code if desired. Examples have been
compiled and tested. This sample code is provided to help the operator in visualizing a completed
comparison module. This code is displayed when the user presses one of the “Compare
Function” buttons, either Image or Structure. Image displays an example of binary_file
comparison code for files containing images. Structure displays an example of binary file
comparison code for files containing arrays of structures, or records.

Also provided is sample driver code, when the operator presses a Driver button. Finally, code for
a simple compare utility is provided for reference, when the user presses cmp.

4.5.1.2.6.3.3 HDF GUI

All the ECS standard data products are generated in HDF format. A tool is provided to compare
HDF data files obtained running some algorithm(s) in a testing versus an operational processing
environment. The HDF file difference tool is invoked from the SSI&T Manager by selecting
Tools->Product Examination->File Comparison->HDF (GUI).

The tool is also available from the UNIX command line by typing EcDpAtCheckHdfFile. Both
methods will result in the display of the screen shown in Figure 4.5.1-21 (note that this program is
written in IDL, so it invokes the IDL environment to run.)
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Figure 4.5.1-21. HDF Pop-up

The HDF File Difference Tool Pop-up allows the operator to compare and contrast 2 HDF files via
a graphic user interface. The button functions on this pop-up are:

e The selection of the files to be compared is done by clicking the File #1 or File #2 buttons.
This selection activates the File Selection Dialogue Pop-up shown in Figure 4.5.1-22. The
appropriate filename is displayed in the Selection textbox of the Dialogue Pop-up. The “OK”
button will return to the HDF File Comparison Pop-up and insert the selected filename in the
originally activated file selection display textbox.
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Figure 4.5.1-22. File Selection Dialogue Pop-up

For each selected HDF file, File Info and Associated Metadata can be displayed by clicking
on the available buttons.

The tool also provides the facility to select the Common Datasets of both files from the list
available in the center upper part of the screen.

Once the datasets are identified, the operator selects the type of tolerance (relative or absolute)
that is used to compare the numerical values of the two datasets. This is accomplished by
clicking on the Tolerances button (Figure 4.5.1-21) and typing the appropriate value of
tolerance as shown in Figure 4.5.1-23.
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Figure 4.5.1-23. Tolerance Editor Pop-up

e The HDF pop-up allows the operator to input comparison coefficients (shown in Figure 4.5.1-
21 as radio buttons 1 through 10 next to the Tolerance button on the HDF File Comparison

Pop-up).
e Finally, two types of graphs can be selected by the operator by clicking on either one of the
following buttons:
e Plot 1 vs 2 shows a plot with both datasets.
» Plot 1-2 shows the difference between the two datasets.

e Documentation for the HDF file difference tool is obtained by clicking on the Help button on
the main screen.

e Clicking on the Quit button will close this Tool.

4.5.1.2.6.4 HDF File Comparison - hdiff

The HDF File Comparison hdiff tool is started from the SSI&T Manager screen by selecting the
Tools->Product Examination->File Comparison->HDF (hdiff) option. An Xterm
appears prompting the user for input. There is no graphics screen for this function. It is run
through the command line interface. The operator is also provided with a list of options for
different kind of comparisons that the tool can perform on HDF files (See Figure 4.5.1-24). After
the operator enters two HDF filenames, the differences between the files is displayed.
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Figure 4.5.1-24. HDF (hdiff) options

4.5.1.2.7 Text Editors

The Text Editors menu provides tools to assist operators in documentation and administrative tasks
(Figure 4.5.1-25).
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Figure 4.5.1-25. SSI&T Manager Main Screen with Text Editors
tool menu displayed
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45.1.2.7.1 Emacs
Emacs, as shown in Figure 4.5.1-26, is a COTS product that provides SSI&T users with Editor

capabilities. More information about Emacs can be downloaded from the web at
ftp://prep.ai.mit.edu/pub/gnu/.

[GNU Emacs 19.28,1 (sparc-sun-solarisZ. X toolkit) of 53t MNow 5 1994 on eclair
Copyright (C) 1994 Free Software Foundation, Inc,

Type C-h for help: C-x u to wundo changes, (°C-" means use CTRL key,?
To kill the Emacs job. type C-x C-cC.

Type C-h t for & tutorial on using Emacs,

Type C-h i to enter Info, which you can use to read GHU documentation.

GHU Emacs comes with ABSOLUTELY NO WARRAMTY: type C-h C-w for full details,
You may giwve out copies of Emacs: type C-h C-c to see the conditions.
Type C-h C-d for information an getting the latest wversion.|]

S+ =scratchs {Lisp Interaction)——L11--All
For information about the GHU FProject and its goals. tupe C-h C-p.

Figure 4.5.1-26. Emacs Pop-up
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4.5.1.2.7.2 Xedit

Xedit, shown in Figure 4.5.1-27, is a COTS product. Which provides SSI&T users with file
editing capabilities. For a detailed description of the Xedit tool, invoke the Unix man(ual)
command:

>man xedit

E i

Quit | Save|Load

Use Control-8 and Control-R to Search.

»—
no file yet
»—

Figure 4.5.1-27. Xedit Pop-up
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45.1.2.8 PDPS Database

The PDPS Database Update Tools are accessed using the TOOLS->PDPS Database menu item
of the SSI&T Manager as shown in Figure 4.5.1-28. These tools are used to register a PGE with
the PDPS database. Critical information about the PGE and under what conditions it should be run
is captured. This information is used by the PDPS prior to and during PGE execution, in both the
test environment and the production environment.

The PDPS Database Update Tools consist of four components;

1. PCF ODL Template
2. Check ODL

3. SSI&T Science Metadata Update
4. SSI&T Operations Metadata Update (a.k.a. PGE Registration Pop-up).

File Tools| Run

Xterm
c —_

Che
Code Analysis
[DO

[DO= .
[ ] Text Editors

[DOI Office Automation
] Standards Checkers
B Product Examination -

Emmm PDPS Database

Help I

-~

gorithm Package
etadata ODL file template

-

-~

netadata ODL file to add ESD
netadata ODL files

™ PCF ODL Template

SSIT At Server

~ Check ODL

whatever

01/06/98 15:05:06 mmauthe

SSIT Science Metadata Update
SSIT Opnl Metadata Update

Edit| Change State

Figure 4.5.1-28.

SSI&T Manager with  PDPS Database

Tool Menu Displayed
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All programs can be started either from the Tools->PDPS Database menu available on the
SSI&T Manager or by as executing the proper command line, as specified in the following
sections.

4.5.1.2.8.1 PCF ODL Template and ODL file Checking

The first step in the process of updating the PDPS Database is to generate a template SSI&T PGE
SCIENCE metadata ODL file from the PCF delivered with the science software. This is
accomplished by selecting PCF ODL Template from the PDPS Database submenu.

A character based window opens where the user is prompted for various inputs, the configuration
filename, the ECS mode of operations, the name of a delivered science software Process Control
File (PCF), the PGE name, the PGE version, and the Profile ID.

The tool is also available by sourcing - in the executable directory
$ECS_HOME/<MODE>/CUSTOM/bin/DPS the file named buildrc.

After the template file is generated, the SSI&T operator must edit this file, adding all information
that is currently blank, as needed. In particular, each PCF file entry must be associated with one or
more ESDTSs.

The file that had been edited in the previous step can be checked by the Check ODL Script,
available through the SSI&T Manager by selecting the Tools->PDPS Database->Check ODL
option.

The edited file is then used as an input to the next step (see Section 4.5.1.2.8.3) of the PDPS
Update process.

4.5.1.2.8.2 Check ODL

The Check ODL program parses the Science Software Metadata ODL files and reports any errors
found. It is used to validate ODL (make sure there aren't any errors) before the SSI&T Science
Metadata Update Tool is executed to populate the Science Software Metadata information in the
PDPS database.

The ODL Checker program is command line driven.

The program’s prompts and explanations of user responses to these prompts follow below. Note
that if there is a default value for an entry (in most cases this will only occur if you run the program
more than once), it will appear at the end of the prompt line.

** SCIENCE Metadata ODL Files Checker Script **
Configuration filename? (hit “enter’ for default: ../../cfg/EcDpAtCheckODL.CFG)

In most cases hitting enter (for the default) is fine. If not, enter the correct configuration filename
including full path:

ECS Mode of operations?

This is the mode (i.e. OPS, TS1) in which the tool will execute. In most cases this will be TS1.
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PGE name (max 10 characters)?

This is the name of the PGE for which you want to check the ODL. It has a maximum length of 10
characters and must be part of the ODL file name and inside the ODL file. See PGE Metadata ODL
File for more information about naming and filling out the PGE ODL file.

PGE version (max 5 characters)?

This is the version of the PGE for which you want to check the ODL. It has a maximum length of
5 characters and must be part of the ODL file name and inside the ODL file. Again, see PGE
Metadata ODL File help page for more information about naming and filling out the PGE ODL file.

PGE Profile ID (0-99, 0 means null)?

This is the profile ID of the PGE who’s ODL you want to check. It is an integer with a range 0-99
and must be part of the ODL file name and inside the ODL file. Again, see the PGE Metadata ODL
File help page for more information about naming and filling out the PGE ODL file.

Any success or error messages will then be displayed followed by:

Hit return to run again, 'q {return }" to quit:
This allows you to check another set of ODL files (just hit enter) or quit the program (enter q).
Check ODL program output.

The Check ODL program will search for any missing or invalid ODL parameters. It reports errors
with the following message:

Check of PDPS Science Metadata was unsuccessful: missing or invalid data in ODL files

What follows is a list of missing or invalid parameters and why they were flagged as invalid. In
many cases the parameter value is out of the expected range or is longer than the allowed
maximum. For some errors, the Check ODL program cannot narrow the problem to its cause and
points the user to the Toolkit Error logs as follows:

DpAtCheckOdIDpAtScienceMd::ProcessOdIFile (PGE):
ODL Error in file /ecs/formal/PDPS/DPS/SSIT/src/Metadata/Test/PGE_BAD#ODL#09.odl
Check LogsStatus file

Look in the LogStatus file in the /usr/ecs/{MODE}/CUSTOM/logs directory or in the user-installed
directory if you have installed a personal copy of SSI&T.

If the required ODL file(s) cannot be found the tool will report:
DpAtCheckOdIDpAtScienceMd: :ProcessOdlIFile (PGE):
Unable to open PGE Science Metadata ODL file
{FILENAME}

4.5.1-51 609-CD-600-001



{FILENAME} will be replaced by the filename that the tool was searching for. If this message
appears check the configuration settings (see Preconditions to running the Check ODL program)
and that the ODL file exists.

If the check of the ODL succeeds, the user will be greeted with the message:
FHFxxAx*** Check of PDPS SCIENCE metadata SUCCESSFUL **#*x sk
NO ERRORS FOUND

4.5.1.2.8.3 SSI&T Science Metadata Update

The next step is to update the PDPS/SSI&T database with science metadata, where the latter is
defined as PDPS metadata that comes from the Instrument Teams (ITs), and rarely changes. This
is done by selecting SSI&T Science Metadata Update from the PDPS Database submenu

The PGE template ODL file, which is output from the PCF ODL Template program of the previous
section, is input to this program, after it has been edited and renamed.

An example of this file (before editing) is available in:
$ECS_HOME/CUSTOM/data/DPS/PGE_ODL.template .

The comments in the example file explain fully what data are needed.

The naming convention that should be used for the edited file is explained in the provided Help
files. The location of the edited file must be set in the configuration file parameter
DPAT_PGE_SCIENCE_MD.

An example of this file can be found in:

$ECS_ HOME/CUSTOM/data/DPS/PGE_ODL.template .

In addition, if it does not already exist, a PDPS/SSI&T ESDT SCIENCE metadata ODL file must
be created, one for each ESDT used by this PGE. Again the naming convention to be used for this

file is documented in the Help files. The location of the edited file must be set in the configuration
file parameter DPAT_ESDT_SCIENCE_MD. An example of this file is provided in:

$ECS_HOME/CUSTOM/data/DPS/ESDT_ODL.template .

The comments in the example file explain fully what data are needed.

In addition, if it does not already exist, a Production Rule ODL file must be created for this PGE.
Again the naming convention to be used for this file is documented in the Help files. The location
of the edited file must Dbe set in the configuration file  parameter
DPAT_RULE_SCIENCE_MD. An example of this file is provided in:

$ECS_HOME/CUSTOM/data/DPS/ESDT_ODL.template .
The comments in the example file explain fully what data are needed.

Once these files (PGE, ESDT, and RULE) have been created and all the blanks have been
completely filled in, the user selects SSI&T Science Metadata Update from the PDPS Database
submenu to run the program. If a PGE already exists the operator will be prompted to update it. If
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a PGE does not already exist a character based window opens that prompts the user for
information needed to identify the PGE, configuration filename, ECS mode of operations, PGE
name, version and profile ID. With this information the program updates the SSI&T version of the
PDPS database with PGE and ESDT Science metadata read from the ODL files.

4.5.1.2.8.4 SSI&T Operational Metadata Update

The SSI&T Database can be updated with PGE operational metadata.

This pop-up is used to view/update operational parameters for a particular PGE. Operational
Parameters include the performance and the resource requirements for each PGE. In addition users
can also view/update PGE user-defined runtime parameter descriptions. Other options include

viewing the PGE science metadata file. (The program looks in the configuration file for the
DPAT_PGE_SCIENCE_MD and DPAT_ESDT_SCIENCE_MD files.)

Select View

The initial screen is as depicted in Figure 4.5.1-29, with the SELECT tab option displayed. This
pop-up provides the following options.
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Figure 4.5.1-29. PDPS/SSI&T Database Operational Metadata Update
Pop-up — Showing the SELECT Tab

The user may select to list either new or existing PGEs by clicking either the NEW PGE
button or the EXISTING PGE button. The difference is that new PGEs have not yet had
their Operational metadata placed into the database.

Clicking on a PGE in the list in the PGE Names: field populates the version list in the PGE
Versions: field with all the versions of the selected PGE presently defined in the PDPS
database.

Once the PGE has been selected, information on the PGE profile is also made available to the
user through the Profile Description: field for each selected Profile ID.

Clicking on the Display button displays PGE science metadata in a Metadata Display window
as read-only.
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e If required, selected PGEs can also be flagged as deleted in the database by clicking on the
Delete button. (However, data is never physically deleted from the database by any SSI&T
program. Only database administrators have permission to do this, using ISQL.)

e Clicking on the EDIT button allows for changing the selected PGE.
Profile View

Selecting the Profile tab displays the profile information of the selected PGE. This view is shown
in Figure 4.5.1-30. The view contains fields showing Resource Requirements and Performance
Statistics of the selected PGE. Descriptions of each field are presented in Table 4.5.1-10. Default
values for these field (i.e. or new PGEs) are set to null. All of the values must be filled in before
the database update is completed. For existing PGEs, current settings in the database are displayed.
The user can update them as needed. Cut and Paste capabilities are provided in the Edit pull down
menu to help performing functionality associated with this tool. Clicking on Reset sets the fields to
the current values in the database ignoring all the changes operated by the user during the current
session. To record updated or new values in the database te user must click on the Apply button.

Once the data on this screen has been entered into the database successfully, the PGE changes state
from “New” to “Existing”. (The PGE name and version scrolling lists on the SELECT tab are now
visible after the user selects Existing there.)
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Figure 4.5.1-30. PDPS/SSI&T Database Operational Metadata Update
Pop-up -showing the PROFILE Tab

Table 4.5.1-12 describes the fields in the PDPS/SSI&T Database Operational Metadata Update
pop-up.
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Table 4.5.1-12.

PDPS/SSI&T Database Operational Update Profile

Field Descriptions (1 of 2)

Field Name Data Type Size Entry Description

Wall clock Time | float N/A User Real time used by the process (in seconds);
filled in both after processing with SCF
Toolkit and with DAAC Toolkit (i.e. with
Autosys).

CPU Time float N/A User CPU time used by the process in seconds.

Max Memory float N/A User Maximum memory used by the process in

Used megabytes.

Block Input Ops | integer N/A User Number of times the file system performed
input in servicing.

Block Output integer N/A User Number of times the file system performed

Ops output in servicing.

Swaps integer N/A User The number of times the process was
swapped out of main memory.

Page Faults integer N/A User The number of page faults serviced by the
process.

Disk Space used | float N/A User Maximum disk space used by the process.

in PGE run

Processing Selectable N/A system Processing string or computer name on

String/ Computer generated | which the PGE will be executed.

Name display

Window

Processing ASCII 30 User A name given to collection of processors

String characters where PGE can be executed.

Computer Name | ASCII 30 User Name of the computer where the process is

characters executed.

Number of CPUs | integer N/A User Number of processors required by the PGE.

Local filename of [ ASCII 30 User Name of the executable file for the PGE.

top level shell

SGI Application | Selectable N/A System The “mode” of SGI compilation of the

Binary Interface Defined executable.

Toolkit On/Off N/A User Determines if Toolkit shared memory will be

Initialization activated during PGE execution.

Settings: Shared

Memory On
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Table 4.5.1-12.

PDPS/SSI&T Database Operational Update Profile

Field Descriptions (2 of 2)

Field Name Data Type Size (of Entry Description
character
S)
Toolkit On/Off N/A User Determines if the Toolkit should use text files
Initialization for shared memory if there is a failure using
Settings: Use shared memory.
Text Files if SM
fails
Toolkit On/Off N/A User Determines if the Toolkit will log information
Initialization during PGE execution.
Settings: Use
Log Files
Toolkit On/Off N/A User Determines if PGE execution should
Initialization continue if logging fails.
Settings:
Continue If
Logging fails

Runtime View

Selecting the Runtime tab displays the PGE runtime parameters, i.e., static parameters used by the
PGE at runtime. This view is shown in Figure 4.5.1-31. The logical ID, name and value which
have already been entered in the database by the Science Metadata Update program are displayed
on the left side of the screen. After selecting one of these runtime parameters the user is given the
opportunity to add some descriptive text. (Use of this functionality is optional. Runtime parameter
descriptions may remain as null values.) The user clicks the OK button when finished editing a
particular parameter. Modifications are applied to the database by clicking on the Apply button. As
before, clicking on Reset sets descriptions of all parameters to current values in the database.
Details of the runtime parameters fields are shown in Table 4.5.1-13.
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Figure 4.5.1-31. PDPS/SSI&T Database Operational Metadata Update

Pop-up Showing the  Runtime Tab

Table 4.5.1-13 describes the fields on the Runtime Tab.
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Table 4.5.1-13. PDPS/SSI&T Database Operational Metadata Update
Runtime View Field Description

Field Name Data Type Size Entry Description
(of
characters)
Logical Id Integer N/A Read from logical id of the user parameter in
database the PCF file
Parameter Name | ASCII N/A Read from User Parameter Name
characters database
Parameter Value | ASCII N/A Read from User Parameter Value
characters database
User Parameter | ASCII <60 User text describing the user parameter
text description | characters
ESDT View

Selecting the ESDT tab displays the ESDT information of the selected PGE. This view is shown in
Figure 4.5.1-32. Two ESDTs lists are made available to show both the PGE Input Datatypes and
the PGE Output Datatypes. On selection of a particular ESDT, the associated PDPS Science ESDT
metadata can be viewed by clicking on the Display button. This data is read only and may not be
modified through this Pop-up.

The program looks for the file it set in the configuration file parameter
DPAT_ESDT_SCIENCE_MD.
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Figure 4.5.1-32. PDPS/SSI&T Database Operational Metadata Update
Pop-up - showing the ESDT Tab

Display Screen

Figure 4.5.1-33 shows a pop-up Display screen. The Display window is used to display either a
PGE Science Metadata (selected from the SELECT tab) or the ESDT Science Metadata (selected
from the ESDT tab).

A Display screen pops-up also if the request for modification to the database fails because of some
mandatory field not being properly set (see screen of PROFILE view). Editing is not allowed in
this window. Clicking on "Done" closes this window.
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— PGE Science Metadata

PGE_NAME = "ssit"
PGE_VERSION = "12"
INSTRUMENT = " CERES"
PLATFORM = "TRMM"
PROCESSING_PERIOD = "DAYS=1"
PROCESSING_BOUNDARY = "START_OF_HOUR"
PGE_SSW _VERSION = "12"
OBJECT = EXIT_MESSAGE
CLASS= 1
EXIT_CODE = 0
EXIT_MESSAGE = "none"
END_OEJECT = EXIT_MESSAGE
OBJECT = ESIT_DEFPENDENCY
CLASS= 1
DEPENDENCY_PGE_NAME = "ssit"
DEPENDENCY_SSW WERSION = "11"
EXIT_OPERATION = "="
EXIT_CODE = 0O
END_OBJECT = EXIT_DEPENDEMNCY
OBJECT = PCF_ENTRY
CLASS = 1
LOGICAL_ID = 100
PCF_FILE_TYPE = 1
DATA_TYPE_NAME = "CEROO"
DATA_TYPE_REQUIREMENT = 1
OBJECT = METADATA_CHECKS
CLASS = 1
PARM_NAME = "tbd_parm_nane"
OPERATOR

Figure 4.5.1-33. PDPS/SSI&T Database Operational Metadata Update

Pop-up - Display Screen
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45.1.2.9 Data Server

This section describes the interfaces to the Data Server used by the SSI&T Specialist during the
SSI&T process. All programs may be started from the Tools->Data Server menu of the SSI&T
Manager shown in Figure 4.5.1-34.
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Get MCF
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Insert Static

SSIT rerg——=

whatever Insert Test Dynamic
Insert EXE TAR

SSAP Editor

Edit] Change State

Figure 4.5.1-34. SSI&T Manager, Tools Menu, Data Server
Submenu Choices

4.5.1.2.9.1 Acquire DAP
This program is used to retrieve the Delivered Algorithm Package (DAP) from the Data Server.
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Before its use, the following events must have occurred:

1. A subscription for the DAP must have been registered with the Data Server. The
subscription delivery option will be set to email, to a specified DAAC operator or mail
drop.

2. The DAP must have been Ingested. There are two ways for this to occur. First, the DAP
may be processed by Ingest. When this occurs, Ingest inserts the DAP into the Data
Server, triggering subscription notification. Second, the DAP may be inserted with the
Insert Test File.

3. After the DAAC operator received the email subscription notification, he or she must save it
to a file.

To run the program, select Acquire DAP from the Data Server submenu. The program prompts for

input parameters Process Framework configuration filename, email message filename and directory
to receive staged file.

The program reads the DAP Universal Reference (UR) from the email file, acquires the DAP from
the Data Server, and stages the DAP on the local disk. The name of the staged file is written to
standard output. Note, this function may be used to acquire any type of granule with a known
UR.

After the file is staged, the operator may unpack it and install its components in ClearCase or in
other places as appropriate.

NOTE: Use of this program is optional, in the sense that the DAP may arrive at the DAAC through
other means than Ingest, e.g., simple ftp.

4.5.1.2.9.2 Get MCF

This Get Metadata Configuration File (MCF) tool has a character based user interface. It is
invoked by selectinge Tools->Data Server->Get MCF menu option of the SSI&T Manager.
The user is prompted to provide pertinent information about the ESDT for the MCF that has to be
acquired from the Data Server. The information includes the configuration file name, the ECS
mode of operations, the ESDT short name, the ESDT version, and, finally the location where the
MCF needs to be transferred to. When the above information is provided the tools contacts the
Data Server and, if the operation is successful, copies the MCF to the new location. A message to
the operator either confirms the successful transfer of the MCF or issues a warning which explains
why the operation did not complete successfully.

4.5.1.2.9.3 Insert Static

The Insert Static File program inserts static input file(s) to the Data Server, for use both during
SSI&T and in production. Static Files are files that rarely change between instances of PGE
processing; for example, calibration files. Such files are normally part of the DAP.

After this program runs successfully, the PDPS database has been updated with the Data Server
Universal Reference (UR) of the file inserted. This UR is read by the Planning and Processing
systems at runtime. so that the file can be acquired and used during production.

The Insert Test Dynamic File program is command line oriented. There is no CHUI or Pop-up for
this program.
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Before this program is used, the following must have occurred:
1) An ESDT for this data type must have been created in the Data Server.

2) A PGE that uses the Static File must have been registered to PDPS via the SSI&T Science
Metadata Update tool.

3) An ASCII Metadata File (.met) for this ESDT must have been created, in the format expected
by the Data Server for Insert.

4) Both the static data file(s) in question and its corresponding ASCIlI Metadata file must be
accessible to the local machine.

5) The directory where the static data file(s) and the ASCII Metadata File exist must be cross
mounted to the Data Server machines.

The Static Input File program produces prompts for the operator to enter the necessary
information. These prompts and explanations follow. Note that if there is a default value for an
entry (in most cases this will only occur if you run the program more than once) it will appear at
the end of the prompt line.

Configuration filename? (enter for default: ../../cfg/EcDpAtinsertStaticFile. CFG)

In most cases hitting enter (for the default) is fine. If not, enter the correct configuration filename
including full path.

ECS Mode of operations?
This is the mode (i.e. OPS, TS1) of operations. In most cases this will be TS1
ESDT short name for the file(s) to Insert?
This is the ESDT short name (max 8 characters) for the data file(s).
ESDT Version for the file(s) to insert?
This is the ESDT version (an integer) for the data file(s).
Science Group for Static file (one of {C, L, D, O} followed by a 3 digit number)?

This is the Science Group for this Static File(s). It is defined in the PGE Metadata ODL File for
each PGE that uses this static file.

C = Coefficent File(s), L = Lookup Table/file(s), D = Database File(s), O = Other Files.

Note that using the wrong letter for the file(s) (say L for a Coefficent File) will not result in an
error.

Is theremore than one data file to this Static (Y = Yes, N = No)?

This indicates to the program if there is more than one file associated with the static input. Most
static inputs are a single data file and a corresponding ASCII Metadata File. Other static inputs
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consist of more than one data file and a single ASCII Metadata file (there is always only 1 ASCII
Metadata File).

If there is only one data file enter N (or just hit enter for the default). For multiple data files enter
Y.

If it is NOT a Static Multi-File Granule (there is a single data file) the following prompts will need
to be answered:

Single Filename to Insert (including FULL path)?

This is the name of the data file to insert to the Data Server. Include the full path to the file so that
it can be found by the tool.

Associated ASCII Metadata Filename to Insert (including FULL path)?

This is the name of the ASCII Metadata File (.met) associated with the data file. The full path to
the file must be included so that it can be found by the tool. It can be created by using the Get
MCF tool to get a Metadata Control File which specifies the fields and type of data that is required
for the ASCII Metadata file.

If it IS a Static Multi-File Granule (more than 1 data file) the following prompts will need to be
answered:

Directory where all data files and .met file exist (FULL path)?

This is the directory location where all the data files and the ASCII Metadata file are located. For
Multi-File Statics all files and Metadata must reside in the same directory.

Name of MFG file (enter to end list)?

This is the name of one of the data files for a Static Multi-File Granule. Enter a file at the prompt
and the prompt will then be repeated, allowing for the next file to be named. When all data files
have been entered, just hit the enter key at the next prompt (thus entering nothing).

Associated ASCII Metadata Filename to Insert?

This is the name of the ASCII Metadata File (.met) associated with the data file. No path is needed
because it is assumed that the file resides in the directory specified above. It can be created by
using the Get MCF tool to get a Metadata Control File which specifies the fields and type of data
that is required for the ASCII Metadata file.

Any success or error messages will then be displayed followed by:
Hit return to run again, 'q <return>' to quit:

This allows the user to enter another Static File (just hit enter) or quit the program (q).

4.5.1.2.9.4 Insert Test Dynamic

The Insert Test Dynamic File program inserts test dynamic input files to the Data Server, for use
both during SSI&T and in production. Dynamic Files are files that change at each instance of PGE
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processing; for example, Level 0 data files. This tool performs a function that is normally done by
Ingest. It allows the user to insert dynamic files to the Data Server for testing purposes.
Normally, Ingest will take in such files and insert them as part of its normal processing.

After this program runs successfully, the specified file(s) have been stored at the Data Server and
can be acquired by PDPS when executing PGEs. Also, any subscriptions made on the ESDT of
the insert file(s) will trigger, and could (via Subscription Manager) cause PGE waiting on this data
to initiate execution

The Insert Test Dynamic File program is command line oriented. There is no CHUI or Pop-up for
this program.

Before this program is used, the following must have occurred:
1. An ESDT for this data type must have been created in the Data Server.

2. A PGE that uses the Dynamic File(s) ESDT must have been Registered to PDPS via the SSI&T
Science Metadata Update tool.

3. An ASCII Metadata File (.met) for this instance of the ESDT must have been created in the
format expected by the Data Server for Insert.

4. Both the test dynamic data file(s) in question and its corresponding ASCII Metadata file must
be accessible to the local machine.

5. The directory where the dynamic data file(s) and the ASCII Metadata File exist must be cross
mounted to the Data Server machines.

The Insert Test Dynamic program produces prompts for the operator to enter the necessary
information. These prompts and explanations follow. Note that if there is a default value for an
entry (in most cases this will only occur if you run the program more than once) it will appear at
the end of the prompt line.

Configuration filename? (enter for default: ../../cfg/EcDpAtinsertTestFile.CFG)

In most cases hitting enter (for the default) is fine. If not, enter the correct configuration filename
including full path

ECS Mode of operations?

This is the mode (i.e. OPS, TS1) of operations. In most cases this will be TS1
ESDT short name for the file(s) to Insert?

This is the ESDT short name (max 8 characters) for the data file(s).
ESDT Version for the file(s) to insert?

This is the ESDT version (an integer) for the data file(s).

Is there is more than one data file to this Dynamic Granule (Y = Yes, N = No)?
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This indicates to the program if there is more than one file associated with the dynamic input.
Most dynamic inputs are a single data file and a corresponding ASCIlI Metadata File. Other
dynamic inputs consist of more than one data file and a single ASCII Metadata file (there is always
only 1 ASCII Metadata File).

If there is only one data file enter N (or just hit enter for the default).

For multiple data files enter Y. If it is NOT a Dynamic Multi-File Granule (there is a single data
file) the following prompts will need to be answered:

Single Filename to Insert (including FULL path)?

This is the name of the data file to insert to the Data Server. Include the full path to the file so that
it can be found by the tool.

Associated ASCII Metadata Filename to Insert (including FULL path)?

This is the name of the ASCII Metadata File (.met) associated with the data file. Full path to the
file must be included so that it can be found by the tool. It can be created by using the Get MCF
tool to get a Metadata Control File which specifies the fields and type of data that is required for the
ASCII Metadata file.

If it IS a Dynamic Multi-File Granule (more than 1 data file) the following prompts will need to be
answered:

Directory where all data files and .met file exist (FULL path)?

This is the directory location where all the data files and the ASCII Metadata file are located. For
Multi-File Dynamics all files and Metadata must reside in the same directory.

Name of MFG file (enter to end list)?

This is the name of one of the data files for a Dynamic Multi-File Granule. Enter a file at the
prompt and the prompt will then be repeated, allowing for the next file to be named. When all data
files have been entered, just hit the enter key at the next prompt (thus entering nothing).

Associated ASCII Metadata Filename to Insert?

This is the name of the ASCII Metadata File (.met) associated with the data file. No path is needed
because it is assumed that the file resides in the directory specified above. It can be created by
using the Get MCF tool to get a Metadata Control File which specifies the fields and type of data
that is required for the ASCII Metadata file.

Any success or error messages will then be displayed followed by:
Hit return to run again, 'q <return>'to quit:

This allows the user to enter another Dynamic File (just hit enter) or quit the program (q).
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4.5.1.2.9.5 Insert EXE TAR

The Insert Exe Tar File program is used to insert the tar file containing the PGE executable (and
associated files) to the Data Server for use during SSI&T and in production.

The Insert EXE TAR program is command line driven. There is no CHUI or Pop-up for this
program.

Preconditions to running the Insert Test Dynamic File program

Before this program is run, the following must have occurred:
e AnESDT for EXE TAR files must have been installed at the Data Server.
e The PGE must have been Registered to PDPS via the SSI&T Science Metadata Update tool.

e An ASCII Metadata file (.met) for the PGEEXE ESDT must have been created, in the
format expected by the Data Server for Insert. A template for such a file is delivered with the
software and stored under /usr/ecs/{f MODE}/CUSTOM/data/DPS/PGEEXE.met.template.

» The tar file must be prepared with the files needed to execute the PGE (see below for a list).
e Both the tar file in question and its corresponding MCF must reside on the local machine.

» The directory where the tar file and the ASCII Metadata File exist must be cross-mounted to
the Data Server machines.

The Exe Tar file must include
[ PGE compiled binary executable(s),
[ PGE scripts (if any),
[ SQ@F-generated SDP Toolkit compiled runtime message files (if any),

[—Any dynamic link libraries needed by the PGE at runtime.
...in short, anything needed to run the PGE, aside from Data Server input and output files.

The program prompts for input parameters Process Framework configuration filename, database
name to update, PGE name, science software version, full path filename to insert, MCF full path
filename, and top level shell filename within tar file. (*Top level shell filename* is the name of the
script file or executable which one uses to kick off the PGE.)

After the program is run, the PGE is ready to run either in the SSI&T environment or in the
production system. Then the PDPS database has been updated with the Data Server Universal
Reference (UR) of the Exe Tar file inserted, the size of this file, and the top level shell within the
tar file. This data is read by the Processing system at runtime and the PGE Exe Tar file is acquired
from the Data Server.

NOTE: All Exe Tar files are inserted to a single ESDT, the Short Name of which is hard-coded into
the EcDpAtInsertExeTarFile software as PGEEXE.
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The Insert EXE TAR program produces prompts for the operator to enter the necessary
information. These prompts and explanations follow. Note that if there is a default value for an
entry (in most cases this will only occur if you run the program more than once) it will appear at
the end of the prompt line.

Configuration filename? (enter for default: ../../cfg/EcDpAtinsertTestFile.CFG)

In most cases hitting enter (for the default) is fine. If not, enter the correct configuration filename
including full path

ECS Mode of operations?
This is the mode (i.e. OPS, TS1) of operations. In most cases this will be TS1.
Name of PGE?

This is the name of the PGE to insert (max length 10 characters). It must have already been
defined to the PDPS database.

Science Software version of PGE?

This is the Science Software version (version of the actual executable) of the PGE (max 5
characters). In most cases this will be the same as the PGE Version, but it is possible to change
the PGE Version without changing the actual executable (in which case the Science Software
version and PGE Version would be different). The Science Software version is specified in the
PGE Metadata ODL File.

Staged filename to Insert (including FULL path)?

This is the name of the Exe tar file to insert to the Data Server. Include the full path to the file so
that it can be found by the tool.

Associated ASCII Metadata Filename to insert (including FULL path)?

This is the name of the ASCII Metadata File (.met) associated with the tar file. The full path to the
file must be included so that it can be found by the tool. Use the
lusr/ecs/{MODE}/CUSTOM/data/DPS/PGEEXE.met.template file to create one for the tar file to
be inserted.

Top level shell filename within tar file?
This is the name of the top-level executable within the tar file. It is the name of the program that
PDPS is supposed to execute when running the PGE.

4.5.1.2.9.6 Science Software Archive Packages (SSAP) Editor

The SSAP Editor pop-up is a tool that manages Science Software Archive Packages. In particular,
the SSAP Pop-up allows the operator to create a new SSAP, update or delete an existing one, add
or remove components, and edit Metadata associated with an SSAP.

From the SSI&T Manager menu, the operator selects the Tools->Data Server->SSAP Editor
option. The SSAP Editor as shown in Figure 4.5.1-35 appears.
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Figure 4.5.1-35. SSAP Editor Main Pop-up

A command line is also available to start the SSAP Editor. The operator can type the command:

EcDpAtSSAPGui ConfigFile <CONFIG_FILE> ecs_mode <MODE>
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where <CONFIG_FILE> and <MODE> are, respectively, the name of the Process Framework
configuration file for this specific application and the mode of operations. The tool will not allow
the operator to come up in a mode that is not consistent with the one established at startup.

The main window contains three pulldown menus, each one performing the following functions:
e The File menu is used to exit from the SSAP Editor.
e The Options menu has two items:

e Check Permissions; displays a Message window that shows a list of functions the
operator can perform with the SSAP Editor tool, including; Create SSAPs, Delete
SSAPs, Add Files to SSAPs, Delete Files from SSAPs, Edit SSAP Metadata.

e Batch Mode; allows the operator to run a script including command lines for creating
SSAPs. The operator is prompted to select the batch mode file using the Input File
Selection screen, shown in Figure 4.5.1-36.

E B

/hone/PDPS/RCCLAB30OPS/CUSTOM/bin/DPS/*

Direc Files

1.0

10.0

120
AccesslogFile

auto.profile
core
EcDpAtacquireDAP

Tri—-—-

Selection

/hone/PDPS/RCCLAB30PS/CUSTOM/bin/DPSA

0K | F11ter| Cance1| Help |
=

Figure 4.5.1-36. Input File Selection Pop-up

e The Help menu provides context sensitive help information.

A toolbar at the top of the screen shows the name of the Current SSAP and the Current File
Type (SSAP), shown in Figure 4.5.1-35.
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The SSAP Editor Pop-up main screen has three tabs, i.e., Main, File List and Metadata.

The following three subsections provide details on the views that are opened by clicking on each of
these tabs.

45.1.2.9.6.1 SSAP Editor Main View

The Main View (Figure 4.5.1-35) is the default view that appears when the SSAP Editor is
started. It contains the following controls:

A free text window that lists all the existing SSAPs that are retrieved from the Data Server.

A Refresh button that updates the above SSAP Listing, regenerating the screen every time the
operator needs to do so, to add recent changes to the listing.

A Create button that allows the operator to start the creation of a new SSAP. Upon clicking
this button, the New SSAP screen appears where the operator is prompted to provide a new
SSAP Name and SSAP Version, shown in Figure 4.5.1-37.

- Mew SSAP

Enter the new SSAP name:

New_SSAP_nane

Enter New SSAP Version:

000000

oK | Cancel | Help |

Figure 4.5.1-37. New SSAP Window

A Create With button is provided as an alternative for the user to create a new SSAP starting
with components of an existing SSAP file. To do this, the operator should click on an existing
file, and change the parameters of the old SSAP with the name, SSAP version, and other
attributes of the new SSAP. The operator will complete the creation of the new SSAP with
saving the changes to the new SSAP. Both the old and new SSAPs will retain their different
identities.
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e A Submit button allows the operator to submit the new SSAP to the Data Server for storage
or update an existing SSAP.

e A Delete button is used by the operator for deleting a selected SSAP from the Data Server.

e A Reset button allows the operator to undo the changes made for the currently selected SSAP
during the session.

45.1.2.9.6.2 File List View

Once the new SSAP has been named or an existing one has been selected, the operator can update
the list of SSAP components by clicking on the File List tab. Selecting the File List tab, the
operator is presented with the screen shown in Figure 4.5.1-38.
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On this screen, two main windows are shown. The first window on the left side of the screen
shows all the files available on the local machine and the bottom window on this side of the screen
shows the directory location, showing the current path. The other window on the right side of the
screen shows the files included in the SSAP. The two buttons Add and Extract allow for the
transfer between the two aforementioned sets of files between the top two windows on the screen.
Once a file is selected in the list of files of the local machine, it is listed as an SSAP file component
and included in a tar file.

e By clicking on the File Type button, selected SSAP files can be further identified as one of
the following: Algorithm Description, Change Log, Context Dialogue, Delivery List, PGE
Information and Software. A File Type must be selected before file list changes can be
made.

Other Options are offered to the operator to act on the list of SSAP files:
e The Select All button selects all the files in the SSAP Files window.

e The Delete button deletes the selected files; a safety window pops-up to ask the operator to
confirm the delete request.

e The Reset button allows the operator to undo the changes just made.

45.1.2.9.6.3 Metadata View

For each existing SSAP, the Metadata files can be edited by the operator clicking on the Metadata
tab. Pertinent information about the Algorithm and the PGE can be input by the operator in several
text fields, shown in Figure 4.5.1-39.
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Figure 4.5.1-39. Metadata Pop-up
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Some of this information is already made available by default but can be changed by the user.
Descriptions of each of the fields that the operator is required to fill in are provided in the following
Table 4.5.1-14

Table 4.5.1-14. SSAP Editor - Metadata Tab Field Descriptions

Field Name Data Type Size Entry Description

Algorithm string unlimited user Name of the Algorithm included in

Package Name the SSAP.

Algorithm string unlimited user Version of the Algorithm included in

Package Version the SSAP.

Delivery Purpose |[string unlimited user Reason for creating an SSAP and
submitting it to the Data Server for
acceptance.

Acceptance Date |date MM:DD:YYYY user The date the SSAP was accepted.

PGE Name string unlimited user Name of the original PGE that was
used to generate the SSAP.

PGE ID string unlimited user ID of the original PGE that was used
to generate the SSAP.

PGE Function string unlimited user Metadata information on the original
PGE.

PGE Version string unlimited user Version of the original PGE that was
used to generate the SSAP.

SW Version string unlimited user Version of the code included in the
PGE.

PGE Date Last date MM:DD:YYYY user Date the PGE was last modified.

Modified

SW Date Last date MM:DD:YYYY user Date the SW was last modified.

Modified

The Metadata view screen allows the operator to select the level of maturity or version of the code
included in the SSAP. By clicking on the Maturity Code pull down menu, one of the following
options can be selected: Pre-launch, Preliminary, Operational, Stable and Final.

The input of all the date fields is facilitated by the presence of ad-hoc up and down arrows that
increment and decrement the values available as default or previously input by the operator.

The Edit Assoc Collection button allows the operator to edit the ESDT’s that the original PGE
is associated with. By clicking on this button, the Associated Collections pop-up appears as shown
in Figure 4.5.1-40.
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Figure 4.5.1-40. Associated Collections Pop-up

It should be noted that at least one ESDT must be associated with the original PGE in order to
create a new SSAP. The Associated Collections window allows the operator to select the collection
name and to input the Short Name and Version of the Associated Collections to be added. The
text fields that the operator is requested to provide in this pop-up are described in Table 4.5.1-15.
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Table 4.5.1-15. SSAP Editor - Association Collection Field Description

Field Name [Data Type| Size Entry Description
Short Name string unlimited |user Name of the Associated Collection
included in the SSAP.
Version string unlimited |user Version of the Associated Collection
included in the SSAP.

e Once the selection and/or the addition have been completed, the operator can confirm the
changes by clicking on the Ok button. Further context sensitive help is available to the operator
by clicking on the Help button.

» Once Done is clicked, the operator is returned to the Metadata screen, shown in Figure 4.5.1-
39. The File button at the upper left hand corner of the screen is clicked, to return to the
SSI&T Manager menu, and finally to quit the operation

4.5.1.2.10 Help Menu

This appears at the far right of the SSI&T Manager Pop-up. Selecting the INDEX menu item
brings up an index of all SSI&T Tools, as shown in Figure 4.5.1-41. Select a tool for which help
is desired to bring up a help screen.

Selecting the ABOUT menu item brings up an instance of Netscape with a HTML file that provides
basic information on the SSI&T Manager Tool, the Version #, etc.
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Figure 4.5.1-41. SSI&T Manager Help Index

4.5.1.3 Required Operating Environment

For all COTS packages, appropriate information on operating environments, tunable parameters,
environment variables, and a list of vendor documentation can be found in a CM controlled
document for each product. To find the documentation for all of the COTS packages used in
SSI&T, refer to the ECS Baseline Information System web page, URL
http://cmdm.east.hitc.com/.

For Ecs Custom Software tools used in SSI&T information on the operating environment, tunable
parameters and environment variables refer to the 920-TDx-013 *“Custom Code Configuration
Parameters” documentation series. The “x” refers to the installed location, e.g. 920-TDG-013 is
for GSFC DAAC.
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4.5.1.3.1 Interfaces and Data Types

The SSI&T Manager exchanges data of various types through interfaces within and external to
ECS. Table 4.5.1-16 lists SSI&T Manager system interfaces for Version 2.0.

Table 4.5.1-16.

SSI&T Manager Interface Protocols

Interface (facility) Type of Primary Type of Backup Comments
Interface Interface
Protocols Protocols

Acquire DAP Science Data Server none Fixed ESDT

Insert Static Science Data Server none Variable ESDT

Insert Test Dynamic Science Data Server none Variable ESDT

Insert EXE TAR Science Data Server none Fixed ESDT

SSAP Edit Science Data Server none Fixed ESDT

Get MCF Science Data Server none Fixed ESDT

4.5.1.4 Databases/ Files
The SSI&T Manager uses the Unix ndbm flat-file database facility to generate the Log/Checklist

database.

More importantly, the SSI&T process is closely coupled with the PDPS database.
carried out in a different mode than production.

SSI&T is

SSI&T activities will not interfere with the

production PDPS database. The PDPS database schema information is described in Section 4.7
Resource Planning of this document.

There are many files that are involved with the SSI&T Manager and the associated applications.
These files are summarily described in Table 4.5.1-17.
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Table 4.5.1-17.

SSI&T Files (1 of 2)

File Title File Name Purpose Associated SSI&T
Application/Tool
Installation $ECS_HOME/CUSTOM/DpALIN | Install SSI&T software
script STALL.sh
EcCoAssist
SSI&T $PGS _PC _INFO_FILE (a SSI&T Manager uses a SSI&T Manager
Internal parameter in the configuration Process Control File
Process file) to de_termine.names and
Control File locations of files.
This Process Control File
defines correspondence
between specifications for
actual files, and the logical
identifiers used by the
SSI&T Manager to access
those files.
This SSI&T PCF should
not be confused with the
PCF used by and included
with the science software.
Process $ECS_HOME/CUSTOM/cfg/Dp | Enable Process All SSI&T programs
Framework At*.CFG Framework for PDPS

Configuration

database access, ECS
event logging.

SSI&T
Manager Run
Menu

$ECS_HOME/CUSTOM/data/D
PS/ssit_run_menu.txt

Add items to SSI&T
Manager RUN menu.

SSI&T Manager

SSI&T
Manager help
files

$ECS_HOME/CUSTOM/docs/W
WW/DPS/DpAtMgr*.html

Online help

All tools in SSI&T
Manager

Sample $ECS_HOME/CUSTOM/data/D | SSI&T Manager Checklist SSI&T Manager
checklist PS/checklist.sample
ECS $FCKCNF (a parameter in the FORCHECK is configured | DpAtMgrForcheck.sh
approved configuration file) to check for non-ANSI
FORTRAN 77 FORTRAN 77 extensions
extensions approved for use in ECS
science code, according to
“Data Production and SCF
Standards and
Guidelines”.
Prohibited $ECS_HOME/CUSTOM/data/D | Suggested list of Prohibited Function

function lists

PS/prohibitedFunctions*.txt

prohibited functions in
science software, one for
each language.

Checker
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Table 4.5.1-17.

SSI&T Files (2 of 2)

File Title File Name Purpose Associated SSI&T
Application/Tool

Xresources In Customize appearance Pop-ups
files $ECS_HOME/CUSTOM/data/DPS | of Pop-ups.

* XDpAtMgr

e Emacs

o Xdiff

» Xbadfunc

* DpAtMgrCheckHdfFile.defaults
Binary File $ECS_HOME/CUSTOM/data/DPS | Binary File Difference DpAtMgrBinDiff
Difference /DpAtMgrBinDiff* templates
templates
Binary File $ECS_HOME/CUSTOM/data/DPS | Binary File Difference DpAtMgrBinDiff
Difference /DaacBinDiff* example code
example
code
Sample $ECS_HOME/CUSTOM/data/DPS | Examples of PDPS PGE | DpAtPdpsDbUpdateSc
PDPS /PGE_ODL.template Metadata ODL files ience (sample input)
Metadata
PGE ODL file
Sample $ECS_HOME/CUSTOM/data/DPS | Documentation of PDPS | DpAtPdpsDbUpdateSc
PDPS /ESDT_ODL.templatel ESDT Metadata ODL ience (sample input)
Metadata files
ESDT ODL
file
Sample $ECS_HOME/CUSTOM/data/DPS | Documentation of PDPS | DpAtPdpsDbUpdateSc
PDPS /TILE_ODL.template TILE Metadata ODL Files | ience (sample input)
Metadata
TILE ODL File
Sample $ECS_HOME/CUSTOM/data/DPS | Documentation of PDPS | DpAtPdpsDbUpdateSc
PDPS /PATHMAP_ODL.template PATHMAP Metadata ience (sample input)
Metadata ODL Files
PATHMAP
ODL File
Sample $ECS_HOME/CUSTOM/data/DPS | Example of PDPS DpAtPdpsDbUpdateSc
PDPS /ORBIT_ODL.template ORBIT Metadata ODL ience (sample input)
Metadata files
ORBIT ODL
file

The SSI&T process also uses the PDPS database. The PDPS database for Release 4 is ECS

document 311-CD-106-005.
examination of the descriptions in the documentation.

through the database software.
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4.5.1.5 Special Constraints
None.

4.5.1.6 Outputs

Output files explicitly associated with the SSI&T custom software have been shown in the
previous sections. In addition, many of the custom tools can produce output files. See the
appropriate section on the custom tools for specific information.

4.5.1.7 Event and Error Messages

The SSI&T Manager displays errors in a popup message box (see Appendix A for additional
details). The SSI&T Manager also logs error and status messages; currently these are sent to
standard output. Refer to the specific vendor manuals for COTS messages.

4.5.1.8 Reports

A variety of ad-hoc and canned reports are available to the DAAC operations staff to assist in the
monitoring of the activities associated with the Algorithm Integration & Test. These reports are
listed in Table 4.5.1-18.

Table 4.5.1-18. Reports (1 of 2)

Report Report Description When and Why Used
Type

Algorithm Provide the operations staff information on Algorithm

Integration & | Integration and Test application software events that

Test have occurred.

Management | This information is available from the MSS database.

Reports
Ad-hoc reports include: Production Requests and These reports can be used to
associated Data Processing Requests, Data track modifications and
Subscriptions, PGE Profiles, etc. provide historical information
This information is available from the PDPS database. on these data objects.

PGE Profile Catalogs the resource profile information associated with | These reports are used to

Reports a PGE (e.g., generation size of PGE Output data, CPU collate information for a PGE,
Wall Clock Time Used, CPU actual time Used, 1/0 for a type of resource, or for a
Operations). given group of PGEs used to
A profile will be captured for each type of machine, i.e., | fulfill a Production Request.
Sun, SGil, etc., for which the PGE is to execute.
Statistics are collected to establish standard deviations,
variances, and averages of resource profile values.
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Table 4.5.1-18. Reports (2 of 2)

Report Report Description When and Why Used
Type
| & T Activity Capture information about the activities which have
Report occurred and activities which are occurring in the
Algorithm Integration and Test environment.
PGE Profile capture information to track the updates which have
Update occurred in the PDPS Database to PGE Profiles.
Report
PGE I&T Capture information on PGEs as they progress through These reports are to trouble
Reports the AI&T process. shoot problems and will
These reports include: provide tracking and trend
- Code Analysis Report analysis guidance.
- Standards Checker Report
- File Comparison Reports
- Al & T Discrepancy Reports
- Inspection Reports
- Integration Reports
- Acceptance Reports
4.5.1.8.1 Sample Reports

These reports are described in Sections 4.7, “Resource Planning,” 4.8, “Production Planning,

and 4.9, “Production Processing” of this document.
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4.6 Data Ingest

ECS Data Ingest provides the software capability to acquire data by various methods and transfer
the data into the ECS system. These methods include an automated transfer from prior request
information, polling with or without delivery records for data which is placed at predetermined
locations, and a media transfer method which includes reading tapes. The ECS Data Ingest
subsystem also stores and manages request information, and provides for data preprocessing
storage and insertion into the appropriate ECS storage location.

The ECS Data Ingest subsystem provides a GUI which allows the operator to view past ingest
activities, monitor and control ingest requests, modify system and external data provider
parameters, and initiate hard media ingest. It also provides the Regenerate Failed PDR (Product
Delivery Record) tool which allows the operator to generate PDRs for each granule that failed in a
PDR.
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4.6.1 Data Ingest GUI

The Data Ingest GUI allows the operator to view past ingest activities, monitor and control ingest
requests, modify system and external data provider parameters, and initiate hard media ingest.

Table 4.6.1-1 lists this tool's operational functions.

Table 4.6.1-1. Operator Ingest Functions
Operating GUI Description When and Why to Use
Function
Ingest History | History Log | Displays a log that contains the As needed or for regularly
Log Viewing [Tab results of past ECS ingest requests. |scheduled Ingest performance
- Specifies search criteria (e.g., time | reports or to view previously
range), the provider ID, data set occurred Ingest activities.
name, and request status of the
Ingest History Log for log display.
Ingest Status | Monitor/ < Monitors the status of all or a subset | As required to verify nominal
Monitoring Control Tab | of the ingest requests that are in system operations.
progress.
Operator Monitor/ » Updates (i.e., cancel and resume) an | As needed to cancel a problem
Request Control Tab | on going ingest request on either request on request/granule
Update request or granule level. level; or resume a suspended
request on request/granule
level .
Hard Media Media » Operator performs hard media ingest | As needed to Ingest hard media.
Ingest Ingest Tab (e.g., 8mm tape)
« Media Ingest Session is configured
on the Operator's GUI to accept the
request and submit it to the ECS
system
Modify Operator Operator updates system parameter As needed to tune the system
System Tools Tab | values including: volume threshold, to current or expected daily
Parameters request threshold, communication activity thresholds.
retry count, completed request monitor
time, request monitor screen refresh
time
Modify Operator e Operator updates parameter values | As needed to tune the system
External Data | Tools Tab for each external data provider to current or expected daily
Provider « Value includes volume threshold and | activity thresholds on an external
Information request threshold data provider basis.

lindividual DAAC policy determines the duration for which Ingest History Log information is stored and available for viewing

4.6.1.1 Quick Start Using Data Ingest
To execute the ECS Data Ingest GUI from the command line prompt, type:

>EcInGUIStart <mode>
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where:

<mode> is the ECS mode for the execution, e.g., OPS, TS1, etc.

4.6.1.2 ECS Data Ingest Main Screen

The Ingest Main screen, with the "Welcome to ECS Ingest GUI Interface” screen, is shown in
Figure 4.6.1-1. The major functions available by clicking on tabs on this screen are:

“Ingest Intro” is the default tab that welcomes the user to the tool.

"History Log" provides operations personnel the capability to view ingest activities that are no
longer active (see Section 4.6.1.2.1).

"Monitor/Control" provides operations personnel the capability to monitor and update ongoing
ingest activities in the system (see Section 4.6.1.2.2).

"Operator Tools™ provides operations personnel the capability to modify interactive user
information by external data provider and/or modify system parameters (see Section 4.6.1.2.3).

"Media Ingest"” provides operations personnel the capability to perform hard media ingest. The
delivery record is required for media ingest (see Section 4.6.1.2.4).

There is a Menu Bar at the top of the window for getting help and activating less-frequently used
secondary functions. The Menu Bar capability is available on all Ingest GUI screens. The
following menus are available:

* "File" provides exit capability through the exit or close command and print and save
capabilities, where applicable.

e "Help" displays general and context-sensitive help. Select "On Help™ from the menu to
get detailed help on using help. Select "On Keys" to get help on keyboard and mouse
usage, and for general help on interacting with user interface components.
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Figure 4.6.1-1. Ingest Main Screen Shown in the Ingest Intro Tab
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4.6.1.2.1 History Log Tab

The History Log tab shown in Figure 4.6.1-2 provides operations personnel with the capability to
view ingest requests which are no longer monitored by the Ingest system.

Operations personnel can selectively view the Ingest History Log based on the following search
criteria:

® Ingest Start and Stop Date/Time
e Data Provider

e Data Type

* Final Request Status

Operations personnel can request a Detailed Report or just a Summary Report for the
specified search criteria. The Display button populates the log window with the detailed or
summary information selected. The “History Log” information is displayed in the history log
information window.

Operations personnel can print requested History Log information by choosing the "Print" option
from the File Menu.

Operations personnel can save requested History Log information by choosing the "Save™ option
from the File Menu. The file will be saved in the operator’s default directory. This option is
useful for saving Ingest History and Performance reports to a file for transmission to the SMC.
History and Performance report generation is discussed in Section 4.6.1.8.
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Figure 4.6.1-2. Ingest History Log Tab
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Fields on the “History Log” tab are defined in Table 4.6.1-2 below.

Table 4.6.1-2. History Log Field Descriptions

Field Data Size Entry Description
Name Type
Start Date/Time | mm/dd/yyyy Operator Selected Entry fields for the
Date/Time hh:mm:ss (Default = Current Start Date and Time.
Date/Time - 24 hrs.)
Stop Date/Time | mm:dd:yyyy Operator Selected Entry fields for the
Date/Time hh:mm:ss (Defau|t = Current StOp Date and Time.
Date/Time)

Additional functionality is made available to the operator on the History Log tab through the
following graphical components:

The pull down menu “File”, that provides the capability to exit the GUI,
The pull down menu “Help”, that displays general and context sensitive information;

The radio buttons “Summary Report” and “Detailed Report”, that allow to toggle
between the two possible optional types of report.

The button “Clear All” that clears the current screen.

The selection of possible filters for the history log is automated through the availability of three
lists: “Data Provider”, “Data Type”, and “Final Request Status” from which the operator
can chose a number of possible options.

4.6.1.2.2 Monitor/Control Tab

Clicking on the Monitor/Control tab brings up the Monitor/Control tab as shown in Figure
4.6.1-3. This tab provides operations personnel with the capability to monitor ongoing ingest
activities in the system and can alert the operator if a request has passed the requested expiration
date. The Control aspect allows the operator to cancel a request on either request or granule level.
It also allows a suspended request to be resumed at either request or granule level.

The Ingest Monitor/Control tab is divided into four regions:

Search By: allows operations personnel to view all or selected ingest requests in the
system.

View selection.—Using the Graphical View or the Text View button controls the type
of display. The Monitor/Control tab defaults to show the graphical view for the request
information (Figure 4.6.1-3). If the text view button is selected, the text view region is
shown as indicated in Figure 4.6.1-4.

Control Types — designed to provide operations personnel with the capability to update
ongoing ingest activities in the system. Update services include resume and cancel.
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Figure 4.6.1-3. Ingest Monitor/Control Tab (Graphical View)
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Table 4.6.1-3 describes the fields available on the Monitor/Control tab.

Table 4.6.1-3. Ingest Monitor/Control Tab Field Descriptions

Field Name Data Size Entry Description
Type
Request ID Integer N/A Operator Selected Searches for a specific

request currently in the ingest
system.

Additional functionality is offered to the operator through the following graphical components:

The “File” pull down menu that provides exit capability;
The “Help” pull down menu that displays general and context-sensitive help;

The “Monitoring.../Control...” event label is used to display the current state of the
underlining process. “Monitoring... “ lets the operator view the list of the current
requests, with information including the Request ID, the Processing Start
Date/Time, and the Percent Complete in the Graphical view and the Request Id, the
Status, the Data Provider, the Ingest Type, the Priority, and the Start Date in the
Text View. “Control...” allows the operator to cancel or resume a request or a granule
from a list;

The pull down list “Data Provider”, which allows the operator to select from a list of
valid external data providers;

The “All Requests” toggle button that displays all requests currently in the system;

The “Suspend” radio button that suspends the processing of an ongoing ingest request
(inactive);

The “Resume” radio button that resumes the processing of a previously suspended ingest
request on either request or granule level;

The “Cancel” radio button that aborts the processing of an ongoing ingest request on
either request or granule level;

The “Priority” radio button that is used in conjunction with a pulldown list of allowed
priority levels allows the operator to assign a priority order to an ingest request (inactive).

4.6.1.2.3 Operator Tools Tab

Clicking on the Operator Tools tab brings up the Operator Tools window shown in Figure 4.6.1-5.
This tab provides the means to set system-level and data provider-level threshold and setup
information for simple throttling of the ingest process. In particular, operations staff may control
both the number of requests to be processed concurrently and the amount of data to be ingested
concurrently (for the entire site and for each data provider individually). Note: All system-level and
data provider-level thresholds and setup information will have initial values at the time of delivery.

The Operator Tools tab is divided into three subtabs:

Modify External Data Provider / User Information subtab allows setup of
thresholds and user information for external data providers, including authorized science
users who interactively request data ingest (see Figure 4.6.1-5)
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e Modify System Parameters subtab allows setup of thresholds and system
information on a system-wide basis as shown in Figure 4.6.1-7.

* File Transfer subtab allows setup of external node information as shown in Figure
4.6.1-8.
See Tables 4.6.1-4, 4.6.1-6, and 4.6.1-7 below for a description of fields that appear,
respectively, in the External Data/User Information, Modify System Parameters, and
File Transfer subtabs.

In addition to the above input fields the three Operator Tools tabs include other graphical elements
that provide additional functionality to the operator.

“File” and “Help” pulldown menus allow, respectively, for exiting capability and displaying of
context sensitive help information.
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Figure 4.6.1-5. Operator Tools - External Data Provider/User Information
Subtab
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The Modify External Data Provider/User Information subtab includes a pull down list that allows
for the selection of valid External Data Provider IDs. The operator clicks on OK to implement
the changes or Clear All to delete all the modifications operated so far.

Table 4.6.1-4. Operator Tools - External Data/ User information Tab
Field Descriptions
Field Name Data Size Entry Description
Type
FTP Username | TextField |10 Operator Selected Username of the external data provider
(Default = current at a remote node holding data.
value or blank, if no
current value exists)
FTP Password | Text Field |30 Operator Selected » Provides an input entry field for FTP
(Default = blank) Password
* The FTP Password is NOT reflected to
the screen when the operator inputs
information (and is encrypted prior to
storage)
Email Address Text Field | 255 Operator Selected Email address of external data provider.
(Default = blank)
HTML Password | Text Field |30 Operator Selected  HTML password for authorized
(Default = blank,) science users
e The HTML password is NOT reflected
to the screen when the operator
inputs information (and is encrypted
prior to storage)
CDS Entry Text Field | 255 | Operator Selected Provides the CDS entry for the given
Name (Default = current data provider.
value or blank, if no
current value exists)
Server Text Field | 36 Operator Selected Provides the UUID for the given data
Destination (Default = current provider.
uuID value or blank, if no
current value exists)
Volume Integer n/a Operator Selected Provides the current ingest volume
Threshold threshold for the given data provider
and an input area to set a new value.
Request Integer N/A Operator Selected Provides the current ingest request
Threshold threshold for the given data provider
and an input area to set a new value.
Priority Level Integer N/A Operator Selected Provides the priority level of the Data
Provider. (e.g., Normal, VHIGH)

The Priority Level of the Data Provider can be changed using a list of valid priority levels
(default is VHIGH).
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If the toggle button Update Notify Parameters is selected in the External Data
Provider/User Information subtab the Notify Parameter pop-up appears as shown in
Figure 4.6.1-6. Table 4.6.1-5 describes the fields contained in this pop-up. With the OK and
Cancel buttons on the Notify Parameter, the operator can accept or delete the changes made.

‘Buffer

Figure 4.6.1-6. Update Notify Parameters Pop-up
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Table 4.6.1-5 describes the fields on the Update Notify Parameters Pop-up.

Table 4.6.1-5. Update Notify Parameters Field Descriptions
Field Name Data Type Size Entry Description
Notify Type Text Field 10 Operator Provides Notify Type for the given data
Selected
(Default = current
value or blank, if
no current value
exists)
Notify FTP Node | Text Field 255 Operator Provides Notify FTP node for the given
Selected data provider.
(Default = blank)
Notify FTP Text Field 255 Operator Provides Notify FTP directory for the
Directory Selected given data provider.
(Default = blank)
Notify FTP Text Field 10 Operator Provides Notify FTP username for the
Username Selected given data provider.
(Default = blank)
Notify FTP Text Field 30 Operator » Provides an input entry field for Notify
Password Selected FTP Password

(Default = blank)

e The Notify FTP Password is NOT
reflected to the screen when the
operator inputs information (and is
encrypted prior to storage)

Figure 4.6.1-5 is the Modify System Parameters subtab.
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Figure 4.6.1-7. Operator Tools - Modify System Parameters Subtab
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Table 4.6.1-6 describes the fields on the Modify System Parameters subtab.

Table 4.6.1-6. Operator Tools Modify System Parameters
Field Descriptions
Field Name Data Type Size Entry Description

Volume Integer n/a Operator Selected | Provides the current system volume

Threshold (Default = current | threshold and an input area to set a
value) new value.

Request Integer N/A Operator Selected | Provides the current system setting

Threshold (Default = current | for ingest maximum requests and an
value) input area to set a new value.

Communication | Integer N/A Operator Selected | Provides the current

Retry Count (Default = current | Communication Retry Count and an
value) input area to set a new

Communication Retry Count.

Communication | Integer N/A Operator Selected | Provides the current system setting

Retry (Default = current | for communication retry interval in

Interval value) minutes and an input area to set a

new value.

Monitor Time Integer N/A Operator Selected | » Provides the current amount of
(Default = current time (in minutes) that a completed
value) request is retained on the

monitoring display prior to removal.
« Provides an input area to set a new
monitor time

Screen Update | Integer N/A Operator Selected | » Provides the current system

Time (Default = current setting for screen update interval
value) in seconds and an input area to set

a new value

The OK and Clear All buttons will allow operators to accept or delete changes to the System

Parameters.

Figure 4.6.1-8 is the File Transfer subtab.
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Figure 4.6.1-8. Operator Tools - File Transfer Subtab
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Table 4.6.1-7 describes the fields on the File Transfer subtab.

Table 4.6.1-7. Operator Tools - File Transfer Field Descriptions

Field Name Data Type Size Entry Description
Filter Text Field unlimited | Operator Selected | Provides a default directory for file
Selection Text Field unlimited | Operator Selected | Provides the name of file for transfer
Transfer Text Field unlimited | Operator Selected | Provides the file transfer destination
Destination
Directories character unlimited | System generated | list of directory available for filtering
Files character unlimited | System Generated | list of files available for filtering

The buttons at the top of the window allow to specify if the operation objective is to perform a
Generic File Transfer or to Build SMC History Files. With the OK button, the operator

initiates the desired file transfer.

4.6.1.2.4 Media Ingest Tab

Clicking on the Media Ingest tab brings up the Ingest Media window as shown in Figure 4.6.1-
9. This tab provides DAAC operations personnel with the capability to perform media ingest (e.g.,
specifying media for ingest, such as 8mm tape).

The Ingest Media Ingest tab is divided into three regions:

* Media Type — allows the operator to select three types of media (8mm tape, 4mm tape, and

D3 tape)

e Data Provider and Media VVolume ID - allows the operator to specify media stacker
information (if a stacker is available for the media type), the media provider 1D, and media

ID.

e Data Delivery Record File Location— allows the operator to specify the location of the media
data delivery record file, which is required for media ingest. The file could either be
embedded in the hard media or be made available electronically. If not embedded on the
hard media, the Delivery Record file must be in an ECS disk location. The external data
provider must connect with that location via ftp prior to delivering the hard media to ECS.

A different GUI is presented if the media type chosen requires a stacker. See Figure 4.6.1-9 for an
example of a GUI without a Stacker. See Figure 4.6.1-10 for an example of a GUI with a Stacker
ID. Table 4.6.1-8 describes the fields of this tab.
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Figure 4.6.1-9. Ingest Media Tab (Without Stacker ID)
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Figure 4.6.1-10. Ingest Media Tab Requiring Stackers
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Table 4.6.1-8 describes the fields on the Ingest Media tab.

Table 4.6.1-8. Ingest Media Field Descriptions

Field Name Data Type Size Entry Description

Media Volume |[integer N/A Operator Selected | Media Volume ID input

D

DDR File Name | character unlimited | Operator Selected | Name of the Data Delivery
Record file

Stacker Slot ID | integer N/A Operator Selected | Provides the location (slot ID) of

the hard media in the stacker
(Presented if Media Type
chosen requires a stacker)

Stacker ID integer N/A Operator Selected | ldentifies the media stacker in
which the media is to be
inserted(Presented if Media
Type chosen requires a stacker)

Media Type Character N/A Operator Selected | Media type (e.g., D3 Tape, 8mm
Tape)
Data Provider | Character N/A Operator Selected |Data Provider identification.

Media Type and Data Provider can be selected from lists of valid names. The location of the
Data Delivery Record file can be selected through by toggling the On Network and Embedded
in Media buttons.

With the OK and Clear All buttons the Operator can accept start the Ingest session or delete the
entries input in any of the fields.

4.6.1.3 Required Operating Environment

For information on the operating environment, tunable parameters, and environment variables refer
to the 910-TDA-022 “Custom Code Configuration Parameters” documentation seriesThe following
table 4.6.1-9 identifies the supporting products that the Data Ingest depends on in order to function
properly in the ECS environment:

Table 4.6.1-9. ECS Data Ingest Product Dependency

Product Dependence Protocol Used Comments
INS GUI X-11 via client libraries
INS GUI and ReqMgr DCE via RPC call

4.6.1.4 Databases

The ECS Data Ingest Tool interface with the Ingest Database. For details about the design and
schema of the Ingest Database refer to 311-CD-103-005, Ingest Database Design and Schema
Specifications.
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4.6.1.5 Special Constraints
None.

4.6.1.6 Outputs
Operations staff have access to three output logs, described in Table 4.6.1-10.

Table 4.6.1-10. Outputs

Output Description and Format
Ingest history log The Ingest history log contains summary information about ingest request status.
Stored in Sybase.
MSS event log The MSS event log contains critical events of interest to DAAC operations staff.
Stored in MSS.
Ingest event log The Ingest event log contains critical and detailed events of interest to DAAC
operations staff. Stored in a flat file.

4.6.1.7 Event and Error Messages

The Ingest interface issues both status and error messages to the event log file. Error messages fall
under the following categories: common messages, history log messages, ingest media ingest
messages, ingest request controller messages, and ingest threshold controller messages. Both
event and error messages are listed in Appendix A.

4.6.1.8 Ingest Reports

In addition to ad hoc ongoing request status displays discussed above, the Ingest subsystem
provides the standard reports described in Table 4.6.1-11. These reports can be invoked through
the History Log Tab discussed in Section 4.6.1.2.1.
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Table 4.6.1-11.

Standard Ingest Production

Reports

Report Type

Report Description

When and Why Used

Ingest Request
History Report

The report supplies operations staff with a view of ingest
request completion performance. It provides a detailed
log of the ingest requests in the reporting period
(including requester, data source, data type, the times of
various ingest events such as request receipt and
completion, data volume, etc.).

The report also provides summary statistics for the
reporting period, such as completed vs. unsuccessful
requests, backlog development, average ingest volumes
and processing times broken down by various
categories.

The report may be
generated for specified
time periods and
executed on a regular
basis (based on site

policy).

Ingest Request
Performance
Report

The report supplies operations staff with a view of ingest
performance. It provides summary statistics for the
reporting period, such as completed vs. unsuccessful
requests, backlog development, average ingest volumes
and processing times broken down by various
categories.

The report may be
generated for specified
time periods and
executed on a regular
basis (based on site

policy).

Ingest Granule
Performance
Report

The report supplies operations staff with a view of ingest
granule-level performance. It provides summary statistics
for the reporting period, such as completed vs.
unsuccessful requests, backlog development, average
ingest volumes and processing times broken down by
various categories..

The report may be
generated for specified
time periods and
executed on a regular
basis (based on site

policy).
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4.6.1.8.1 Sample History Reports
An example Ingest Request History Report is shown in Figure 4.6.1-11.

Req Data Compl Ingest Start End Total Success Granules Data Volume File Count Transfer Pre - Proc Archive Priority Restart
1D Provi . Type Time Time Granules Time Time Time Flag

der Status
— —
00100 TSDIS | OK

01.0597 | 010597 | L T 1125 5 53.6 3.2 23.4
12:31:06 13:51:16

IS |

Figure 4.6.1-11. Sample Ingest Request History Report

An example Ingest Request Performance Report is shown in Figure 4.6.1-12.

Data Provider Total Total Granules Files Size Transfer Time | Pre - Proc Time | Archive Time
Requests quuest Avg | Max | Avg | Max Avg | Max Avg | Max Avg | Max Avg | Max
rrors
SDPF 112 2 54 | 112 | 62 |33 | 106. | 1145 |51 [105 |7 23 12 | 212
6 5
TSDIS | ......  [|......

Figure 4.6.1-12. Sample Ingest Request Performance Report
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An example Ingest Granule Performance Report is shown in Figure 4.6.1-13.

Files

Data Data Total Total Granule Transfer Pre - Proc Archive Time
Provider | Type | Granules | Granules Avg|Max Vol. Time Time Avg | Max
with Avg | Max Avg | Max Avg | Max
Errors
SDPF CERO 112 21 62133 |[106.]114. 51 105 7 23 12| 212
0 6 5 5
SDPF | .... |  ......

Figure 4.6.1-13.
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4.6.2 Regenerate Failed PDR Tool

The Regenerate Failed PDR tool provides the ECS Operations Staff with the ability to generate a
PDR for each failed granule in a PDR and copy the generated PDRs to an Ingest polling directory
using a command line interface. This tool can be used when a PDR fails with a long PAN message
file. A long PAN means that the request had more than one granule and not all granules had the
same error. The purpose of the tool is to provide a means for the ECS Operations Staff to easily
resubmit only failed granules to Ingest polling, rather than having to manually edit the original
PDR file or resubmit all of the granules which would create duplicate granules in the archive.

4.6.2.1 Quick Start Using the Regenerate Failed PDR Tool
The Regenerate Failed PDR tool is started by entering the following command:

>EcInRegenFailedPDRStart <mode>

The mode parameter specifies the mode in which the program is to run. The tool can run in any
mode, e.g., OPS, TS1, etc. Modes are established by the DAAC operations staff.

4.6.2.2 Regenerate Failed PDR Tool Main Screen

There is no GUI for the Regenerate Failed PDR tool. The DAAC operations user interacts with the
Regenerate Failed PDR Tool by responding to the following prompts output by the program.

1. Generate PDRs
2. Quit
>>1

Please enter PDR filename with path
>>

Please enter PAN filename with path
>>

Please enter the path of the Polling directory into which the PDRs should be copied
>>

The new PDR file <filename> was created successfully.
Please inspect this PDR file and correct any errors found.
Do you want this PDR to be moved to the Polling directory (y/n)?
If nis entered:
Do you want to delete the PDR file <filename> (y/n)?

4.6.2.3 Required Operating Environment

For information on the operating environment, tunable parameters, and environment variables refer
to the 920-TDx-013 “Custom Code Configuration Parameters” documentation series. The “X”
refers to the installed location, e.g. 920-TDG-013 is for GSFC DAAC.

4.6.2.3.1 Interfaces and Data Types

The Regenerate Failed PDR tool is a stand-alone tool, so it has no dependencies on supporting
products.
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4.6.2.4 Databases

The Regenerate Failed PDR tool does not include the direct managing of or interfacing with any
database.

4.6.2.5 Special Constraints

The Regenerate Failed PDR Tool needs to have access to the PDR and PAN files which are to be
used. It also needs to have access to the Ingest polling directory into which the generated PDRs are
to be moved. Note also that the Regenerate Failed PDR Tool is started through a start script which
specifies that the EcInRegenFailedPDR.CFG configuration file be used to initialize the
environment.

4.6.2.6 Outputs

The Regenerate Failed PDR Tool’s output consists of prompts return to the command line
interface, error messages returned to the command line interface as described in Section 4.6.2.7,
messages written to the application log file (EcInRegenFailedPDR.ALOG), and the generated PDR
files.

4.6.2.7 Event and Error Messages
Refer to Appendix A for the error messages displayed by the Regenerate Failed PDR Tool.

4.6.2.8 Reports
None
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4.7 Resource Planning

This section describes the Resource Planning tools used by DAAC operators. These tools are
accessible through Resource Planning GUIs.
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4.7.1 Resource Planning

Resource planning is accomplished by operations through a Resource Editor tool that is used to
define the resources that will be allocated to run production data and a Resource Scheduler GUI
that is used to create resource reservations. The Resource Scheduler can also display resource
reservations on a time line.

The Resource Editor GUI can define hardware resources such as disks and host computers (‘real
computers’) as well as virtual resources such as ‘virtual computers’ which are the collections of
CPUs and disks. The list of resources can be created from scratch or they can be initially obtained
from a resource configuration in MSS.

A resource plan is defined by a set of approved resource reservations. The Resource Scheduler
GUI is used by the resource planner to create, validate and approve reservations until a conflict-
free plan is achieved. At this point the reservations will be “committed” and the reservations
become ground events. The Ground Event activities include maintenance, test, and training. .

Table 4.7.1-1 provides a high level summary of the activities of the Resource Planning GUISs.

Table 4.7.1-1. Common ECS Operator Functions Performed with
Resource Planning GUIs (1 of 2)
Operating GUls Involved Description When and Why to Use
Function

Ingest /create and
modify resource
configuration.

Resource Editor,
Virtual Computer
Details,

Disk Details,

Hardware Detalils,
String Details,

Real Computer Details,
Autosys Details.

Obtains from the MSS CM
system a list of system
resources that are used
for resource planning and
to edit/ add to these
resource items.

* To define system
resources.

e To add and modify
resources.

Enter a resource
reservation
request.

Resource Scheduler,
Reservation
Edit/Definition,
Resource Selection,
Intervals Selection.

The resource planner
enters a request for a
resource reservation.

To define the resource
reservation for testing or
maintenance.

Review resource
reservation
requests in the
system.

Resource Scheduler,
Reservation
Edit/Definition,
Resource Selection,
Intervals Selection.

The resource planner
reviews the resource

reservations that have
been made.

To support resource
allocation process, to aid in
preparing a resource
reservation request, or to
inspect the use of system
resources.
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Table 4.7.1-1. Common ECS Operator Functions Performed withA
Resource Planning GUIs (2 of 2)A

Operating GUls Involved Description When and Why to Use
Function
Commit approved | Resource Scheduler The resource planner To register the reservation
resources. allocates a resource to a as the ground event.

particular activity.
Review Timeline. | Resource Reservation | A timeline oriented view To aid in planning resource

Planning Master of resource allocation for | use within the system.
Timeline all configured system
resources.

4.7.1.1 Quick Start Using Resource Planning
There are two main applications associated with Resource Planning:

e Resource Scheduler GUI is used to enter a new resource reservation, to modify an
existing resource reservation request, to approve a resource reservation, to commit
approved resource reservations, to view a timeline format display of all approved resource
reservations, and to delete an existing reservation.

* Resource Editor GUI is used to add or delete resources or modify the characteristics of
resources.

To invoke the Resource Editor GUI from the command line, enter:
EcPIRpReStart <mode> <MSGSVR_ID>

<mode> is the ECS mode for the execution.

<MSGSVR_ID> is the TBS Server ldentifier.

To execute the Resource Planning Scheduler from the command line, type:
EcPIRpSiStart <mode> <MSGSRV_ID>

<mode> is the ECS mode for the execution.

<MSGSVR_ID> is the TBS Server ldentifier.

4.7.1.2 Resource Scheduler Main Screen

The Resource Scheduler GUI, depicted in Figure 4.7.1-1, appears when the Resource Scheduler
Icon is clicked. This GUI presents a list of the resource reservations entered into the system, with
one line of information per resource reservation. The list can be filtered by activity type by clicking
on the button displayed next to “Activity Type” at the top left of the screen. The selection button
lists each of the activity types defined to resource planning, e.g., ‘Testing’. Selecting an activity
from this list limits the display to resource reservations with that type of activity specified.
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Figure 4.7.1-1. Resource Scheduler GUIA
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There are several buttons at the bottom of the GUI which affect the status of the reservations. The
functions associated to these buttons are also accessible from the menu bar. These buttons and
their actions are:

New ... - Used to enter a new resource reservation request. This brings up the Resource
Reservation Request Edit/Definition GUI described in the section 4.7.1.1.3.

Modify ... - Used to edit or review the details of an existing resource reservation request.
First select a resource reservation entry from the list in the Resource Planning GUI, then click
on ‘Modify...” This brings up the Resource Reservation Request Edit/Definition GUI for the
selected resource reservation

Approve - Used to indicate that all reviews associated with the resource planning process
have taken place and there are no objections to the resource usage as described by the request.
Clicking on this button checks if there is any conflict between this resource reservation and
other reservations. Error messages are displayed if conflicts are detected

Commit globally - Commits all approved resource reservations. At this point, the
information related to the activity and its reserved resources is accessible by the production
planning software.

Timeline - Displays a timeline oriented view of the resource plan in the Resource Reservation
Plan Timeline GUI. This GUI is discussed further in Section 4.7.1.1.4.
In addition, on the menu bar, the pulldown menus provide the following capabilities.

‘File’ Pulldown:

New - Same as the ‘New’ button on the GUI - used to enter a new resource reservation
request.

Open - Same as the ‘Modify...” button on the GUI - used to update information for an
existing resource reservation request.

Delete - deletes a resource reservation request.
Exit - exits the application.
‘Options’ Pulldown:

Timeline - Same as the “Timeline’ button on the GUI - used to display a timeline oriented
view of the resource plan.

4.7.1.2.1 Resource Reservation Request Edit/Definition GUI

From the Resource Planning GUI, a user enters a new resource reservation, or reviews an existing
resource reservation. Either selection displays the Resource Reservation Request Edit/Definition
GUI shown in Figure 4.7.1-2.
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Request Name:

Edited Date: 04/13/1999 At 21:04:13

Originator: ioriginator

sponsor: [N

RN 0
Activity: |pr0duct1’on —II it |

Description: newyc

Resource .. | Interval... |

Start Day as "MM/DD/YYyy" PUlFPtFRELT] Start Time as "HH:MM:SS"  [UEEELRUE]
Stop Day as "MM/DD/vvyy" [UUEAEFEEED] Stop Time as "HH:MM:SS" 19:39:03
Frequency: Every_7_days —
+ Rejected + Validated Status:

Comments:

Save Clear Cance1|

Figure 4.7.1-2. Resource Reservation Request Edit/Definition GUI

Table 4.7.1-2 describes the fields of the Resource Reservation Request Edit/Definition GUI.
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Table 4.7.1-2.

Resource Reservation Request Edit/Definition GUI

Field Description

Field Name |Data Type Size Entry Description
(# of
characters )
Request ASCII <=40 user A name for the resource request
Name characters input,
required
Edited Date |Date 40 system Date of resource request entry
generated
Originator ASCII <=30 system Userid of the user entering the resource request.
characters generated
Sponsor ASCII <=30 user input | Name of the individual designated to review and
characters validate the Resource Request for completeness,
etc.
Priority Integer 3 user The priority for the activity
provided
Description  |ASCII 30 User User description of the activity for which the
characters provided, |resource is required
optional
Start Day Date 10 User The start date of the resource request.
provided,
required
Start Time Time 8 User The start time of the resource request.
provided,
required
Stop Day Date 10 User If the reservation is to be repeated at some
provided, |frequency, the stop date specifies the end date
required |[for the repeated request.
Stop Time Time 8 User The stop time of the resource request.
provided,
required
Frequency: |Resource - User The Frequency: pulldown menu offers the
reservation provided, |options listed in Table 4.7.1-3 to specify how the
request required |resource request should be repeated over the
repeat term from Start Time to Stop Time. If the
interval. “Every_? days” is selected, the user enters the
interval in days in the associated text field to the
right.
Status ASCII <=20 system Displays the status of the request, e.g.,
characters generated|‘approved’, ‘validated’, etc.
Comment ASCII unlimited |User User comment on the resource reservation
characters provided, |request.
optional

Selecting the ‘Resources ...” button will display the Resources Selection GUI, shown in Figure
4.7.1-3, that displays two lists, one containing all of the available resources and the other listing
the resources that the operator selects for incorporation into the resource reservation. The user
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selects the desired resource by means of the arrow buttons. The name of the resource request is
displayed, once the reservation is saved.

= Bl

reauest Nane: [FR S
‘Resources: Selected Resources:

AS1 °q - B new\C
newComputer E '

newsString

realConputer a -‘l .
tapelil . ;
vel

- Caﬁce1|

=

Figure 4.7.1-3. Resources Selection GUI

In the time period specification region of the Resource Reservation Request Edit/Definition GUI,
the user can specify the frequency of occurrence of a repeating resource request. Several options
for expressing the frequency are available in the ‘Frequency’ selection list box combined with a
text field that provides a qualifier. The available frequency options are listed in Table 4.7.1-3.

Table 4.7.1-3. Frequency Qualifiers for Resource Reservation Request
Edit/Definition GUI (1 of 2)

Frequency Text Result
Specifier Qualifier

Once - The default. Resource reservation covering the period from the start time
and stop time for the start date specified.

Monthly - Resource reservation for every month on the start day of the month,
repeated until the end date as specified.

Daily - Resource reservation for every day, between the start date and end date,
for the start time and end time specified.

Every M-W-F | — Resource reservation for every Monday, Wednesday, and Friday, between
the start date and end date, for the start time and end time specified.

Every - Resource reservation for every Monday through Friday, between the start

M-through-F date and end date, for the start time and end time specified.

Every T,Th - Resource reservation for every Tuesday & Thursday, between the start
date and end date, for the start time and end time specified.
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Table 4.7.1-3. Frequency Qualifiers for Resource Reservation RequestA
Edit/Definition GUI (2 of 2)A

Frequency Text Result
Specifier Qualifier

Weekends - Resource reservation for every Saturday & Sunday, between the start date
and end date, for the start time and end time specified.

‘Every_? day | n-days Resource reservation for every n-days, between the start date and end

s’ date, for the start time and end time specified.

The “Intervals ...” button provides the mechanism to tailor a ‘Frequency’ based request by
overriding selected intervals. If the user selects the ‘Intervals ...” button, the Intervals Selection
GUI shown in Figure 4.7.1-4 is displayed, providing two lists. The window on the left displays a
list of dates selected through the ‘Frequency’ button. The window on the right shows dates that the
operator selects for exclusion from the initial interval. Items are moved from one list to the other
by selecting the item and using the arrow keys. The name of the resource request is also displayed.

—| Intervals Selection [4]1
Unselected Intervals: Selected Intervals:

10/29/1999
11/03/1999
11/08/1999
11/13/1999

u 0k | Cancel | 4

Figure 4.7.1-4. Intervals Selection GUI

4.7.1.2.2 Resource Reservation Planning Master Timeline GUI

From the Resource Planning GUI, the user can select the ‘“TimeLine’ button to view a timeline
format display of all approved resource reservations, similar to the example displayed in
Figure 4.7.1-5.

The Resource Reservation Planning Master Timeline GUI represents a set of resources, arranged
along the left side of the GUI, and some period of time as indicated across the top edge of the
GUI. The use of a resource over a period of time is represented by one or more ‘resource
reservation’ bars across the GUI. A bar represents a time period during which a resource
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reservation has been approved for the resource. Each bar has the name of the resource reservation.
At those times where a reservation has not been placed against a resource, that resource is allocated
to a default activity (which can vary by resource). For example, science processing computers are
used for science processing unless a reservation has been placed against them. Scroll bars allow
scrolling up and down through the full list of resources and left and right in time. A select list of
time span viewing options (e.g., 24-hours, 48-hours) at the lower left of the screen is available for
selecting the time span of interest.

Figure 4.7.1-5. Resource Reservation Planning Master Timeline GUI

The capabilities to adjust some of the timeline display features (e.g., colors) are available through
the pulldown menus located at the top of the GUI. These capabilities include:
e ‘File’ Pulldown:
- Quit - Exits this application and returns to the Resource Planning GUI
e ‘Display’ Pulldown:
- Change Color - Changes the color setup of the display.
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— Change Resource - Selects or filters the resources displayed in the timeline.
- Change Timescale - Changes the plan window start and stop time

4.7.1.2.2.1 Report Generator GUI
Note, this functionality will be made available in future releases.

Figure 4.7.1-6. Report Generator GUI (Future Release)

4.7.1.3 Resource Editor GUI

The resource list may be created from scratch or be initialized from the MSS-managed
configuration list, through a ‘fetch baseline’ operation.  Resources may be added to or deleted
from the resource list without affecting the MSS configuration list. This is useful, for example, for
identifying resources that will be available in the future for the purposes of planning. The
Resource Editor GUI, shown in Figure 4.7.1-7, is the tool used for adding resources or modifying
the characteristics of existing resources. On start-up, the Resource Editor GUI displays a list of
the resources known to the resource planning tool. To add a new resource the operator first
selects a resource type using the Resource Type selection button 1. Then the operator clicks on
the “New...’button The characteristics of an existing resource can be modified clicking on the
resource in the resource list and clicking on ‘Modify...". A resource can be removed by selecting
it and clicking on ‘Delete’.

The retrieval of configuration information is a two step process. First a Tivoli job is run (see
Section 4.2.3) that generates a file of configuration information used by Resource Planning. This
job is run by pressing the ‘Fetch Baseline’ button. When the Tivoli job has completed, press
the ‘Load Baseline’ button to extract the needed information from the Tivoli generated file and
load it into the PDPS database.

The GUIs for the definition of specific resource are discussed in the following subsections.
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' Resource Name T . T Activity

N AS1 AUTOSYS production
disk DEVICE production
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Figure 4.7.1-7. Resource Editor GUIA
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In addition, the ‘File’ pulldown located on the menu bar provides an ‘Exit’ option to leave the
application.

4.7.1.3.1 Hardware Details GUI

The Hardware Details GUI, shown in Figure 4.7.1-8, is used to define the characteristics of
generic hardware resources at the DAAC, such as communications equipment.

Resource Name: FIETELE]

..... e Sauel_...-_ cance]l

Figure 4.7.1-8. Hardware Details GUI

The characteristics of the other fields are described in Table 4.7.1-4.

Table 4.7.1-4. Hardware Details GUI Field Description

Field Name Data Type Size Entry Description
(characters )

Resource Name |ASCII <=60 User provided, A user defined name for the resource.
characters required.

Comments ASCII unlimited |User provided, User comment on the resource.
characters optional.

4.7.1.3.2 Disk Details GUI

The Disk Details GUI, shown in Figure 4.7.1-9, is used to define the characteristics of disk
partition type resources.
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Resource Nane:

Comments:

save | . cancel]l

Figure 4.7.1-9. Disk Details GUIs

The characteristics of the other fields are described in Table 4.7.1-5.

Table 4.7.1-5. Disk Resource Details GUI Field Description

Field Name Data Type Size Entry Description
(characters)
Resource Name |ASCII <= 60 User provided, |A user defined name for the resource.
characters required.
Partition Size float <=10 User provided, [The size of the disk patrtition, in bytes.
required.
Block Size Integer <=6 User provided, |Block size used for the disk in bytes.
required.
Comments ASCII unlimited |User provided, |User comment on the resource.
characters optional.

4.7.1.3.3 Virtual Computer Details GUI

The Virtual Computer Details GUI shown in Figure 4.7.1-10 is used to define the characteristics of
virtual computer resources.
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Figure 4.7.1-10. Virtual Computer Details GUIs

The characteristics of the other fields are described in Table 4.7.1-6.
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Table 4.7.1-6. Virtual Computer Details GUI Field DescriptionA

Field Name | Data Type Size Entry Description
(characters)
Resource ASCII <= 60 User provided, |A user defined name for the computer.
Name characters required
Number of  [Integer <=3 User provided, | The number of CPUs within the computer.
CPUs required.
Total RAM Integer <=7 User provided, | The total memory for the computer, in Mbytes.
required.
Operating ASCII <=60 User provided, | The operating system name/version for the
System characters required. computer.
Disks ASCII <= 60 N/A « A list of the disks previously defined for that
characters site.

« This list of disks is used to select from when a
disk is associated (or disassociated) with the
computer using the arrow buttons.

Associated [ASCII <= 60 User provided, |Disks in this list are associated with the

Disks characters required. computer.

Comments |ASCII unlimited |User provided, |User comment on the resource.
characters optional.

4.7.1.3.4 String Details GUI

The String Details GUI, shown in Figure 4.7.1-11,
or a collection of virtual computer resources.

,:

Resource Name:

newString

- Conputers SRS

newyc
vecil

- Comments:

Figure 4.7.1-11.

- associated Computens <.

Cance1|

is used to define the characteristics of a string,

[

newComnputer

String Details GUIs

The characteristics of the other fields are described in Table 4.7.1-7.
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Table 4.7.1-7. String GUI Field DescriptionA
Field Name | Data Type Size Entry Description
(characters)
Resource ASCII <= 60 User provided, |A user defined name for the resource.
Name characters required.
Computers ASCII <=60 N/A. A list of the computers previously defined for
characters that site. This list of computers is used to
select from when a computer is associated
(or disassociated) with the string using the
arrow buttons.
Associated ASCII <=60 User provided, |Computers in this list are associated with the
Computers characters required. string.
Comments ASCII unlimited [User provided, [User comment on the resource.
characters optional.

Note that the Real Computer Details GUI and the Autosys Details GUI are similar to the String
Details GUI. They are shown, respectively, in Figures 4.7.1-12 and 4.7.1-13.

=

|
Real Computer Details [[1] ]

newConputer

Conments:

Save

Resource Name: [HUER TSNS
Activity: production -Jl
Conputers Associated Computers

Cancel

newyC
vci

Figure 4.7.1-12.

Real Computer Details GUIs
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Resource Name: [}

"ﬂ---____Activitvil production _JI T P 0o @

B newString

- Comments:

Save Cancel

Figure 4.7.1-13. Autosys Details GUIs

4.7.1.4 Required Operating Environment

For information on the operating environment, tunable parameters, and environment variables refer
to the 920-TDx-013 “Custom Code Configuration Parameters” documentation series. The “X”
refers to the installed location, e.g. 920-TDG-013 is for GSFC DAAC.

4.7.1.5 Databases

The Resource Planning GUIs relies on the PDPS database to provide all the necessary information
at the start time as well as to save all the updated input data about Resource Planning and Resource
Definition.

Information on the PDPS database is contained within the Production Planning tools portion of this
document, Section 4.8.1.3.

4.7.1.6 Special Constraints
There are no special constraints associated with the Resource Planning tools.

4.7.1.7 Outputs
The Resource Planning tools provide output in 3 forms:

* displays to the GUIs (described above)
e updates to the PDPS database for planning (described in Section 4.8.1.3)
e generates reports(described in Section 4.7.1.8).
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4.7.1.8 Event and Error Messages

The resource planning tools provide informational messages or warnings for minor errors.
Significant resource planning events or errors are logged to the MSS Event Log.

Both event and error messages are listed in Appendix D.

4.7.1.9 Reports
Reporting is planned to be made available in future releases.
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4.8 Production Planning
This section describes the Production Planning GUIs used by DAAC operators.

The Production Planning GUIs are used by the production planner to define the science processing
jobs to be run at a DAAC. The jobs are defined in terms of Production Requests (PRs). A PR is
essentially an order for data to be produced by the data processing subsystem. A single PR may
lead to several jobs being run over time, or to a single job producing a single set of data. PRs
apply to the processing of new data (standard PRs, or standing orders) or the reprocessing of
existing data (reprocessing PRs).

The Planning subsystem uses the PR and information on the science processing software (known
as a Product Generation Executive, or PGE) to prepare a Data Processing Request (DPR). A DPR
corresponds to a single processing job.

Planning subsystem GUIs are used to enter or modify PRs, review DPRs, and produce a selection
of production planning related reports. The production planner uses the GUIs to create plans for
data processing from the PRs defined in the Production Planning Subsystem. The GUIs are also
used by the production planner to activate or cancel a plan.

The Production Planning GUIs are packaged into three applications: the Production Request
Editor, the Production Planning Workbench, and the Production Strategies User Interface. The
Production Request Editor and Production Planning Workbench are accessible through separate
icons from the desktop
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4.8.1 Production Request Editor

The Production Request Editor allows the user to create production requests, which produce data
products. The Production Request Editor is used to perform the functions described in
Table 4.8.1-1.

Table 4.8.1-1. Common ECS Operator Functions Performed with
Production Request Editor

Operating GUI Description When and Why to Use
Function
Generate/Review | Production e The operator enters To process or reprocess ECS
/Edit Production | Request Editor Production Request data.

Requests (PRs) information. When a PR expires, a hew one

PR Edit, PR List | « Production Requests | may need to be input
define processing over
a period of time.

Review Data Production e The operator can A DPR may be reviewed to
Processing Request Editor review the inspect job parameters.
Requests (DPRs) | — characteristics of a

DPR View, DPR particular data

List processing request.

e DPRs are created
automatically from PRs.

4.8.1.1 Quick Start Using Production Request Editor
To execute the Production Request Editor from the command line prompt use:

EcPIPRE_IFStart <mode> where:
<mode> is the ECS mode for the execution, e.g., OPS, TS1, etc.

Refer to the 910-TDA-022 “Custom Code Configuration Parameters” documentation series, for a
listing of ECPIPRE_IFStart.

4.8.1.2 Production Request Editor Main Screen

The Production Request Editor is a collection of display areas in a ‘tab stack’ selection arrangement
— clicking on a tab along the top causes the associated tab “page” (also referred to as the tab) to be
displayed. There are “pop-ups” associated with some of the tabs which expand the displayed area
and provide GUI interaction for sub-functions. The first tab in the *Planning” window, shown in
Figure 4.8.1-1, is the ‘cover page’ or default of the tab stack, which lists and describes the other
tabs. The primary activities associated with the Production Request Editor activity are:

* Production Request Edit Tab
* Production Request List Tab
e Data Processing Request View Tab
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e Data Processing Request List Tab

Figure 4.8.1-1. Production Request Editor GUI Showing the
Planning Tab
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In addition, on the menu bar, the pulldown menus provide the following capabilities.

e File Pulldown:

e Exit - To exit the application.

The PR List tab, shown in Figure 4.8.1-2, and PR Edit tab, shown in Figure 4.8.1-3, have
a lot of commonality. The data displayed on the PR List tab is a subset of the data included
on the PR Edit tab. These data fields are described in Table 4.8.1-2.
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The PR List tab allows the operator to review those PRs that have already been entered into the
system. The PRs are presented in the order in which they appear in the PDPS database as a one
line summary display for each PR. A particular PR can be located by entering a search string in the
field next to the “Find’ button and then clicking on the button. The first occurrence of the search
string will be highlighted. By clicking on (highlighting) a PR and then selecting the File: Open
pulldown option, the PR Edit tab is initialized with information for that selected PR.

The menu bar for the PR List tab and its pulldown menus provide the following capabilities.

e ‘File’ Pulldown:

- Open - Allows the operator to open a highlighted, existing Production Request for
review or editing in the PR Edit tab.

- Exit - To exit the application.
e ‘Edit’ Pulldown:
— Delete — To delete a production request.

The data on the PR List tab are identified by the column headings at the top of the display. These
data descriptions are given in Table 4.8.1-2.
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Figure 4.8.1-3. PR Edit Tab
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On the menu bar for the PR Edit tab, the pulldown menus provide the following capabilities.

e ‘File’ Pulldown:
- New — When selected, the fields are cleared to allow entry of a new Production
Request.

- Open — Allows the operator to select an existing Production Request for review or
editing. This function uses the File Selection Pop-up (Figure 4.8.1-4) invoked by
Save As.

- Save As... - Allows the operator to save the displayed Production Request and give it
a new PR name. This function uses the File Selection Pop-up (Figure 4.8.1-4)
invoked by Open.
- Exit - To exit the application.
e ‘Edit’ Pulldown:

— Delete — To delete a production request.

Most PRs will be slight modifications of existing PRs, for example, to change the time duration of
a PR. The process for entering a new PR is usually to select an available PR via the File: Open
feature. The user then would modify the parameters as necessary and save the new PR through the
‘Save As...” option on the “File’ menu bar of PR Edit. This action brings up a separate pop-up
to name the new PR. Also, a completely new PR may be entered directly via the PR Edit tab.
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Figure 4.8.1-4. File Selection Pop-up

The PR Edit tab fields are organized into six regions: Production Request Identification, Request
Definition, Duration, PGE Chain Head / Computer, Intermittent DPR, and Comment. The
individual fields of the PR Edit tab are described in Table 4.8.1-2.
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Table 4.8.1-2. PR Edit Field Description (1 of 2)

Field Name Data Size Entry Description
Type
Production Request - - - Information used to identify the PR and the
Identification originator
PR Name ASCII <27 user input, |[a name for the PR
characters required
PR Type GuUI N/A click Routine
selection On Demand
Reprocessing
User Type GUI N/A click Operator
selection DAAC Manager
Scientist
Researcher
Origination Date Date 10 system date of PR entry
(UTC) generated
Originator ASCII <25 system user ID of the user entering the PR.
characters generated
Priority Integer <3 user input, |priority to be associated with the PR;
required |l<value<99
Production Request - - - Information defining the PR
Definition
Satellite Name ASCII <25 system Satellite name, if applicable, with which the
characters generated |[PR/PGE is associated; displayed when PGE
is selected.
Instrument Name |[ASCII <20 system instrument name, if applicable, with which
characters generated [the PR/PGE is associated; displayed when
PGE is selected.
PGE Name ASCII <12 system Name of PGE to be used in the PR;
characters generated |displayed when PGE is selected.
PGE Version ASCII system The version number of the PGE to be
characters generated |associated with the PR; displayed when PGE
is selected.
Profile ID Integer <3 system The Profile Id of the PGE to be associated
generated [with the PR displayed when the PGE is
selected.
CollectionTime Data start/stop time
Insertion Time Time ASTER tape was inserted by the DAAC
Duration - - - Time range over which the PR is applicable
UTC Time Button N/A user input [UTC radio button, for use when instrument is
required [time based. UTC start/stop date/times will

then be required.

4.8.1-9

609-CD-600-001



Table 4.8.1-2. PR Edit

Field Description (2 of 2)

Field Name Data Size Entry Description
Type
Orhit Button N/A user input|Orbit radio button, for use when the instrument
required |is orbit based, such as MISR. The user will
then be required to enter the orbit number
instead of start/stop date/time. After the orbit
number is entered, the user can hit the UTC
radio button, and the start/stop date/time for
the orbit selected will appear in the Collection
Time Begin/End display.
Start Date Date 8 user start date of instrument data to be processed
input,
required
Start Time Time 6 user start time of instrument data to be processed
input,
required
End Date Date 8 user end date of instrument data to be processed
input,
required
End Time Time 6 user end time of instrument data to be processed
input,
required
From (Orbit) Integer <8 user input|User can select orbit from number as an
alternative to UTC Time.
To (Orbit) Integer <8 user input|User can select orbit to number as an
alternative to UTC Time.
Tile Id Integer <8 User input|User enters the number of the tile requested.
PGE Chain Head Button N/A User input|Radio button indicating whether the PGE
required |associated with displayed PR is the first in a
chained PGE scenario.
Computer ASCII <60 User input|User clicks on the down arrow to display a list of
characters required |computers on which DPRs can run. Selecting
a computer populates the field.
Intermittent DPR
Skip Integer <6 user input|Number of DPRs to skip
Keep Integer <6 user input|Number of DPRs to keep
SkipFirst Flag GUI user Determines whether the first DPR is skipped or
selected [kept.
Comment ASCII <255 user user comment associated with the PR
characters input,
optional
Status ASCII <20 system [current status of the PR
characters generate
d

4.8.1-10

609-CD-600-001



There are 4 function selection buttons in the Request Definition section of the screen:
1. PGE Selection button

As a part of the PR Edit process, a PGE will need to be associated with the PR. The PGE
Selection pop-up contains a list of the PGEs available for selection and is accessed via the
‘PGE...” button on the PR Edit tab. The PGE Selection pop-up is shown in Figure 4.8.1-5.
The information describing each PGE is entered through GUIs used in the SSI&T process,
described in Section 4.5.1. To associate a PGE to a PR, the desired PGE is highlighted from the
list of PGEs, and then selected by clicking the OK button on the PGE Selection pop-up. A
particular PGE may be located by entering a search string in the field next to the ‘Find*“ button and
then clicking on the button. The resulting PGE list will match the search string in any of the
displayed fields: PGE Name, PGE Version, etc. Clicking on the Cancel button at the bottom of
the PGE Selection pop-up returns to the previous window.
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PGE Selection

PGE Selection

PGE Name PGE Version Profile Id Satellite Name Instrument Name

ACT AM1 ASTER
AM1Eph AM1 Al
AM1Eph AM1 Al
AM1Eph AM1 Al
AM1Eph AM1 Al
AM1Eph AM1 Al
AM1Eph AM1 Al
BTS AM1 ASTER
ETS AM1 ASTER
FddAtt AM1 Al
FddAtt AM1 Al
FddAtt AM1 Al
FddAtt AM1 Al
FddAtt AM1 Al

MIP1AA
MIP1AF
MIP1AN
MIP1EA
MIP1EBF
MIP1CA
MIP1CF
MIP1DA
MIP1DF
MIP2Z

MIP3
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MIP4AF
MIP4AN
MIP4EA
MIP4EBF
MIP4CA
MIP4CF
MIP4DA
MIP4DF
MIPS

AM1 MISR
AM1 MISR
AM1 MISR
AM1 MISR
AM1 MISR
AM1 MISR
AM1 MISR
AM1 MISR
AM1 MISR
AM1 MISR
AM1 MISR
AM1 g
AM1 MISR
AM1 MISR
AM1 MISR
AM1 MISR
AM1 MISR
AM1 MISR
AM1 MISR
AM1 MISR
AM1 MISR

1
1
2
1
2
3
4
1
1
1
2
1
P
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Fddatt 1 4 AM1 Al
q 1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1

| OK ~ Cancel '~ Help

Figure 4.8.1-5. PGE Selection Pop-up
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This screen has three function buttons:

OK Complete the action displayed (the selection)
Cancel Ignore the action displayed (the selection)
Help Display a Help pop-up with information about the function of this window.

The data displayed on this screen is described in Table 4.8.1-2.
2. PGE Parameters button

The parameters that may be associated with a PGE when it is run are normally specified for the
PGE when the PR is defined. If unspecified, the parameters default to values set during the
SSI&T process, as described in Section 4.5.1. The production planner may edit or review these
parameters by clicking the ‘PGE Parameters...” button on the PR Edit tab (Figure 4.8.1-3)
once a PGE has been selected. The PGE Parameter Mappings pop-up that is used to edit/view the
parameters are shown in Figure 4.8.1-6. The name of the PGE is shown in the text region at the
top of the window. The window lists each parameter on a line with its default value. A particular
PGE Parameter can be located by entering a search string in the field next to the ‘Find’ button and
then clicking on the button. The resulting list of PGE Parameters will match the search string in
any of the displayed fields: Parameter Name, Logical ID, etc. To override a value, select the
desired parameter line, enter the override value in the *‘Override Value’ text region at the bottom,
click Apply and then click OK.
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PGE ID: |CG_Combo#syn1#001

Parameter Name Logical Id Default va
nuin. parameters for output product 2000 2400 16
NUM_INPUT_LO 20002

NUM_INPUT_HDF 20003
NUM_INPUT_NON_HDF 20004
NUM_ALTERNATE_INPUTS 20005

NUM_OUTPUT_HDF 20006
NUM_OUTPUT_NON_HDF 20007

SPACECRAFT_NAME 20008 EOSAM1
tirst met. param. for output product 2000 200000 DayNightFl
second met. param. for output product 2000 200001 AutomaticQ
third met. param. for output product 2000 200002 AutomaticQ
tforth met. param. for output product 2000 200003 QAPercentM
fifth met. param. for output product 2000 200004 QAPercentC
sixth met. param. for output product 2000 200005 LocalGranu
seventh met. param. for output product 2000 200006 ParameterN
eighth met. param. for output product 2000 200007 GRingPoint
nineth met. param. for output product 2000 200008 GRingPoint
tenth met. param. for output product 2000 200009 GRingPoint
11th wet. param. for output product 2000 200010 ExclusionG
12th met. param. for output product 2000 200011 TimeofDay:
13th met. param. for output product 2000 200012 CalendarDa
14th wet. param. for output product 2000 200013 PGEYersion
15th met. param. for output product 2000 200014 QAPercentO
16th met. param. for output product 2000 200015 QAPercentI

£no)
override Value

oK aApply | Cancel | Help |

-

Figure 4.8.1-6. PGE Parameter Mappings Pop-up
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This screen has four function buttons:

« OK Complete the action displayed (the selection)

 Apply Update the database with the value entered

* Cancel Ignore the action displayed (the selection)

* Help Display a Help pop-up with information about the function of this window.

The data displayed on this screen is described in Table 4.8.1-2.
3. Metadata checks button

The Metadata checks button on the PR Edit tab invokes the MetaDataChecks pop-up window
shown in Figure 4.8.1-7. This function allows the operator to check a metadata value against a
specified input data granule metadata field value to determine if the data granule can be used or a
PGE performed to update the values. The production planner may edit or review these values in
the MetaDataChecks pop-up window. This window is invoked by clicking the ‘Metadata
Checks...” button on the PR Edit tab (Figure 4.8.1-3) once a PGE has been selected. The name
of the PGE is shown in the text region at the top of the window. The upper section of the window
lists each input data type for the PGE and the lower section displays metadata check values. A
particular input data type can be located by entering a search string in the field next to the ‘Find’
button in the upper section of the window and then clicking on the button. Selecting a particular
input data type displays any metadata field values associated with the selected input data type in the
lower section of the window. A particular metadata field can be located in the lower section of the
window by entering a search string in the field next to the 'Find' button in the lower section of the
window and then clicking on the button. To modify a value, select the desired metadata checks
line in the lower section of the window. The metadata field name will be displayed in the
'MetaDataField' text region and the current metadata value will be displayed in the 'Value' text
region at the bottom. Enter the modified value in the “Value’ text region, click Apply and then
click OK.
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Figure 4.8.1-7. MetaData Checks Pop-up
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This screen has four function buttons:

e OK Complete the action displayed (the selection)

e Apply Update the database with the value entered.

e Cancel Ignore the action displayed (the selection)

e Help Display a Help pop-up with information about the function of this window

Table 4.8.1-3 describes the fields displayed on the MetaDataChecks pop-up window.

Table 4.8.1-3. PR Edit-MetaData Checks Field Description

Field Name Data Type | Size Entry Description
PGE ID ASCII <17 system ID of the associated PGE

characters generated

Input Data Type|ASCII <20 |[system Identifiers for the data types that used as
characters generated input for the selected PGE.

MetaData Field [ASCII <40 |[system Name of the metadata field
characters generated

Operator ASCII <3 system The logical operator ( <,>,=, <=,=>) used
characters generated with the metadata field.

Value ASCII <80 |[system The value stored in the selected metadata
characters generated field.

Type ASCII <5 system Metadata field characteristic (Float, Int,
characters generated String).

4. Alternate Input Values button

The Alternate Input Values button on the PR Edit tab causes the AlternatelnputValues pop-up
shown in Figure 4.8.1-8 to appear. This function allows the operator to select a replacement for a
data input to a PGE with multiple inputs. This may be necessary if inputs to the PGE are not
available and alternative inputs can be used.
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PGE ID: ‘HIP1BA#2.1.101
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Order DataType LogicalID Tiner

DataType: ‘
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Figure 4.8.1-8. AlternatelnputValues Pop-up
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This screen has four function buttons:

e OK Complete the action displayed (the selection)

e Apply Update the database with the value entered.

e Cancel Ignore the action displayed (the selection)

e Help Display a Help pop-up with information about the function of this window

Table 4.8.1-4 describes the information displayed on the AlternatinputValues pop-up.

Table 4.8.1-4. PR Edit- AlternatelnputValues Field Description

Field Name Data Size Entry Description
Type
PGE ID ASCII <17 system |ID of the associated PGE
characters generate
d
Alternate List Name [ASCII <20 system [ldentity of the primary data type for this input.
characters generate
d
Order Integer <99 system  [Current order of this data type
generate
d/ User
changeab
le
Data Type ASCII <20 system [ldentity of the data type
characters generate
d
Logical ID Integer <8 system [The SDP Toolkit logical identifier used to
generate [reference the data type
d
Timer Long <12 system |The time period the Subscription Manager will
Integer generate |wait for an alternate input to arrive.
d/User
changeab
le

4.8.1.2.1DPR View and DPR List Tabs

The DPR List tab, shown in Figure 4.8.1-9, and the DPR View tab, shown in Figure 4.8.1-10
have a lot of commonality. The data displayed on the DPR List tab is a subset of that included
on DPR View tab. Also, the dropdown menus of both tabs have the same options.
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File Edit Help |

P1ann1ng\] PR Edit\} PR List\] DPR View\] DPR List\]
PR Name: | CG_Combo1.pr 9 PR Type: ALL =
Filter Data Processing Requests

DPRId PGEId PRName TileId DataStartTim
CG_Combo#s010000000PS CG_Combo#syni1#001 CG_Combol.pr 0O 0170151999 0

e}
rano) [

Status:

Figure 4.8.1-9. DPR List Tab
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DPRs are generated automatically from the PRs described above during Planning. The Production
Request Editor GUI provides capabilities to review these DPRs. By selecting the ‘DPR List’ tab,
a list of DPRs is displayed (in the order in which they have been entered into the PDPS database)
for review in the same manner in which PRs are selected and edited. In addition, on the menu bar,
the pulldown menus provide the following capabilities.

e ‘File’ Pulldown:

- Open - Allows the operator to select an existing DPR for review in the DPR View tab.
In the DPR View tab (but not in the DPR List tab), this function uses the File
Selection Popup (Figure 4.8.1-4).
- Exit - To exit the application.
e ‘Edit’ Pulldown:

— Delete - To delete a DPR.

Each line of the DPR List display represents a DPR, i.e., a job that will be run when all data and
resource needs are satisfied. A particular DPR may be searched for by entering in a search string
in the field next to the ‘Find’ button and then clicking on the button. The resulting DPR list will
match the search string in any of the displayed fields: DPR ID, PGE ID, etc. In addition, DPRs
may be filtered for associated PRs by selecting a PR using the Production Request selection tool at
the top of the window and clicking on the ‘Filter’ button. By selecting (clicking on) one of the
DPR summary lines, selecting 'Open’ from the 'File' pulldown, and selecting the ‘DPR View’
tab, that DPR is displayed in detail.
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Production Request Editor

Figure 4.8.1-10. DPR View Tab
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This screen has two function buttons:
e PGE Parameters See Figure 4.8.1-5
e PGE File Mappings See Figure 4.8.1-11

The DPR View tab fields are organized into three regions: Data Processing Request
Identification, PGE Information, and Request Data and Status. The individual fields of the DPR

View tab are described in Table 4.8.1-5.

Table 4.8.1-5. DPR View Field Description
Field Name Data Type| Size Entry Description
Data Processing - - - Information used to identify the DPR and
Request Identification the originator
DPR Name ASCII <24 system DPR name generated from the associated
characters generated |PGE
PR Name ASCII <27 system A name for the associated PR
characters generated
Origination Date Date 8 system Date of PR entry
generated
Originator ASCII <25 system User ID of the user entering the PR.
characters generated
PGE Information - - - Information describing the PGE
PGE ID ASCII <17 system ID of the associated PGE
characters generated
Data Start Time date & time |17 system Start date and time of the data to be
generated |processed by the job
Data Stop Time date & time |17 system Stop date and time of the data to be
generated |processed by the job
Request Data and - - - Information describing the running status
Status of the job
Predicted Start Time |[date & time |17 system Date and time at which the associated job
generated |is expected to be run, as predicted by the
planning subsystem
Actual Start Time date & time |17 system Date and time at which the associated job
generated |ran
Priority integer 3 system Priority of the job; 100<; =1
generated
Status ASCII <20 system Status of the job
characters generated

DPRs are generated automatically from PRs during the Planning process, using PGE information
defined during SSI&T. The PGE information can be viewed but not edited from this screen. This
is because the information is quite complex and its alteration can have considerable side effects on
the PGE execution.
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PGE parameters may be viewed for a particular DPR run. These parameters may be accessed by
selecting the ‘PGE Parameters...” button on the DPR View. This screen is similar to
Figure 4.8.1-6 shown earlier.

The input and output files for a particular DPR can be viewed by selecting the ‘PGE File
Mappings...” button. The associated GUI is shown in Figure 4.8.1-11. The PGE File
Mappings GUI displays one line of information for each file that may be used by or be produced
by the PGE. A particular input or output file can be searched for by entering in a search string in
the field next to the ‘Find’ button and then clicking on the button. The resulting file list will match
the search string in any of the displayed fields. Information displayed includes:

e Logical ID The ID or tag used within the PGE to access the file.
e Granule ID The ID or tag used to identify the file uniquely.
e Start/Stop Time The start or stop date and time for the data contained in this file.
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UR File Mappings

File Mappings

Input Data

LogicalId GranuleId StartTimne{UTC) 2
1200 AST_ANCH#OO01L 1000 010171901 00:00:01 01

1100 AST_L1BET#00107041997130123000 0770471997 13:01:23 07
1101 GDAS_O0ZF#00101000 010171901 00:00:01 01

| TTTTT——————__[i¥|
v [ ]

Ooutput Data

LogicalId GranuleId StartTimne{UTC) Stot
2000 AST_09TR#00107041997130123000 0770471997 13:01:23 0770

Figure 4.8.1-11. File Mappings Pop-up
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This screen has two function buttons:

e OK Dismiss the screen.
e Help Display a Help pop-up with information about the function of this window.

Table 4.8.1-6. File Mappings Field Description

Field Name Data Size Entry Description
Type

Logical ID Integer <8 system The SDP Toolkit logical identifier used to
generated |reference the data type

Granule ID ASCII <20 system Identity of the data type.

characters generated

Start Time Time 17 system Start date/time of instrument data
generated

Stop Time Time 17 system End date/time of instrument data
generated

4.8.1.3 Required Operating Environment

These GUIs may be hosted on the Planning Server and Queuing Server or Planning Workstation.
For information on the operating environment, tunable parameters and environment variables of
Production Strategies User Interface refer to the 910-TDA-022 “Custom Code Configuration

Parameters” documentation series. The following table identifies the supporting products this tool
depends upon in order to function properly.

Table 4.8.1-7. Support products for Production Request Editor

Product

Sun Solaris 2.5

MOTIF 1.2.3

PDPS Database

4.8.1.3.1Interfaces and Data Types

The Planning Subsystem has no interfaces external to ECS. It interfaces with the Data Processing
Subsystem through the Planning and Data Processing System (PDPS) database to exchange
planning information. The PDPS database is populated with information from the SSI&T
components after the integration of a new or updated PGE. An element of the Planning system
which does not require an operator interface, the Subscription Manager, also interfaces with the
ECS Science Data Server Subsystem.

The Planning Subsystem is primarily intended for use by the operations staff of the EOSDIS
DAACs. However, the capability has been requested and made available for science personnel
from the SCFs to enter Production Requests into the Planning subsystem using the same interface
as described above. This is to be done with the consent of the DAAC operations managers and via
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the X-11 interface with procedures and equipment provided to ensure a secure interface for these
updates.

4.8.1.4 Databases

The Planning Subsystem includes the PDPS database which contains information needed to plan
the processing at a DAAC. It is also used for resource planning, containing information on the
configured resources and their allocation. Finally, the database is used by the Data Processing
Subsystem, the other major element of the PDPS. The following subsections provide a summary
description of the PDPS database tables, and tools used with the database.

The SSI&T capability, which is a design component within the Data Processing Subsystem,
includes capabilities to support the integration and test of the science software, PGEs, within the
production processing environment. As a part of this activity, the SSI&T GUI, described in
Section 4.5.1 of this document, provides for the entry into the databases used by SSI&T of PGE-
related information needed to plan for and run science software. At the conclusion of the SSI&T
process, this database information is transferred to the operational databases from the databases
established for SSI&T.

The Production Request Editor allows changes to scheduling information for PRs and DPRs. The
complete database schema is listed in 311-CD-106-005, Planning and Data Processing Subsystem
Database Design and Schema Specifications.

4.8.1.5 Special Constraints
There are no special constraints that are associated with the Production Request Editor.

4.8.1.6 Outputs

Outputs of the Production Request Editor are provided in one of three ways:
1. Production Request Editor GUI responses as described above, including the File Mapping
GUL.
2. Updates to the PDPS database (described in Section 4.8.1.3).
4.8.1.7 Event and Error Messages

The Production Planning GUIs provide informational messages or warnings for minor errors
which the operator can immediately correct directly via the operator interface. Significant
production planning events or errors are logged to the ECS Planning Server ALOG file. The Error
messages are listed in Appendix A.

4.8.1.8 Reports
None.
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4.8.2 Production Planning Workbench

The second major element of production planning is the Production Planning Workbench (PWB).
Table 4.8.2-1 summarizes the operational functionality of this tool. Via the PWB GUI, the
operator selects a Production Request (PR) to be included in the plan. The planning tool provides
a forecast of the start and completion times of the jobs based upon historical experience in running
these PGEs. Using the planning tool, the operator can “activate” the plan, i.e., transfer the
information included in the plan to the Data Processing subsystem and load it into the AutoSys tool
where production processing is managed.

Table 4.8.2-1. Common ECS Operator Functions Performed with the
Production Planning Workbench

Operating Description When and Why to Use
Function
Create a Plan The operator can select available PRs | When a new or revised plan needs to
to be included in the plan be prepared
Activate a Plan The operator can activate a plan, which | When a new plan is prepared and
transfers the planned jobs into the accepted
Data Processing System
Save a The operator can create What-if When plans are in the process of being
Candidate Plan | scenarios created

4.8.2.1 Quick Start Using Production Planning Workbench
To execute Production Planning Workbench from the command line prompt, enter:

>EcPIAllStart <mode> <Application 1D>

where:

<mode> is the ECS mode under which the program is to run, e.g., OPS, TS1.

<Application ID> is an integer from 1 to 5 uniquely identifying the execution.

This action results in the display of the Production Planning Workbench main window and the

Planning Master Timeline GUI discussed in the following sections.

4.8.2.2 Production Planning Workbench Main Screen

When the Production Planning Workbench is started, the GUI window shown in Figure 4.8.2-1 is
one of the windows displayed. Table 4.8.2-1 contains a description of the fields in this GUI. The
GUI is started using information from the currently activated plan. Other plans may be opened or
new plans created and saved using the ‘New’, ‘Open’, ‘Save’, and ‘Save As’ options on the “File’
pull down on the menu bar, much like creating, opening, and saving a text document.

Comments to the plan may be made in the indicated region. Selected PRs can be moved from one
list to the other using the arrow buttons. A PR is scheduled by selecting from the pool of available
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‘Unscheduled’ PRs and, using the arrow buttons, the selected PRs are moved to the ‘Scheduled’
list. A note of clarification about Ground Events during scheduling: All Ground Events will be
automatically scheduled with any plan. Hence the GUI Ground Events will always be put into the
‘Scheduled’ list. Whenever a plan is activated, the Ground Events will also be activated. (If there
is an unscheduled Ground Event in the ‘Unscheduled’ list, this means that this Ground Event has
lost allocations.) The new plan can then be saved with a new name through the ‘Save As’ option
on the “File’ pull-down menu.
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Figure 4.8.2-1. Production Planning Workbench GUI

The following describes the pulldown menu options supported by the PWB GUI:
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File
New clears all the fields, and creates a new plan. The new plan name can not be longer
than 20 characters.
Open allows the user to select an existing Production Plan for review or editing. This
function invokes a File Selection Pop-up for specifying the file to be opened.
Save saves the current plan
Save As saves the displayed PR under a new PR name. This function uses the File
Selection Pop-up for specifying the new name of the PR.
Delete allows the user to delete a plan via a file selection pop-up. The active plan cannot
be deleted but other candidate plans can be removed.
Exit exits the application.
Options (no functionality has been associated with this menu, as yet).
Help — Provides assistance in using the PWB GUI.

The following push buttons are supported on the PWB GUI:

Baseline records the plan and the time of baselining. This baseline plan can be used as a point
of comparison with which to compare future plans and results.

Activate activates a plan and the Data Processing Requests (DPRs) associated with the
planned PRs are then transferred to the Data Processing subsystem and loaded into the
AutoSys production queuing system. Once the necessary data dependencies are satisfied,
the jobs are ‘Released’ to be run when processing resources are available. When the
Activate button is pressed on the planning workbench, the current active plan gets
"replanned over" by the selected plan. A pop-up listing any unprocessed DPRs that are in
the "old" active plan and not selected in the "new"plan is displayed and the user is asked to
confirm that these DPRs are to be cancelled.

Schedule schedules the selected PRs in the Unscheduled List.

Unschedule un-schedules the selected PRs in the Schedule List.

Prioritize allows for the modification of priorities associated with PRs. To change the
priority for a PR, select (highlight) the PR and press the Prioritize button. A Priority pop-
up is displayed. Enter a new priority in the text region for the selected PR and press OK.

Refresh not yet available.

Also a pulldown list is available on the PWB GUI:

Strategy: selects different strategies for scheduling, which determine the priorities assigned to
the individual PRs in a plan.

For all of these actions, the operator will be prompted for confirmation before proceeding. Table
4.8.2-2 summarizes the information fields on the PWB GUI.
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Table 4.8.2-2. Production Planning Workbench Field DescriptionA
Field Name Data Type| Size Entry Description
Plan Name ASCII <20 |System Name assigned to the plan; assigned initially
characters generated |when the ‘New’ plan is saved
Status ASCII <20 |System Status of the displayed plan: ‘Active’,
characters generated |‘Candidate’
Rollover Time ASCII 19 System The time at which the currently selected plan
characters generated |was activated.
Comment ASCII <256 |user input, |User comments
characters optional
Production ASCII <256 |System List of available PRs which are currently not
Requests: characters generated |scheduled
Unscheduled
Production ASCII <256 |user input |List of available PRs which are currently
Requests: characters scheduled
Scheduled Planner selects these from ‘Unscheduled’ list
and moves them to/ from ‘Scheduled’ with arrow
buttons

4.8.2.2.1Planning Master Timeline GUI

The Planning Master Timeline GUI main screen, shown in Figure 4.8.2-2 is brought up when the
Production Planning Workbench is started as explained in Section 4.8.2.1.

The Planning Master Timeline GUI represents a set of computers, arranged along the left
side of the GUI, and some period of time as indicated across the top edge of the GUI. The
execution of Data Processing Requests (DPR)s on a computer over a period of time is represented
by several DPR bars across the GUI for that computer. A bar represents a time period during
which a PGE (as described by a DPR) is running. Each bar has the name of the PGE. Scroll bars
allow scrolling up and down through the full list of computers and left and right in time. A select
list of time span viewing options (e.g., 24-hours, 48-hours) at the lower left of the screen is
available for selecting the time span of interest. If one exits from the Planning Master
Timeline GUI, it can be restarted as explained in Section 4.8.2.1.
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Figure 4.8.2-2. Planning Master Timeline GUIA

4.8.2-6 609-CD-600-001



The Planning Master Timeline Pulldown Menu Options are:
File
Open Plan: Opens a previously created plan through a file selection pop-up. It loads it in
the main region of the timeline and adds it to the plans menu buttons.
Load Configuration: loads a configuration for the timeline containing a list of resources
and color options. It does this through a file selection.
Save Configuration: saves a configuration file.
Exit: quits application.
Edit - Not yet supported.
Display - To select resources and attributes of the display: e.g. colors.
Time - To select Start and Stop times of the plan windows.
Plans - To elect plans to include

4.8.2.3 Required Operating Environment
These GUIs may be hosted on the Planning Server and Queuing Server or Planning Workstation.

For information on the operating environment, tunable parameters and environment variables of
Production Strategies User Interface refer to the 920-TDx-013 *“Custom Code Configuration
Parameters” documentation series. The “X” refers to the installed location, e.g. 920-TDG-013 is
for GSFC DAAC.

Table 4.8.2-3 identifies the supporting products this tool depends upon in order to function
properly.

Table 4.8.2-3. Support Products for Production Planning Workbench
Product
Sun Solaris 2.5.5
MOTIF 1.2.3
PDPS Database

4.8.2.3.1Interfaces and Data Types

The Production Planning Workbench has no interfaces external to ECS. It interfaces with the Data
Processing Subsystem through the Planning and Data Processing System (PDPS) database.

4.8.2.4 Databases

The Production Planning Workbench updates the information in the PDPS database for
subsequent use by the Data Processing software. It updates entries in DB tables such as
PlDataProcessingRequest, PIPlans, and PIGroundEvent.

The complete database schema is listed in 311-CD-106-005, Planning and Data Processing
Subsystem Database Design and Schema Specifications.

4.8.2.5 Special Constraints
There are no special constraints that are associated with the production planning tools.
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4.8.2.6 Outputs
Outputs of the Production Planning Workbench are provided in one of three ways:

Production Planning Workbench GUI responses as described above, including the Production
Plan Timeline display, Figure 4.8.2-2.

Updates to the PDPS database (see Section 4.8.2.4).

4.8.2.7 Event and Error Messages

The Production Planning Workbench provides informational messages or warnings for minor
errors which the operator can immediately correct directly on the operator interface. Significant
production planning events or errors are logged to the ECS Production Server ALOG file. Both
event and error messages are listed in Appendix A.

4.8.2.8 Reports
Report generation capability is not available.
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4.8.3 Production Strategies User Interface

The Production Strategies User Interface is used to tailor the priority of production requests (PRS).
Table 4.8.3-1 summarizes the operation functionality of this tool. The priority of production
requests impacts the development of processing plans. Production Strategy is a method of
developing a composite priority from several factors for a production request. These factors may
be assigned different proportions of the final priority. The factors themselves are composed of
attributes which may be given separate priorities. The factor attributes are then averaged to
produce the priority of the factors.

The Production Strategies User Interface provides an option to display the default values for the
factors and components.

Table 4.8.3-1. Common ECS Operator Functions Performed with
Production Planning GUIs

Operating GUI Description When and Why to Use
Function
Manage Production The operator can view, When the priority of a PR needs
Production Strategies User create, modify, or delete to change to adjust processing
Strategies Interface Production Strategies. scheduling.

4.8.3.1 Quick Start Using Production Strategies User Interface
To execute the Production Strategies User Interface from the command line prompt, enter:

>EcPIProdStratStart <mode>
<mode> is the ECS mode, e.g., OPS, TS1.

Refer to the 910-TDA-022 “Custom Code Configuration Parameters” documentation series, for a
listing of EcPIProdStratStart

4.8.3.2 Production Strategies User Interface Main Screen
The Production Strategies main screen is shown in Figure 4.8.3-1.
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Figure 4.8.3-1. Production Strategies Main Screen

The menu bar for the Production Strategies User Interface GUI contains pulldown menus
providing the following capabilities.

File Pulldown:
Open displays the Open Production Strategies pop-up window shown in Figure 4.8.3-2
with the production strategies currently in the PDPS database.
New clears all the display areas on the screen for input.
Save saves the displayed values to the database for the production strategy displayed.
Save As saves the displayed production strategy to the database as a different strategy.
Exit to exit the application.
Edit Pulldown:
Delete - To delete a production strategy.
Options Pulldown:
ActiveStrategy - Displays the Active Production Strategy screen shown in Figure
4.8.3-3).

Other options available on the Production Strategies screen:

Pr Type selects the PR Type panel as active.
User Type selects the User Type panel as active.
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PGE Type selects the PGE Type panel as active.

Normalize adjusts the weighting values to total 100.

Add the Type List/Priority pairs displayed on the screen to the selected type.
Modify the Type List/Priority pairs displayed on the screen in the selected type.
Delete the Type List/Priority pairs displayed on the screen from the selected type.

The parameters associated with the Production Strategies User Interface are used as attributes and
weights to generate the priorities for use by the overall Production Plan. All the parameters for the
Production Strategies User Interface tools are accessible through the operator GUIs. These
parameters are listed in Table 4.8.3-2. The parameters correspond to the sub-schema elements in
the PDPS database referenced in Section 4.8.3.4 below.

The Production Strategies User Interface creates a two-level scheme for prioritizing the Production
Plans. One level divides the plan into components: PR Type, User Type, PGE Type, and the
Production Request Editor. Each of these components (except Production Request Editor) is
further broken down into elements related to the Type. In the picture of the screen these elements
may be observed in the list boxes under the type labels. Each of the elements may be assigned a
priority.

The element priority assignment is initiated by selecting one of the type buttons. A type button
brings one of the type frames into focus and displays the type elements in the Type List in the
lower left corner of the screen. Element priorities are assigned or changed by selecting an element
in the Type List, choosing a priority in the scroll box above the Type List, and clicking the
appropriate button for Add, Modify, or Delete. The result will appear in the type frame list box
with the value (element) and priority displayed. The Production Strategies GUI will re-compute
the overall type priority based on the current element priorities of that type.

The second level of the priority scheme involves giving “weight” to the types. This “weight” is
similar in concept to percentage. Note: the sum of the four “weight” values must equal 100. Each
of the types may be given a weight. The fourth weight is the one assigned by the user in the
Production Request Editor. As the values are entered, the program will total the weights and
display an error dialog if the total is over 100.00. The program will not allow the entry of a weight
that causes the total to exceed 100.00. If the total is less than 100.00 the operator may use the
“Normalize” button to scale the weight values to base 100.00.

Table 4.8.3-2. Production Strategies Field Descriptions (1 of 2)

Field Name Data Size) Entry Description
Type
Production ASCII text--| 20 Default = Production Strategy Id
Strategies Default
PR Type - - - Strategy component name (Production
Request)
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Table 4.8.3-2.

Production Strategies Field Descriptions (2 of 2)A

Field Name Data Type| Size) Entry Description

Weight Floating Pt [<100. |Default= Weight for this component in final priority

number 50.00000 computation

Default Integer <10 Default =5 Priority for component.

Routine Integer <10 Default =5 (Sub) priority for Routine Requests

OnDemand |[Integer <10 Default =7 (Sub) priority for On-Demand Requests

Reprocessing [Integer <10 Default =3 (Sub) priority for Reprocessing Requests
User Type - - - Strategy component nhame (User Type — all

users)

Weight Floating Pt [<100. |Default= Weight for this component in final priority

number 00.00000 computation

Default Integer <10 Default =5 Priority for component.

DAAC Integer <10 Default=0 (Sub) priority for DAAC Manager Users
Manager

Operator Integer <10 Default = 0 (Sub) priority for Operator Users

Researcher [Integer <10 Default =0 (Sub) priority for Researcher Users

Scientist Integer <10 Default =0 (Sub) priority for Scientist Users
PGE Type - - - Strategy component name (Production

Generation Executive)

Weight Floating Pt [<100. |Default= Weight for this component in final priority

number 00.00000 computation

Default Integer <10 Default =5 Priority for component.

BTS#113#01 [Integer <10 Default =0 (Sub) priority for PGE BTS#113#01
Production - - - Strategy component name (User that made the
Request Editor PR)

Weight Floating Pt [<100. |Default= Weight for this component in final priority

number 50.00000 computation — the priority is part of the PR.

Total Weight |Floating Pt < 100. |No Default This field will be zero unless the user enters a

number weight in one of the 4 weight fields: PR Type
Weight, User Type Weight, PGE Type Weight,
or User Selected Weight. If that value then
becomes > 100.0, hit the “Normalize” button
to normalize.

Priority Integer <10 Default = 1 Raise or lower this value by clicking on either

the up or the down arrow beside that window.

Type List ASCll text |20 Default = For an active type (ex., click on the PR Type

blank button), the various valid types appear in this
window. Inactive types and their priorities can
be added using the “Add” button. Existing
active types can be modified using the
“Modify” button.

Late Start Integer <100 [Default=0 Priority for component.
Delta Priority
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4.8.3.2.10pen Production Strategy Pop-up

The Open Production Strategies GUI shown in Figure 4.8.3-2 displays Production Strategies
stored in the database. This pop-up is used to select the Production Strategy for display on the
Production Strategies Main Screen.

Production Strategies

Default

onDenandStrategy

~ File Selection L -
N Sanplel e

Ok | Cancel | ~ Help |_'

Figure 4.8.3-2. Open Production Strategies Pop-up

The production strategies available in the PDPS database are displayed in the Production
Strategies window. Selecting one of the displayed strategies will cause the selected strategy to
be displayed in the File Selection window. The Open action is completed by clicking the “OK”
button to accept the selection or the “Cancel” button to reject it.

4.8.3.2.2Active Production Strategy GUI

The Active Production Strategy screen, shown in Figure 4.8.3-3, displays the default values
from the PDPS database.
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Active ProductionStrategy

Figure 4.8.3-3. Active Production Strategy Screen

The fields displayed on the Active Production Strategy GUI are the same as those on the
Production Strategies User Interface, Table 4.8.3-2.

4.8.3.3 Required Operating Environment

These GUIs may be hosted on the Planning Server and Queuing Server or Planning Workstation.
For information on the operating environment, tunable parameters and environment variables of
Production Strategies User Interface, refer to the 910-TDA-022 “Custom Code Configuration

Parameters” documentation series. Table 4.8.3-3 identifies the supporting products this tool
depends upon in order to function properly.
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Table 4.8.3-3. Support products for Production Strategies User InterfaceA

Product

Sun Solaris 2.5

MOTIF 1.2.3

PDPS Database

4.8.3.3.1Interfaces and Data Types

The Planning Subsystem has no interfaces external to ECS. It interfaces with the Data Processing
Subsystem through the Planning and Data Processing System (PDPS) database to exchange
planning information. The PDPS database is populated with information via the SSI&T
components after the integration of a new or updated PGE. An element of the Planning system
which does not require an operator interface, the Subscription Manager interfaces with the ECS
Science Data Server Subsystem.

The Planning Subsystem is primarily intended for use by the operations staff of the EOSDIS
DAACs. However, the SCFs have the capability to enter Production Requests into the Planning
subsystem using the same interface as described above.

4.8.3.4 Databases

The Planning Subsystem includes the PDPS database which contains information needed to plan
the processing at a DAAC. Itis also used for resource planning, as it contains information on the
configured resources and their allocation. The database is also used by the Data Processing
Subsystem, the other major element of the PDPS. The following subsections provide a summary
description of the PDPS database table, and tools used with the database.

The SSI&T capability, which is a design component within the Data Processing Subsystem,
includes capabilities to support the integration and test of the science software (PGEs) within the
production processing environment. As a part of this activity, the SSI&T GUIs, described in
Section 4.5 of this document, provide for the entry into the databases used by SSI&T of PGE-
related information needed to plan for and run science software. At the conclusion of the SSI&T
process, this database information is transferred to the operational databases from the databases
established for SSI&T.

The complete database schema is listed in the 311 document for the release, Planning and Data
Processing Subsystem Database Design and Database Schema Specifications for the ECS Project.

4.8.3.5 Special Constraints

There are no special constraints that are associated with the Production Strategies User Interface
tools.

4.8.3.6 Outputs

Outputs of the Production Strategies User Interface are provided in the following ways:

1. Production Strategies User Interface responses as described above.
2. Updates to the PDPS database (described in Section 4.8.3.3).
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4.8.3.7 Event and Error Messages

The Production Strategies User Interface tool provides informational messages or warnings for
minor errors. Significant events or errors are logged to the ECS Production Strategies Server
ALOG file. The Error messages are listed in Appendix A.

4.8.3.8 Reports
The Production Strategies User Interface does not produce any reports.
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4.9 Production Processing

This section describes the Production Processing tools used by DAAC operators:
1. AutoSys/AutoXpert

2. QA Monitoring Tool
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4.9.1 AutoSys/AutoXpert

This section describes how the AutoSys and the AutoXpert packages are used by DAAC
operations for production processing. The combination of the two packages are referred to as
AutoSys/AutoXpert in the following description.

AutoSys is a job scheduling and management COTS product that provides mainframe batch
scheduling functionality in a distributed UNIX environment. AutoSys has three primary
components: AutoSys database, Event Processor, and Remote Agent. The AutoSys database is the
repository for all system events, and for all job, monitor, and report definitions. The Event
Processor is AutoSys’ scheduling engine. It continuously queries the AutoSys database for events
to be processed and performs necessary job, resource, and fault management actions. The Remote
Agent is a transient process that is initiated by the Event Processor to run a program on the client
machine. It sends messages directly to the Data Server to indicate changes in states for the job
(e.g., STARTING, SUCCESS, FAILURE).

AutoSys is embedded in the ECS PDPS software specifically to manage the execution of jobs on
science processing computers. Jobs that are necessary for the execution of DPRs are created and
organized into “job boxes” using a custom API named “Job Management” in the ECS PDPS
software.

Operator interaction is limited to “force starting” failed jobs from the Ops Console or from the
JobScape GUI and monitoring the progress of jobs from JobScape. Entire job boxes should be
canceled using the Planning Subsystem’s Production Request Editor. Jobs should not be deleted
using the AutoSys Job Definition GUI. This does not communicate with the PDPS database.

For uninterrupted processing, AutoSys supports automatic fault tolerance management via the
High Availability option. In this configuration, multiple Event Servers (Primary and Secondary)
and Event Processors (Primary and Shadow) can be setup for complete redundancy in case of
anomalous situations such as hardware, software, or network problems.

AutoXpert, a companion tool for AutoSys, is an advanced graphical facility for monitoring jobs in
AutoSys. Its components are HostScape, JobScape, and TimeScape. HostScape provides a view
of the resources, showing active states of machines, Event Server(s), Event Processors(s), and
jobs. JobScape presents a PERT-like view of job processing from a logical point of view.
TimeScape presents a Gantt-like view of job processing from a temporal point of view. All three
GUIs provide user configurable color codes via the X resources file for correlating unique colors
to job and resource states.

AutoSys and AutoXpert are used to perform the operating functions listed in Table 4.9.1-1.

4.9.1-1 609-CD-600-001



Table 4.9.1-1.

AutoSys/AutoXpert (1 of 3)

ECS Operator Functions Performed using

Operating Command/Script Description When and Why to
Function or GUI Use
Start the Event | eventor Starts the Event Processor To start the Event
Processor(s) (and optionally, the Shadow Processor(s).

Event Processor). Normally, this would be
done when the system
is booted*

Startup GUI /usr/ecs/<mode>/fUaunches AutoSys GUI To launch Ops
Console Panel | STOM/bin/DPS/EcDpControl Panel. Console, HostScape,
PrStartAutosys<mpde JobScape, and

><AutoSys Instan
1d>

cCe

TimeScape GUIs.

Access
database

xql

Invokes direct Sybase
database access utility to
issue SQL commands.*

Used for
troubleshooting
purposes.*

Check overall

chk _auto_up

Check the overall health of

To determine the

system the system including the overall health of the
environment, configuration system for
files, Event Server(s), and troubleshooting
Event Processor(s). purposes.
Control job JobScape The GUI provides a display of | To monitor jobs.
execution job’s progress.
Determine Ops Console View the list of successfully- | To view the
active and completed jobs by selecting | successfully
completed jobs the Jobs Completed completed jobs which
button. have been removed
from AutoSys.
Generate autorep Generates detailed or To report on the
report summary format report of jobs | history of job
processing.
Manage gatekeeper Manages product license To manage product
product license keys. license keys.*
keys
Manage autosecure Maintain Edit and Exec To manage system
security Superusers (Edit Superuser | security.*
can edit any job definition,
and Exec Superuser can
execute any job and stop the
Event Processor(s)).
Monitor and Alarm button from View alarms, acknowledge To monitor and

manage alarms

Ops Console,
HostScape,
JobScape, and
TimeScape GUIs

them, and change the status.

manage alarms.
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Table 4.9.1-1. ECS Operator Functions Performed using
AutoSys/AutoXpert (2 of 3)
Operating Command/Script Description When and Why to
Function or GUI Use
Monitor and Ops Console button | Compact “Control Center” for | To monitor and
manage jobs from GUI Control monitoring jobs and sending | manage jobs. See
Panel events to jobs: (Kill Job, Controlling Job
Force Start Job, On Hold, Off | Execution in this
Hold). Can also Launch Alarm | section.
Manager and view reports on
all events sent to a job.
Monitor job TimeScape button To see an overall view of To monitor current jobs
history from GUI Control processing for jobs running running.

Panel

in AutoSys. However, jobs
that have finished
successfully will have been
removed, and jobs not ready
to run will be waiting outside
of AutoSys. See: Determine
active and completed jobs.

Monitor jobs by

JobScape button

Viewing the progress of jobs

To monitor status of a

Job Box from GUI Control in the job box. An Event GUI | job.
Panel can be brought up by
selecting a job and clicking
the right mouse button.
Monitor HostScape button Monitor machines, Event To monitor resources
resources from GUI Control Server(s), Event and jobs. This GUI can
Panel Processor(s), and jobs. also be used to check
resource utilization to
see if the processing
load is being balanced
across machines.
Perform chase Verifies what AutoSys thinks | This command is run as
synchronizatio is running, is actually running. | part of the Event
n between Processor(s) startup,
database and and should not have to
active/inactive be run manually.*
jobs
Print AutoSys autoflags Prints AutoSys configuration | To retrieve necessary

configuration
information

information such as version
and release number,
database used, operating
system, hostname, and
hostid.

information to be
supplied to the vendor
for product license key
generation.*
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Table 4.9.1-1. ECS Operator Functions Performed using
AutoSys/AutoXpert (3 of 3)
Operating Command/Script Description When and Why to
Function or GUI Use
Remove archive_events Removes events and alarms | This command is run
events or job_runs information from | automatically during
the database. the daily DB
Maintenance cycle.*
Remove clean_files *Deletes old Remote Agent This command is run

Remote Agent
log files

log files from client machines
which have had jobs started
on them.

automatically during
the daily DB
Maintenance cycle,
and should not have to
be run manually.*

Retrieve status
of a job

autostatus

Retrieves the status of a job.

To monitor job status.*

Send event

sendevent from
command line

Send Event button
from Ops Console

Sends an event to manage
job execution, stop Event

Processor(s), and cancel a
scheduled event.

To stop the Event
Processor(s), since
everything else can be
done from the GUIs.*

Verify machine | autoping Verifies that both client and To verify a configured
server machines are machine for
configured properly, and the | troubleshooting
client is functioning properly. | purposes.

View job job_depends Generates a detailed report To view job

dependencies about the dependencies and | dependencies and

and conditions conditions of a job. conditions.*

View job Ops Console - Jobs | Used to view jobs in Verify that jobs have
gqueue Waiting Button CQ_RELEASED, CQ_HOLD | been queued or
and JIL_FAILUR (either the determine why a
job is already in AutoSys, or queued job was not
AutoSys environment released.
variables are invalid) states by
selecting the Jobs
Waiting button.
View Ops Console - Jobs | Used to view jobs that have Used to view list of jobs

successfully-
completed jobs

Completed Button

successfully completed and
have been removed by Job
Management from AutoSys.

that have finished but
are not in AutoSys.

View
processing log
files

autolog

Viewing the Event Processor
log file is an alternative to
monitoring all jobs and
events using the GUIs.

To monitor jobs,
events, and alarms for
troubleshooting
purposes.*

* Not generally

used in normal operations

4.9.1.1 Quick Start Using Autosys/AutoXpert

To invoke AutoSys/AutoXpert, type from the command line prompt:
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>$ECS_HOME/CUSTOM/utilities/EcDpPrAutosysStart <mode> <AutoSys
Instance 1d>

where:
<mode> is the ECS mode which this AutoSys instance is associated with and
<AutoSys Instance Id> is the instance name of this AutoSys

This script sets the appropriate AutoSys environment variables and issues the autosc command
to start the GUI Control Panel.

Refer to the 920-TDx-013 “Custom Code Configuration Parameters” documentation series , for a
listing of the EcDpPrAutosysStart script.

AutoSys provides various scripts and executables for defining objects, checking system status,
accessing the database, monitoring and reporting job status, defining custom calendars, recording
sounds, generating license keys, and controlling system security (see AutoSys User Manual,
Chapter 11 “Using AutoSys Commands”).

AutoXpert can not be invoked by a command line interface. Its functions are invoked by buttons
on the AutoSys Main Screen.
4.9.1.2 AutoSys Main Screen

The AutoSys GUI Control Panel provides buttons for launching (bringing up) Ops Console, Job
Definition, Calendars (not used), Monitor/Browser (not used), HostScape, JobScape, and
TimeScape GUIs. Figure 4.9.1-1 provides a snapshot of the Control Panel GUI.

Ops Console Job Definition Calendars

Figure 4.9.1-1. AutoSys GUI Control Panel

For more information about the AutoSys GUI Control Panel see the AutoSys Users Manual,
Chapter 5 Defining AutoSys Jobs using the GUL.

4.9.1.2.1 AutoSys Ops Console

The AutoSys Ops Console GUI provides an interface to monitor jobs and alarms in real-time. The
GUI provides a Job Selection Dialog for filtering jobs based on various parameters such as type,
name, state, and machine. Detailed information about the selected job including starting
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conditions, dependent jobs, and reports can be viewed. In addition, there are buttons for
launching Alarm Manager, Job Definition, and Send Event GUIs.

For more information about the AutoSys Ops Console please see the AutoSys Users Manual,
Chapter 9 The Operator Console.

4.9.1.2.1.1 ECS-Added Functions to the AutoSys Ops Console
ECS has added the following three buttons to the AutoSys Ops Console:

Jobs Completed - When this button is selected a display similar to the following appears on

the screen:
Jobs Completed

DPR 1D COMPLETION STATE PRIORITY TYPE
MODPGEO1#s02280100DEV04 SUCCESS 250 Routine
MODPGEOQ2#s28010500DEV04 SUCCESS 250 OnDemand
MODPGEOQ2#s28011000DEV04 FAILED 250 Reprocessing
MODPGEOQ2#s28011500DEV04 SUCCESS 250 Routine
MODPGEOQ2#s28012000DEV04 SUCCESS 250 Reprocessing

Jobs Completed: 5
Jobs Successful: 4
Jobs Failed: 1

These jobs have completed and have been removed from AutoSys so that the database is optimally
maintained to increase job throughput. Their completion state is indicated, as well as their Priority
and Type. Totals are listed at the bottom as to how many jobs have been completed successfully or
failed. Note that the Completion State, Priority and Type are highlighted and underlined: this
means that you can click these to get the list reordered by any of these fields.

Jobs Waiting - Select this button to display a list of jobs that have been scheduled, but which
are waiting for data. When all of the data is available for a job, jobs will be released from
this holding queue into AutoSys where they will immediately start to execute. The display
will look as follows:

Jobs Waiting
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DPR ID PGE 1D PRIORITY TYPE REASON
MODPGEO1#s02280100DEV0O4 MODPGEO1#synl1#001 250 Routine Data
MODPGEO2#s28010500DEV0O4 MODPGEO2#syn1#001 250 OnDemand Resources
MODPGEO2#s28011000DEV0O4 MODPGEO2#syn1#001 250 Reprocess Resources
MODPGEO2#s28011500DEV0O4 MODPGEO2#syn1#002 250 Routine Data
MODPGEO2#s28012000DEV0O4 MODPGEO2#syn1#001 250 Reprocess Resources

Jobs Waiting: 5

Routine Jobs Waiting: 2
Reprocessing Jobs Waiting: 2
On Demand Jobs Waiting: 1

This display shows all jobs waiting to be released into Autosys because they either do not have all
their data available (Reason = Data) or there are not enough resources available for them to run
(Reason = Resources). The DPR ID, PGE ID and Priority are all displayed, as well as the type of
job (On Demand, Routine or Reprocessing). Note that the PGE ID, Priority, Type and Reason are
highlighted and underlined: this means that you can click these to get the list reordered by any of
these fields.

Job Management Client Tool - The Job Management Client Program can be used to
manually override the normal PDPS operations of creating jobs from information in the
PDPS database and removing them after they have been successfully completed. Except
for creating and deleting ground event jobs (which must be invoked via this tool) and
updating the Max Jobs In Autosys for the various types of requests (On Demand, Routine
and Reprocessing), this capability is almost always used only during system testing. You
would only need to use this tool if a problem was identified and you were waiting for it to
be resolved through normal channels. You must first select a job box (not a job contained
within a job box) to identify a DPR to work with. The following menu is displayed after
selecting the IM Client button from the AutoSys Ops Console:

Current DPRId:MODPGEQ8#s28015500DEV04 Current Mode:DEV0Q4 ***

Exit

Create DPR Job

Release DPR Job

Cancel DPR Job

Change DPR 1d

View Job Management DPR Queue
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6) Create Ground Event Job

7) Cancel Ground Event Job

8) Change Max Concurrent Jobs for PGE Limits table
9) Change Max/Min DPRs for Job Class

a) Trigger release of un-released ready-to-run DPRs

enter an option:

Once into the program, you can change DPR IDs by selecting option 4). This DPR ID stays in
effect until another DPR ID is entered. Options 1) and 2), taken together, create and put a job into
AutoSys, or on the queue, if AutoSys is full (the job will be in a CQ_RELEASE state). Option 3
can be used to cleanly (as opposed to manually deleting the job from AutoSys) remove a job from
AutoSys.

Option 8 allows users to modify the DpPrPgeLimits database table. Option 9 allows users to
modify the DpPrClassSchedulingLimits database table. Option a should be used whenever options
8 or 9 are used. This causes Job Manaement Server to re-evaluate ready DPRs for possible entry
into AutoSys and execution.

4.9.1.2.2 AutoSys Job Definition

The AutoSys Job Definition GUI provides an interface to add new jobs, delete existing jobs, and
modify attributes for existing jobs. Both Date/Time Options and Adv Features Dialogs can be used
to set/modify all job attributes.

For more information about the AutoSys Job Definition please see the AutoSys Users Manual,
Chapter 5 Defining AutoSys Jobs using the GUL.

Note: This capability must never be used without first checking with someone who knows
something about the system internals. The ECS Job Management software handles the creating,
running and removing of successfully-completed jobs. Manually performing these functions
bypasses Job Management housekeeping and may cause the processing system to get out of sync,
possibly with severe consequences.

4.9.1.2.3 AutoSys Calendars

Not used by ECS.

4.9.1.2.4 AutoSys Monitor/Browser
Not used by ECS.

4.9.1.2.5 AutoSys Alarm Manager

The AutoSys Alarm Manager GUI provides an interface to monitor and manage alarms. Alarms
can be filtered based on type, state, and time; a response can be registered for an alarm; and the
state of the alarm can be changed. The Alarm Manager is invoked by clicking on the “Alarm”
buttons on either the JobScape or Operator’s Console GUIs.
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For more information about the AutoSys Alarm Manager please see the AutoSys Users Manual,
Chapter 9 The Operator Console.

4.9.1.2.6 AutoXpert HostScape

The AutoXpert HostScape GUI provides an interface to monitor the states of resources, Event
Server(s), Event Processor(s), and jobs. This GUI also provides buttons for launching Alarm and
Job Console GUIs. For more information about HostScape see AutoSys/Xpert User Guide for
UNIX Version 3.4, Product Overview.

4.9.1.2.7 AutoXpert JobScape

The AutoXpert JobScape GUI provides an interface to monitor states of jobs. This GUI presents
a Pert-like (network) view of job processing from a job dependency point of view. Alarm and Job
Console GUIs can be launched from this GUI. For more information about JobScape see
AutoSys/Xpert User Guide for UNIX Version 3.4, Product Overview.

4.9.1.2.8 AutoXpert TimeScape

The AutoXpert TimeScape GUI provides an interface to monitor states of jobs. This GUI
presents a Gantt-like (chart) view of job processing from a time-related point of view. This GUI
also provides buttons for launching Alarm and Job Console GUIs. For more information about
TimeScape see AutoSys/Xpert User Guide for UNIX Version 3.4, Product Overview.

4.9.1.3 Required Operating Environment

For all COTS packages, appropriate information on operating environments, tunable parameters,
environment variables, and a list of vendor documentation can be found in a CM controlled
document for each product. To find the documentation for AUTOSYS, refer to the ECS Baseline
Information System web page,

URL http://cmdm.east.hitc.com/.

No tuning or configuration of the product is required, beyond that required by a normal
installation.
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49.1.3.1

AutoSys exchanges data of various types through interfaces within ECS. Table 4.9.1-2 lists

Interfaces and Data Types

AutoSys system interfaces for Version 2.0.

Table 4.9.1-2. Interfaces Between AutoSys and other
ECS PDPS Components
Interface Type of Primary Type of Backup Comments
Interface Interface
Protocols Protocols
ECS PDPS | ECS PDPS Job None Interface between Planning and
Subscription | Management/API Data Processing subsystems for
Manager releasing Data Processing
Request jobs in AutoSys
ECS PDPS | ECS PDPS Job None Interface between Planning and
Planning Management/API Data Processing internal
Workbench software subsystems for adding,
deleting, and canceling Data
Processing Request and
Ground Event jobs in AutoSys

The information in the above table is informational only. It is not needed for normal operations.

4.9.1.4 Databases

All AutoSys information is stored in one of the three Sybase database types. The three types of
databases are: Event Server, Monitor Server, and Alarm Server. The Event Server contains all the
information about a particular instance of AutoSys such as job definitions, events, monitor and
browser definitions, calendar information, and machine definitions. Monitor and Alarm Servers,
not used within the ECS, are specialized databases for monitoring events and alarms.

See AutoSys User Manual, Chapter 13 “AutoSys Databases” for database schema definitions.

4.9.1.5 Special Constraints

None.

4.9.1.6 Outputs

AutoSys Event Processor(s), Event Server(s), and Remote Agent maintain log files. Table 4.9.1-3
lists AutoSys output log files.
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Table 4.9.1-3. Outputs

Output Description and Format
$AUTOUSER/out/event_demon.$AUTOSER | Event Processor log file
\Y;
$SYBASE/install/errorlog Event Server error log file
AutoRemoteDirlauto_rem.joid.run_num.ntry Remote Agent log file

4.9.1.7 Event and Error Messages

AutoSys issues both status and error messages to the Event Processor log file
(SAUTOUSER/out/event_demon.$AUTOSERV).

4.9.1.8 Reports

AutoSys autorep utility provides a method of generating reports containing information about
jobs, machines, and global variables currently defined in the database. Table 4.9.1-4 lists AutoSys
reports that can be generated. See the AutoSys User Manual for further information.

Table 4.9.1-4. Reports

Report Type Report Description When and Why Used

job The report provides information about jobs and | It should be used primarily
their processing status for generating production
Summary, detail, and query formats can be history reports, but also can
generated be used for real-time

monitoring of jobs

machine The report provides status of machines and It should be used for real-
attributes such as maximum load, current load, | time monitoring of machines
and factor
Summary, detail, and query formats can be
generated

4.9.1.8.1 Sample Report
Figure 4.9.1-2 shows an autorep job report obtained by using the command:

autorep - d -J % > report
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Job Name Last Start Last End Status Run
Pri/Xit
BTS#syn1#020704981301 12/11 17:19 12/11 21:08 SUCCESS 9837/1
Status/[Event] Time Ntry EventState ProcessTime Machine
RUNNING 12/11 17:19:01 1 Processed 12/11 17:19:19
SUCCESS 12/11 21:08:54 1 Processed 12/11 21:08:59
BTS#syn1#020704981301A 12/11 17:56 12/11 18:00 SUCCESS 9837/2
Status/[Event] Time Ntry EventState ProcessTime
Machine
STARTING 12/11 17:19:15 1 Processed 12/11 17:19:19 pdpsi
RUNNING 12/11 17:19:19 1 Processed 12/11 17:19:24 pdpsl
FAILURE 12/11 17:19:48 1 Processed 12/11 17:19:50
JOBFAILURE 12/11 17:19:50 1 Processed 12/11 17:19:56 pdpsi
[FORCE_STARTJOB] 12/11 17:56:19 O Processed 12/11 17:56:27
STARTING 12/11 17:56:24 2 Processed 12/11 17:56:27 pdpsl
RUNNING 12/11 17:56:28 2 Processed 12/11 17:56:32 pdpsl
SUCCESS 12/11 18:00:51 2 Processed 12/11 18:00:58
BTS#syn1#020704981301S 12/11 18:00 12/11 18:11 SUCCESS 9837/1
Status/[Event] Time Ntry EventState ProcessTime
Machine
STARTING 12/11 18:00:55 1 Processed 12/11 18:00:58 pdpsi
RUNNING 12/11 18:00:59 1 Processed 12/11 18:01:10 pdpsi
SUCCESS 12/11 18:11:25 1 Processed 12/11 18:11:32
BTS#syn1#020704981301P 12/11 19:02 12/11 19:02 SUCCESS 9837/2
Status/[Event] Time Ntry EventState ProcessTime
Machine
STARTING 12/11 18:11:29 1 Processed 12/11 18:11:33 pdpsl
RUNNING 12/11 18:11:33 1 Processed 12/11 18:11:38 pdpsl
SUCCESS 12/11 18:13:20 1 Processed 12/11 18:13:27
[FORCE_STARTJOB] 12/11 19:01:56 0 Processed 12/11 19:02:02
STARTING 12/11 19:02:02 2 Processed 12/11 19:02:07 pdpsl
RUNNING 12/11 19:02:04 2 Processed 12/11 19:02:07 pdpsl
SUCCESS 12/11 19:02:22 2 Processed 12/11 19:02:28
Figure 4.9.1-2. AutoSys autorep job report
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Figure 4.9.1-3 shows an autorep job report obtained by using the command:

autorep -d -m ALL >report

Machine Name Max Load Current Load Factor 0/S
chimera - - 1.00 Unix
deepsea -——= -——= 1.00 Unix
guiness -——= -——= 1.00 Unix
lasher - - 1.00 Unix
monet - - 1.00 Unix
nessie - - 1.00 Unix
pdpsl -——= -——= 1.00 Unix
stringl.pdpsl 1 0 -—— Unix
pdps2 -——= -——= 1.00 Unix
stringl.pdps2 2 0 -—— Unix
relbsgi -——= -——= 1.00 Unix
sdps2 -——= -——= 1.00 Unix
seagull -——= -——= 1.00 Unix
Current Jobs:

Job Name Machine Status Load
Priority

ETS#syn1#020704971301 RUNNING 1 250

Figure 4.9.1-3. AutoSys autorep job report - all
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4.9.2 ECS Quality Assurance (QA) Monitor

ECS QA Monitor processing capabilities enable DAAC operators to perform duties associated with
DAAC QA activities. The ECS Quality Assurance (QA) Monitor GUI is the user-interface for
entering data requests and displaying data, status, and error messages. The QA Monitor does not
produce data products, but communicates with the science data server to retrieve data that have
been previously archived.

The QA Monitor GUI is used to perform the operator functions listed in Table 4.9.2-1.

Table 4.9.2-1. Common ECS Operator Functions Performed with

QA Monitor
Operating Description When and Why to Use
Function
Query data Initiates a request to search When there is a need to know all archived data granules
granules the science archive for data with the same data type and inserted in the archive at a
granules within a datel certain time (date interval )
interval
Retrieve data | Initiates a request to get data | When data granule(s) needs to be transferred from
granules granules from the science archive to local disk for visualization
archive
Visualize data | Display Visualize screen When graphical images of data granules need to be
(HDF files) viewed to assess quality
Update Initiates a request to archive When QA information about data granules needs to be
metadata QA information about data updated in the archive based on DAAC QA activities
granules encompassing use of the Visualize Data function.

4.9.2.1 Quick Start Using QA Monitor

The QA Monitor is used to search for granules in the science archive, to retrieve granules and/or
processing history files from the science archive and to update metadata of granules retrieved from
the science archive. The QA Monitor GUI’s main screen has three windows: a window that
displays the ESDTSs of granules in the science archive, a data granule display window to select data
to browse, and a status window to indicate progress or display error messages. Several dialog
screens may be activated when functions are performed. Some windows are display-only for
informational text, while others require user-interaction.

4.9.2.1.1 Invoking QA Monitor Tool From the Command Line Interface

To execute QA Monitor from the command line prompt use the startup script provided during
installation and located in utilities subdirectory of the operational directory structure:

EcDpPrQaMonitorGUIStart <mode>

1 Data acquisition beginning and ending date.
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<mode> is the ECS Mode for the execution, e.g., OPS, TS1.

Refer to the 920-TDx-013 “Custom Code Configuration Parameters” documentation series , for a
listing of EcDpQaMonitorGUIStart.

4.9.2.2 QA Monitor Main Screen

The QA Monitor Tool Main Screen shown in Figure 4.9.2-1 provides access to all QA Monitor
primary functions. It consists of the QRU (Query/Retrieval/Update) data Tab and the Visualize
data Tab. The QRU data Tab is activated when the QA Monitor Main Screen is initialized. A group
of related objects is displayed by default to help the operator get started. The Data Types, Data
Granules, Date Granule Insert (acquisition date of granules) windows, and the Query pushbutton
are displayed, plus four desensitized (grayed-out) pushbuttons. These objects and the QRU data
object which controls display of this screen are needed to perform a query. Other available data
types are displayed in the Data Types window so the operator can choose which data type to query
on. This enforces the sequence of events: query, retrieve and update. The grayed-out pushbuttons
are sensitized after a Query, which permits selection of the indicated functions. The Visualize data
Tab displays a list of science granules available for browsing.

From this screen, the following functions can be performed:

* Request the Science Data Server to search for specific types of Data Granules
(Section 4.9.2.2.1)

* Request the Science Data Server to transfer Data Granules to the operator’s computer

* Request the Science Data Server to transfer Production History to the operator’s computer
e Update Data Granules’ Metadata (Section 4.9.2.2.2)

* View graphical images of Data Granules (Section 4.9.2.2.3)

e Print Display Lists of Data Granules and Data Types (Section 4.9.2.2.4)
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Figure 4.9.2-1. QA Monitor Tool Main Screen
The operator can select the following menu items from the QA Monitor Main Screen

e File This menu contains the following items:

Print allows the operator to print the Data Types list and the Data Granules list
(Section 4.9.2.2.4)

Exit allows the operator to exit the QA Monitor
Help The "Help" menu offers the following help choices: (Note: Presently not functional)
On Help displays help about using help

On Context displays help about individual screen elements. Context sensitive help
pops up a scrolled window that displays text about a specific user interface
component. There are two ways to get context-sensitive help:
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The first way to get context sensitive help is to move focus to an active user
interface component (e.g., text entry field, scroll list) and press the Help key.
Help will be displayed about that element. If the keyboard does not have a key
labeled Help, the F1 key usually functions as the help key.

The second way is to select "On Context” from the Help menu. The cursor will
change to a question mark. Clicking on any user interface component will
display help about that element.

On Window displays high-level help about the window (see "Tutorial™ below)

On Keys displays help about using the keyboard and general help about standard
user interface components that support complex behaviors. Topics include:

1. how to get context sensitive help

2. how to use keyboard mnemonics and accelerators to access
menu functions without using the mouse

3. how to navigate between active fields on windows using the
keyboard

Index is currently not supported.

Tutorial displays an extended discussion of the application and its role within the
ECS system.

On Version identifies what version of ECS software is currently being used.

On Mode identifies the operating mode of the ECS software currently being used.

Additionally, the following functions may be selected on the QRU data Tab:

Query: refer to Section 4.9.2.2.1

Set Granule Params: refer to Section 4.9.2.2.2
Retrieve Data Granule: refer to Section 4.9.2.2.1
Retrieve ProdHistory: refer to Section 4.9.2.2.1
Update Metadata: refer to Section 4.9.2.2.2

The following functions may be selected on the Visualize data Tab (refer to Section 4.9.2.2.2):

Visualize: refer to Section 4.9.2.2.3

Help: refer to Section 4.9.2.2.3

4.9.2.2.1 Query and Retrieve Data

The QA Monitor allows the operator to search the data archive for data granules by data type. The
available data types are displayed when the main screen comes up and allows the operator to
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choose which data type to query on. The operator may accept the default dates or enter new dates
to further constrain the search. Clicking on the Query pushbutton initiates the search request. If a
search is successful a list of data granules are displayed. Then the operator can have them
transferred from the data archive to his computer. Where the data will be located on the operator’s
computer is a configurable item. To request transfer of a data granule, highlight the row with
information about the granule desired by clicking on it then click on the Retrieve Data pushbutton.
A message will appear in the Status window indicating the processing status. To get the
production history file associated with the granule just click on the Retrieve ProdHist pushbutton.

For a description of the “Query and Retrieve Data” fields, see Table 4.9.2-2 below.

Table 4.9.2-2. QA Monitor Field Descriptions

Field Name Data Type Size Entry Description
Data Granule Insert | date 8 initial default The date interval window that data
Begin min 8 value(1/2/1901- granules are inserted into the data
End max 6/1/2036) can be |server
changed by
operator
Data Types list single N/A operator selects a | The list of all available data types at a
selection data type from the |specific DAAC
list displayed at
startup
Data Granules list  [multiple N/A operator clicks data |The list of all data granules in the date
selection granule row(s) then |interval above for a particular selected
clicks retrieve data type are available for retrieval
pushbutton
Status text N/A display status Display status messages
messages only

In addition, the following pushbuttons are provided:

Query populates the list of data granules on the bottom half of the screen for a particular
selected data type within a date interval.

Find (below the data types and data granules list) allows the operator to perform a
keyword search for information stored in those 2 lists.

Retrieve DataGranule allows the operator to retrieve data granule(s) from the DAAC’s
data archive to local disk.

Retrieve ProdHistory allows the operator to retrieve a production history tar file from
the DAAC’s data archive to local disk.

Update Metadata pops up a Granule Parameters screen (see Section 4.9.2.2.2 below).
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4.9.2.2.2 Update Metadata

Clicking on one data granule displayed in the Data Granules Field and then the Update Metadata
pushbutton brings up the Granule Parameters screen shown in Figure 4.9.2-2. The list of
parameter names are attributes describing the selected data granule. The settings for the parameters
are determined by the DAAC, SCF or PGE. Those settings are displayed along with explanations,
if any. After DAAC QA of a data granule the DAAC operator may update the operational QA flag
providing an explanation . To update a parameter, click the parameter name then click OK. The
Update Metadata screen will be displayed as shown in Figure 4.9.2-3.

= Granule Parameters

Parameter Operational Operational Flag SCF SCF Flag
Name 0A Flag Explanation 0A Flag Explanatio

GuruTej

Figure 4.9.2-2. Granule Parameters Dialog
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Figure 4.9.2-3.

Update Metadata Dialog

For a description of the “Update Metadata” dialog fields, see Table 4.9.2-3 below.

Table 4.9.2-3. Update Metadata Field Descriptions (1 of 2)
Field Name | Data Type| Size Entry Description
Operational character N/A operator DAAC and SCF quality status setting of a
Quality Flag, selects value |data granule parameter. The valid values
SCF Quality are:
Flag e passed
~ failed
 being investigated
< not being investigated
Operational character Less Operator inputs| Text describing quality status
Quality than 150 |text
Explanation, chars
SCF Quality
Explanation
Auto Quality |character N/A Operator input | Quality status of a data granule
Flag not allowed parameter set during data processing.
The valid values are:
e passed
~ failed
« being investigated
* not being investigated

4.9.2-7

609-CD-600-001



Table 4.9.2-3.

Update Metadata Field Descriptions (2 of 2)

Field Name | Data Type| Size Entry Description
Automatic character N/A Operator input | Quality status of a data granule
Quality not allowed parameter set during data processing.
Explanation

In addition, the following pushbuttons are provided:

e OK sends an update request to the data server to update data granule parameter values.

e Cancel will cancel the update request.

e Help displays the help for Update Metadata.

4.9.2.2.3

Visualize Data

Clicking on Visualize data from the QA Monitor GUI main screen brings up the Visualize Data
Tab shown in Figure 4.9.2-4. The operator clicks a row with the name of a science file to
browse. When the Visualize pushbutton is activated EOSView is invoked. The EOSView GUI
requires operator input to produce a graphical image of the science data file (see Section 4.12.7
“EOSView”). Note that the EOSView GUI can only read data products that are in HDF format.
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Figure 4.9.2-4.

Visualize Data Tab Stack

For a description of the “Visualize data” fields, see Table 4.9.2-4 below.

Table 4.9.2-4. Visualize Data Field Descriptions
Field Name Data Type| Size Entry Description

Filter character N/A uneditable |Indicates path and filenames to be
displayed as established in the
configuration file

Files character N/A click on a row|Highlights row information

Selection character N/A uneditable |Full pathname of the file selected for
viewing will be displayed

In addition, the following pushbuttons are provided:
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* Visualize invokes EOSView for visualizing data products.

e Help displays help for the file selection box.

4.9.2.2.4 Print Options

Clicking on “File” pull-down menu brings up the Print Options dialog shown in Figure 4.9.2-5.
This dialog allows the operator to select which list, data types list or data granules list, or both, to
be sent to the printer.

Print Options

~ Print both

# Print the Data Types List

~ Print the Data Granules List

x|

Cancel |

Figure 4.9.2-5.

Print Options Dialog

For a description of the “Print Options” fields, see Table 4.9.2-5 below.

Table 4.9.2-5. QA Monitor Tool Field Descriptions

Field Data Type| Size Entry Description

Name
Printdata [N/A N/A select 1 at a | This toggle button is selected if the operator wants
types list time the data types list to be sent to the printer.
Printdata |[N/A N/A select 1 at a | This toggle button is selected if the operator wants
granules list time the data granules list to be sent to the printer
Print both  [N/A N/A select 1 at a | This toggle button is selected if the operator wants

time both lists to be sent to the printer

In addition, the following pushbuttons are provided:

e OK sends a print request to the printer for option selected.

e Cancel will cancel the print request.
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4.9.2.3 Required Operating Environment

For information on the operating environment, tunable parameters and environment variables of
The QA Monitor Tool refer to the 920-TDx-013 “Custom Code Configuration Parameters”
documentation series . The “x” refers to the installed location, e.g. 920-TDG-013 is for GSFC
DAAC.

4.9.2.3.1 Interfaces and Data Types

The QA Monitor Tool does not have any external interfaces to ECS. However, there is an internal
interface to the Science Data Server to query and retrieve data granules, and update metadata.
There is also an internal interface to the Advertising server to get all data.

4.9.2.4 Databases

None

4.9.2.5 Special Constraints

None

4.9.2.6 Outputs

Other than the output displayed to the operator the QA Monitor is responsible for file (science data
files in the HDF format) transfers from the science archive to the local disk of the QA Monitor host
computer. It also sends data to the science archive to be stored.

4.9.2.7 Event and Error Messages

The QA Monitor issues status messages to the Status Messages text area at the bottom of the QA
Monitor GUI and error messages on pop-up error dialogs. Both event and error messages are
listed in Appendix A.

4.9.2.8 Reports

None
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4.10 Science Data Archive and Distribution
This section describes the Science Data Archive and Distribution tools used by DAAC operators.

The Data Server Subsystem (DSS) has the responsibility for storing earth science and related data
in a persistent fashion, providing search and retrieval access to this data, and supporting the
administration of the data, hardware devices, and software products. As part of its retrieval
function, the subsystem also provides for distribution of data electronically or on physical media.

The ECS Data Server Operator GUIs provide normal operational control and insight into science
data server, storage management, and data distribution subsystem operations. These views into
the system are managed by means of five operational tools described in the following sections:

4.10.1 Science Data Server GUI

4.10.2 Storage Management GUI
4.10.3 Data Distribution Requests GUI
4.10.4 Granule Deletion Administration.

4.10.5 Product Distribution System (PDS) Stand Alone (PDSSA) User Interface
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4.10.1 Science Data Server GUI

The Science Data Server GUI provides the operator two major functions, the management of Earth
Science Data Types and the management of all types of requests that the Science Data Server
operator is involved with. Further details on these two functions are given in Table 4.10.1-1.

Table 4.10.1-1. Common ECS Operator Functions Performed with the
Science Data Server GUI
Operating GUI Description When and Why to Use
Function
Manage Science Data | Data Types Tab | Allows operators to manage As needed, to manage
Server Earth Science the ESDTs offered by the data type descriptor
Data Types (ESDTS) Science Data Server information and add and
update ESDTs
Manage Data Server System Allows operators to manage all | As required, to manage
System Requests Requests Tab the requests within each data | requests in each data
server component server component

4.10.1.1 Quick Start Using the Science Data Server
To invoke the ECS Science Data Server GUI, enter the following:

EcDsSdSrvGuiStart <mode>
where:

<mode> is the ECS mode for the execution, e.g., OPS, TS2.

4.10.1.2 Science Data Server Main Screen

The ECS Science Data Server GUI, shown in Figure 4.10.1-1, has two tabs that provide access to
each one of the components’ screens.

e The Earth Science Data Type Manager is accessed through the Data Types tab
e The System Request Manager is accessed through the System Requests tab.
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Science Data Server - Data Types

Data Type Information

ID

SGI_DEVO4:
SGI_DEVO4:
SGI_DEVO4:
SGI_DEVO4:
SGI_DEVO4:
SGI_DEVO4:
SGI_DEVO4:
SGI_DEVO4:
SGI_DEVO4:
SGI_DEVO4:
SGI_DEVO4:
SGI_DEVO4:
SGI_DEVO4:
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AIRIZIFC.001
AIRIZRED. 001
AIRIZTMC. 001
AM1ANC. 001

AM1ATTF. 001
AM1ATTHO. 001
AM1ATTHF. 001
AM1ATTNO. 001
AM1ATTNF. 001
AM1EPHF. 001
AM1EPHHO. 001
AM1EPHHF . 001
AM1EPHNO . 001
AM1EPHNE. 001

AIRIZIFC
AIRIZRED
AIRIZTMC
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AM1ATTF
AM1ATTHO
AM1ATTHF
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AM1EPHNO
AM1EPHNE

Version

1
1
1
1
1
1
1
1
1
1
1
1
1
1

Description

View |

Add. . . |

Update..w

Refresh/
Reconnect

Operator Messages

Figure 4.10.1-1.

Data Types Tab
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The operator can select from the menu bar items at the top of the Science Data Server GUI window
for getting help and activating special functions. The menu bar capability is available on all Science
Data Server GUI screens. The following options are available through the toolbar:

Eile - which includes the following item:

Exit (Ctrl-Q) - Exit application (graceful exit).
Selected - which includes the following items:

Duplicate - Not implemented.

Select All - Not implemented.

Deselect All - Deselects any items that were previously selected.

Change Permissions - Not implemented
Options - This menu includes the System Settings item that opens the Server Polling
Options window shown in Figure 4.10.1-2. Polling of the data server can be switched
On/Off and the polling rate can be adjusted.
Help - which provides context sensitive help.

|7 sdSrv Polling On

Figure 4.10.1-2. Science Data Server - Server Polling Options

Table 4.10.1-2 describes the fields used on the Server Polling Options window.
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Table 4.10.1-2. Science Data Server - Server Polling Field Description

Field Name Data Size Entry Description

Type
SdSrv Polling|Button N/A Optional |Pressing this button on invokes automatic polling by
On the SDSRYV at the time interval specified in the SdSrv

Polling Rate: ssss secs field.

SdSrv Polling|integer 4 digits  [Optional |Specify the rate at which the Science Data Server GUI

Rate is updated with data coming from the Data Server. The
polling rate interval default is 120 seconds.

OK Button N/A Optional |Pressing this button submits the polling rate setup for
activation.

Cancel Button N/A Optional [Cancels the submission of a new polling rate setup.

4.10.1.2.1 Data Types Tab

The Data Types Tab is the default screen of the Science Data Server GUI shown in Figure 4.10.1-
1. This window provides operations personnel at the DAAC the capability to view descriptor
information, add new ESDTSs and update ESDTs. A list of currently installed ESDTs is shown
containing the ESDT ID, name, version number, and a brief description of the structure and
services available for the ESDT. Additional information that describes the structure, contents, and
services that each existing ESDT provides can be viewed by selecting the data type and clicking on
the View button.

Table 4.10.1-3 describes the Science Data Server - Data Types fields.

Table 4.10.1-3. Science Data Server - Data Types Field Description

Field Name Data Size Entry Description
Type

Data Type ID |character 8 System Uniquely identifies the specific type of ESDT.
generated

Name Character 25 System Name of ESDT.
generated

Version Integer 3 System Version number of ESDT, assigned starting at 1.
generated

Description |Character 255 |System Includes structure and services available for an ESDT.
generated

Find Character 255 |[Optional |This functionality is provided in order to help the user

browsing very long ESDT lists.

In addition, the following buttons are provided:

e The View button on the Data Types subtab displays ESDT descriptor information (read-
only) and it’s associated dynamic data link library (DLL) filename. Descriptor information
consists of groups, objects, and keywords that define an ESDTs metadata, advertised
services, subscribable events, data dictionary information, validation criteria, and science
parameters. Descriptor information is necessary for the Science Data Server to properly
configure itself to perform services related to an ESDT. A DLL is an executable library that
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is loaded dynamically when needed to fulfill ESDT services. The Science Data Server -
Descriptor Information Dialog (see Figure 4.10.1-3 below) provides the following buttons:

— Close exits the dialog.
- Help displays on-line help information.

L Descrptorinformation ||

Name: MODO3SYN
Version: 1
pLL:  1ibDsSESDTMoMODO3SYNSh.so

f Mok gk kR Rk Rk Rk Rk Rk Rk ok NPT Rk Rk ok kw ko

/* This ESDT descriptor file is based on
/* Model, and has been tailored for use
/* PGEs as modified for the August Deno.
/* should not be used for any other purp

...J' ETE S I B B R R R SR LR T T L L L L R L R SR R T T I I I R R L T T R I T TR L T

F* Based on the B.0 ESDT Descriptor
f E I 2 A B O O B O O O
GROUP METADATA

GROUP COLLECTIOMMETADATA

GROUPTYPE = MASTERGROUP

GROUP = CollectionDescriptionClass
OBJECT = ShortNane

Data Location = "MCF"

Figure 4.10.1-3. Science Data Server - Descriptor Information Dialog

e The Add... button on the Data Types tab shown in Figure 4.10.1-1 opens the Data Type
Dialog shown in Figure 4.10.1-4. This window is used to add a new ESDT to the
existing installed list of data types based upon input information. The SDSRV GUI has the
capability to install multiple ESDTs. Click on the File... button to display a list of
descriptor filenames to choose from instead of typing them in. Multiple descriptor files can
be selected. Click the OK button to add the data type. If no error messages appear, then
the operation has been successfully completed. Click the Cancel button to close the dialog
without performing an operation. Click the Clear button to start all over again the process
of filling in new information. Click the Help button to display on-line help information.
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Descriptor : . . |
Erilanae DSESDTASAST _L1ET.001 Eislanas

0K | Cancel | Clear | Help |

=

Figure 4.10.1-4. Science Data Server - Add Data Type Dialog

Table 4.10-4 describes the Science Data Server - Add Data Type fields.

Table 4.10.1-4. Science Data Server - Add Data Type Field Description

Field Name | Data Type Size Entry Description
Descriptor Character 25 required |Name of an ASCII file containing the ESDT descriptor
Filename string file.

e The Update... button on the Data Type tab in Figure 4.10.1-1 opens the Update ESDT
Dialog shown in Figure 4.10.1-5. This window is used to update an ESDT to the installed
list of data types based upon input information. The SDSRV GUI provides the capability
to update multiple ESDTs at one time. The Science Data Server needs to be running in
Maintenance mode to accept this operation. Click on the File... button to display a list of
descriptor filenames to choose from instead of typing them in. Multiple descriptor files can
be selected. Click the OK button to update the data type. If no error messages appear,
then the operation has been successfully completed. Click the Cancel button to close the
dialog without performing an operation. Click the Clear button to start all over again the
process of filling in new information. Click the Help button to display on-line help
information.

Descriptor File..
Filename:

(0] 4 | Cancel | Clear | Help |

Figure 4.10.1-5. Science Data Server - Update Data Type Dialog
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Table 4.10.1-5 describes the Science Data Server - Update Data Type fields.

Table 4.10.1-5. Science Data Server - Update Data Type Field

Description
Field Name | Data Type Size Entry Description
Descriptor character 255 [required |Name of an ASCII file containing the ESDT descriptor
Filename string file.

e The Refresh/Reconnect button on the Data Types subtab of Figure 4.10.1-1 updates the
data type information screen with current information.

e The Operator Messages field on the Data Types subtab of Figure 4.10.1-1 displays
informational and error messages.

4.10.1.2.2 System Requests Tab

Clicking the System Requests tab will bring up the System Management Requests window (see
Figure 4.10.1-6). This window provides operations personnel at the DAAC the capability to
monitor requests the Science Data Server is working with. All requests within the Science Data
Server are displayed. The columns of the list can be sorted by positioning the cursor and clicking
on the appropriate column of interest. Positioning the cursor and clicking on the Filter button and
entering the attributes on which to filter can filter the requests.
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File Selected Options

System Management Requests

System Management Requests

Request Requester Service Status Priority
1D Request

cind| [
Change Express _,l oo | Memory
Priority: s State

F11ter...| Refresh

Operator Messages

Figure 4.10.1-6. System Management Requests Window

Table 4.10.1-5 describes the System Management Requests Window fields.
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Table 4.10.1-6. System Management Requests Field Description

Field Name Data Type Size Entry Description

Request ID character 255 system Unique identifier for the request.
generated

Requester variable 100 system Identifies the user that submitted the

character generated request.

Service Request [character 25 system Types of requests handled are Insert,
generated Acquire, and Delete

Status character 20 system Possible states are Submitted,
generated Queued, Executing,

Failed_Retryable, Failed_Fatal,
Failed_Unknown and Done

Priority variable 20 system Priority of the data server system
character generated requests, i.e., Express, Very High,
High, Normal(default), Low.
Find character 255 optional If the list is too long, this field can be

used to search for an entry

In addition, the following buttons are provided:

Change Priority allows the operator to change the priority of each selected request
through a pulldown menu. Possible values are: Express, Very High, High, Normal
(default) and Low.

Apply allows the operator to commit to the priority change selected through the change
priority button.

Filter (see Figure 4.10.1-6) brings up the System Management Filter Requests dialog
which provides a selection of attributes on which to filter for the list of System-wide
requests. Filter on system management requests by entering the desired information, then
clicking on the Request ID or Requester radio button for the desired attribute. Return to the
original list of requests by clicking on the All Requests radio button. Click on other filters
associated with State and Priority by clicking on the toggle button. Filter on every attribute
associated with a category by clicking the All button or clear a category of filters by
clicking on the None button.

Memory State monitors the current memory state of the data server in regards to values
that are set on the server side through configuration parameters. Possible values are:
Normal (green), Low (yellow), Very Low (red) and Disabled (gray). The Memory State
will show a Disabled state when this functionality has been turned off by setting of the
DSSMEMORYMONITORDISABLEFLAG in the data server’s configuration file.
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System Management Filter Requests

-  Requester

A All Requests

State: Priority:
- Submitted -l Express INE
_I Queued L - Very High
I Active None _I High None
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d Failed i Low
0K Apply Cancel Help |

-

Figure 4.10.1-7. System Management Filter Requests Dialog

Table 4.10.1-7 describes the System Management Filter Requests Dialog fields.

Table 4.10.1-7. System Management Filter Requests Field Description

Field Name |Data Type| Size Entry Description
Request ID character 255 |system Unique identifier for the request.
generated
Requester variable 100 |system Identifies the user that submitted the
character generated |request.

In addition, the following buttons are provided:

e OK implements filter criteria, and the dialog closes.

* Apply implements filter criteria, and the dialog remains open for additional filtering.
e Cancel closes the dialog without saving

e Help displays on-line help information.

e Back to the System Requests tab description (figure 4.10.1-5), Operator Messages

provides informational and error messages to the DAAC Operator.
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* Refresh causes the Data Server to be polled for an update on Requests.

4.10.1.3 Required Operating Environment

For information on the operating environment, tunable parameters, and environment variables refer
to the 920-TDx-013 “Custom Code Configuration Parameters” documentation series . The “x”
refers to the installed location, e.g. 920-TDG-013 is for GSFC DAAC.

4.10.1.3.1 Interfaces and Data Types

Table 4.10.1-8 lists the supporting products that this tool depends upon in order to function
properly.

Table 4.10.1-8. Interface Protocols

Product Protocols Comments
Dependency Used
SDSRYV and all clients DCE via client libraries
SDSRYV GUIs X-11 via client libraries

4.10.1.4 Databases

The Science Data Server GUI does not include the direct managing of any database. It has an
interface with the Science Data Server Data Base: however this interface is based on a simple
parameter passing function. For further information of the Science Data Server Data Base refer to
311-CD-107-005, Science Data Server Database Design and Schema Specifications for the ECS
Project.

4.10.1.5 Special Constraints

The Science Data Server GUI runs only if the Science Data Server is running in the background.
Note also that at the moment the Science Data Server GUI is started through a command line that
specifies the configuration file that is used to initialize the GUI Application.

4.10.1.5.1 Deleting an ESDT
The Science Data Server GUI does not provide a means of deleting an ESDT. A script command
is provided for this purpose and is invoked as follows:

>EcDsSrRemesdt <mode> <descriptor file name> where:
<mode> is the operating mode affected (e.g., OPS, TS1)
<descriptor file name> is the name of the ESDT’s descriptor file

4.10.1.6 Outputs

There is no processing associated with the operation of this GUI. The information provided to the
operator are retrieved from the Data Server Database described in section 4.10.1.4 and displayed
through the screens discussed in section 4.10.1.2 and the related sub-sections.
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4.10.1.7 Event and Error Messages
Both event and error messages are listed in Appendix A.

4.10.1.8 Reports
This tool produces no reports.
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4.10.2 Storage Management Control GUI

This tool enables operations to manage various data storage functions. These functions include
the capability to set and modify configurations of various server types (e.g., 8mm tape, Archive
Server, D3 tape), manage data location within the archive and on disk, configure stacker slots,
display storage events which possibly require operator actions, and view backup failures with the
ability to restart a backup operation.

The tool is used to perform the operator functions listed in Table 4.10.2-1.

Table 4.10.2-1. Common ECS Operator Functions Performed with STMGT Control

Operating
Function

Command/Script or
GUI

Description

When and Why to Use

Configure Servers
and Devices

Storage Config Tab

Allows operators to
organize and configure
various Server and any
associated disk and
hardware resources.

As needed to add, delete, or
modify the configuration of a
Server or hardware
resource.

Configure Volume
Groups

Vol. Grp. Config.
Tab

Allows operators to
organize and configure the
data flow in and out of
various archives.

As needed to configure
archive repositories for
ESDTs.

Monitor Media

Resource Mgmt. Tab

Allows operator to monitor

As needed to make

statistics for a Read-Only
Cache or the Pull Area.
Operator can force
expiration and cleanup of
liens against cached files.

Resources and set resource availability | available or take off-line
for media distribution. specific resources.

View Cache Cache Stats. Tab Allows the operator to view Used when warning is

Statistics the contents and usage displayed in the message

area informing the operator
the cache is getting too full.

Search Event Log

Storage Events Tab

Allows operators to find
events from selected
parameters.

As needed to locate events.

Monitor Server
Operations

Request Status Tab

Allows operators to monitor
the progress of requests
throughout the STMGT CI.

As needed to monitor
processing, e.g. to detect
stalled requests or servers
which appear to be idle.
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4.10.2.1 Quick Start Using the Storage Management Control GUI

The Storage Management Control GUI provides the user with the ability to control the following
STMGT components:

1. Storage Configuration

2. Volume Group Configuration
3. Resource Management

4. Cache Monitoring

5. Storage Events

6. Server Monitoring

To invoke the Storage Management Control GUI, enter the following command line:
>EcDsStmgtGuiStart <mode>....
where:

<mode> corresponds to the system mode in which to operate, e.g., OPS, TS1. Note that the
Unix “DISPLAY” environment variable must be properly set in order for the GUI to display on
your screen.

4.10.2.2 The Storage Management Control Operator Main Screen

The Storage Management Control Main Screen, shown in Figure 4.10.2-1, consists of 6 tabs,
which provide user control of the components listed above. The operator can select from the
following toolbar menu items located at the top of the window for each component:

File contains the exit command to close application

Options allows the operator to set polling rates for various displays within the GUI.
Backup allows the operator to recover from failures to store backup copies of ingested data.
Help provides context sensitive help to the operator.

The STMGT Control Main Screen also contains an Operator Messages listbox to display error
conditions.

4.10.2.2.1 Storage Configuration Tab

The Storage Configuration Tab, shown in Figure 4.10.2-1, displays server identification
information, and allows the operator to view and control the server configuration including
adding, deleting and modifying server instances and their associated disk and hardware
resources.
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Figure 4.10.2-1. Storage Management Server Main Screen with the Default
Storage Configuration Tab Displayed
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This includes servers to both distribute data and archive data. Each specific server can be
configured by activating a separate window and inserting a set of parameters for that type of
server.

Selecting a Server Type will bring up a list of configured servers in the listbox below. Table
4.10.2-2 describes the fields shown on the Storage Configuration tab.

Table 4.10.2-2. Storage Management Server Field Description

Field Name Data Type Size Entry Description
Server Type character |20 preloaded Type of server to configure.
# of Servers integer N/A calculated Number of Server instances configured
for this Server Type.
Description character  [100 preloaded Brief description of Server Type.
# of Re-routes integer 3 required For media server types, the maximum

number of times a request may be re-
routed to an alternate instance of a
media server before the request is failed.

Times to re-route |character |3 required Number of times to re-route (see above).
The user can change the value by
modifying this field and pressing the
Apply to Server Type button.

Server Name integer 100 system generated |Name which uniquely identifies the
server instance within the mode.
Status character  [N/A system generated |Status of the server, either Up or Down.

The Storage Configuration Tab includes several buttons. These buttons are: Apply to Server
Type, Add Server, Modify Server and Delete Server. (Note: When a media server is selected,
the Modify Server button is automatically re-labeled as Modify Server/View Stackers or
Modify Server/View Devices.) The functionality associated with these buttons is discussed
below along with the pop-up windows that are displayed when the buttons are depressed.

Apply to Server Type updates the number of re-routes configured for that media type.

Add Server allows the operator to add a server instance of the selected Server Type to the
configuration. A screen will appear which allows the operator to configure the parameters and
resources for the new server instance. Different Server Types have different screens to address
the particular configuration of that Server Type.

Modify Server allows the operator to change the parameter settings or resources associated with
the selected server. For media servers, this includes stacker and device resources. The screen
that appears is identical to the screen used for Add Server for the same Server Type. These
screens are discussed in the following sections.

Delete Server allows the operator to remove configuration of a selected server instance. This
will remove all stored configuration information associated with parameters and configured
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resources for the deleted server. Operators are not permitted to delete servers that are running;
the executing server instance must be brought down before it may be deleted.

All server configuration windows provide OK and Cancel buttons. Pressing the OK button
saves the server configuration information to the database and closes the server configuration
window. Cancel closes the server configuration window without saving the configuration
information to the database.

All server configuration windows also provide a Service Threads field with an associated
Allocate by Priority button. The Service Threads field specifies the number of worker threads
which will be allocated within the server instance to process requests. By clicking on the
Allocate by Priority button, these threads may be allocated by priority in order to reserve certain
resources for higher priority requests. Note that lower-priority threads may be used to service
higher priority requests, but never vice versa. Figure 4.10.2-2 illustrates the window that is
presented when clicking on any Allocate by Priority button. All fields refer to the number of
threads that are allocated to service requests of the indicated priority (or higher). By default, all
service threads are created as low priority service threads, since these may be pre-empted by any
priority request. So that the total of the numbers in each of the 5 different thread type fields
equals the number in the Total field, the number of low threads is automatically re-calculated
whenever the number of any of the other thread types is changed.

Allocate Threads by Priority

XPress:
V-High:
High:
Normal:
Low:

Total:

0K | Cancel

Figure 4.10.2-2. Service Thread Configuration Window
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4.10.2.2.1.1 Request Manager Server Configuration

Figure 4.10.2-3 displays the server configuration window for configuring instances of the
Request Manager Server.

—| Request Manager Configuration

Berver Mape! ohsSiieguesiManageriorver BPL Tag:

File 170 Block ®ize {bhvias):

Bt g

Al
[ -
Al
I, -

Slesntine {ueconds):

%wa%%?%%%%:lﬂ? At jocate
by Priority

{3 £ anne i

Figure 4.10.2-3. Request Manager Configuration Window

Table 4.10.2-3 describes the fields shown on the Request Manager Configuration pop-up.
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Table 4.10.2-3. Request Manager Configuration Field Description

Field Name Data Type Size Entry Description

Server Name character |6 required Name of this instance of the Request
Manager Server. The only nhames which
are recognized by the STMGT client
interface are PRI and SEC.

RPC Tag character |4 required The four-character tag which will appear
in RPC Ids submitted by the Request
Manager Server. Recommended values
are RQMA and RQMB.

File 1/0 Block Size |integer 16 required The block size to be used for file 1/0.

Retries integer 3 required The number of times to retry failed
operations.

Sleeptime integer 5 required The time to sleep, in seconds, between

(seconds) retries.

Service Threads |integer 5 required The number of Service Threads

available to process requests submitted
to the Request Manager Server. Note:
This neither refers nor correlates to DCE
Listen Threads.

4.10.2.2.1.2 Staging Disk Server Configuration

Figure 4.10.2-4 displays the server configuration window for configuring instances of the
Staging Disk Server.
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Figure 4.10.2-4. Staging Disk Server Configuration Window

Table 4.10.2-4 describes the fields shown on the Staging Disk Server Configuration pop-up.

Table 4.10.2-4. Staging Disk Server Configuration Field Description (1 of 2)

Field Name Data Type Size Entry Description
Server Name character |6 Required Name of this instance of the Staging
Disk Server.
RPC Tag character |4 Required The four-character tag which will appear

in RPC Ids submitted by the Staging
Disk Server. Recommended values are
STDA, STDB, etc.

Allocation Block  [integer 16 Required Block size in bytes to be used for

Size (bytes) allocation purposes. Clients which must
accommodate links to other files will
allocate one block per link to be created.
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Table 4.10.2-4. Staging Disk Server Configuration Field Description (2 of 2)

Field Name Data Type Size Entry Description

Total Staging integer 16 Required Total space available on disk for

Space (blocks) allocation. The unit is allocation blocks.

Available Staging [integer 16 System generated [Space remaining which is available for

Space (blocks) allocation. The unit is allocation blocks.
This is calculated based on the Total
Staging Space and the current set of
allocated staging disks as stored in the
database.

Root Path character  |250 Required Path on disk where staging disks will be
created. Each staging disk will be
named disknnn wherennn is a unique
number..

File 1/0 Block Size [integer 16 Required The block size to be used for file 1/0.

(bytes)

Retries integer 3 Required The number of times to retry failed
operations.

Sleeptime integer 5 Required The time to sleep, in seconds, between

(seconds) retries.

Service Threads |integer 5 Required The number of Service Threads

available to process requests submitted
to the Request Manager Server. Note:
This neither refers nor correlates to DCE
Listen Threads.

4.10.2.2.1.3 Cache Manager Configuration

Cache Manager Server instances may be configured to manage Read-Only Caches or to manage
the Pull Area. The type of cache being managed is controlled by the Pull Area Manager toggle.
If Pull Area Manager is toggled to No, the configured instance is defined to manage a Read-
Only Cache. Otherwise, the configuration defines the cache information to be used by the Pull
Monitor Server. Figure 4.10.2-5 displays the server configuration window for configuring
instances of the Cache Manager Server. Note that the last three fields are greyed out. These
fields are enabled only when configuring the Pull Area.

4.10.2-9

609-CD-600-001



Server Name: .acheManagerServer L0

Space (blocks): | Disk Capacity
Available Cache Fault
Space (blocks): |50000 Level:

Allocation Block | -
Size (bytes): Leue1? 85000000

195 . 000000

Description: BN ELEE:

Expiration g e 170 Block
Threshold PPLRDITTY ile ock [FYRVETY
(hours): ® Size (bytes): |kt

Retries:

et [

Confirm Delete:

Sleeptine {seconds):

. _|10 Allocate
Service Threads: by Priority

Pull Area Manager No —

(e A I usr/fecs/OPS/CUSTOM acn/f2acgo1/d

toar Reauest Directiory:

ETE Motifioation File

0K | Cancel |

Figure 4.10.2-5. Cache Manager Server Configuration Window

Table 4.10.2-5 describes the fields shown on the Cache Manager Server Configuration pop-up.
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Table 4.10.2-5. Cache Manager Server Configuration Field Description (1 of 3)

Field Name

Data Type

Size

Entry

Description

Server Name

character

Required

Name of this instance of the Cache
Manager Server. Recommended value
for the Cache Manager instance which
manages the Pull Area is PULL.

RPC Tag

character

Required

The four-character tag which will appear
in RPC Ids submitted by the Cache
Manager Server. Recommended values
are ROCA, ROCB, etc. for Cache
Manager instances which manage Read-
Only Caches and PULL for the Cache
Manager instance which manages the
Pull Area.

Original Cache
Space (blocks)

integer

16

Required

Total size of the cache on disk. The unit
is allocation blocks.

Available Cache
Space (blocks)

integer

16

System generated

Free space remaining in the cache. The
unit is allocation blocks. This is
calculated based on the Original Cache
Space less the combined size of the files
currently cached as stored in the
database.

Allocation Block
Size (bytes)

integer

16

Required

Block size in bytes to be used for cache
allocation purposes.

Description

character

100

Optional

A mnemonic description of the cache for
use by the operator.

Disk Capacity —
Fault Level

real

16

Required

The level at which a message will be
sent to the operator via the STMGT GUI
to indicate that the cache is critically full.
Unless Expired Files Confirm Delete is
set to Yes, this should be set to 99.5%,
since the Cache Manager will
automatically clean up files as needed to
make space.

Disk Capacity —
Warning Level

real

16

Required

The level at which a message will be
sent to the operator via the STMGT GUI
to indicate that the cache is becoming
full. Unless Expired Files Confirm Delete
is set to Yes, this should be set to
99.5%, since the Cache Manager will
automatically clean up files as needed to
make space.
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Table 4.10.2-5. Cache Manager Server Configuration Field Description (2 of 3 )

Field Name

Data Type

Size

Entry

Description

Expiration
Threshold (hours)

real

16

Required

The number of hours a lien will be held
against a cached file. A lien may be
either an expressed intent to copy or link
the file from the cache or a physical link
to the file from another area, e.g. a
staging disk. If the lien expires and
space is required in the cache, the lien
will be removed automatically unless the
Expired Files Confirm Delete flag is set
to Yes. For normal operations, this field
should be set to at least 24 hours.

Expired Files
Confirm Delete

boolean

N/A

Required

If set to No, the Cache Manager will
automatically make space for new files in
the cache by removing files whose liens
have expired. If this flag is set to Yes,
the operator must confirm the removal of
expired liens before the liens may be
deleted. (See the Cache Statistics tab
later in this section for information on
deleting expired liens.)

File 1/0 Block Size
(bytes)

integer

16

Required

The block size to be used for file 1/O.

Retries

integer

16

Required

The number of times to retry failed
operations.

Sleeptime
(seconds)

integer

16

Required

The time to sleep, in seconds, between
retries.

Service Threads

integer

16

Required

The number of Service Threads
available to process requests submitted
to the Staging Disk Server. Note: This
neither refers nor correlates to DCE
Listen Threads.

Pull Area Manager

boolean

N/A

Required

Indicates whether this instance of the
Cache Manager will be managing a
Read-Only Cache (ROC) or the Pull
Area. Only one instance of the Cache
Manager should be configured as a Pull
Area Manager, though multiple instances
may be configured to manage ROCs.

Cache Path

character

250

Required

Path on disk where the cache physically
resides.
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Table 4.10.2-5. Cache Manager Server Configuration Field Description (3 of 3)

Field Name

Data Type

Size

Entry

Description

User Request
Directory

character

250

Required if Pull
Area Manager is
Yes

If this instance has been flagged as a
Pull Area Manager, the User Request
Directory identifies the path on disk
where user directories will be created.
These directories are the visible paths
which are used for staging FTP Pull
distributions. The path specified here
must match the login path specified in
the configuration for anonymous FTP, if
anonymous FTP will be used for client
acquisition of FTP Pull orders.

FTP Notification
File

character

250

Required if Pull
Area Manager is
Yes

A fully-qualified path and filename where
a list of acquired files will be placed to
permit the Cache Manager to
automatically clean up files which have
been successfully pulled. This field is
only used by the Pull Area Manager.

FTP Notification
Freq (Sec)

integer

16

Required if Pull
Area Manager is
Yes

The frequency with which the Pull Area
Manager will review the list of acquired
files and perform the corresponding
clean-up.

4.10.2.2.1.4 FTP Server Configuration
Figure 4.10.2-6 displays the server configuration window for configuring instances of the FTP

Server.
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Figure 4.10.2-6. FTP Server Configuration Window

Table 4.10.2-6 describes the fields shown on the FTP Server Configuration pop-up.

Table 4.10.2-6. FTP Server Configuration Field Description (1 of 2)

Field Name Data Type Size Entry Description

Server Id character |6 Required Name of this instance of the FTP Server.
The ID of the FTP server for external
FTP distributions should be configured
as NONE.

RPC Tag character |4 Required The four-character tag which will appear
in RPC Ids submitted by the FTP Server.
Recommended values are FTPA, FTPB,
etc..

Max Request Size [integer 16 Required The maximum aggregate size of files

(blocks) which may be electronically transferred
as a single request. The size is specified
in terms of file /O blocks.

File 1/0 Block Size [integer 16 Required The block size to be used for file 1/0.

(blocks)
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Table 4.10.2-6. FTP Server Configuration Field Description (2 of 2)

Field Name Data Type Size Entry Description

Data List character |100 Required The name of the file which will be used
by DDIST to specify the list of files to be
electronically distributed. This must
match the corresponding parameter in
the DDIST configuration.

Retries integer 16 Required The number of times to retry failed
operations.

Sleeptime integer 16 Required The time to sleep, in seconds, between

(seconds) retries.

Service Threads |integer 16 Required The number of Service Threads

available to process requests submitted
to the FTP Server. Note: This neither
refers nor correlates to DCE Listen
Threads.

4.10.2.2.1.5 8MM and DLT Server Configuration

Figure 4.10.2-7 shows the configuration screen for media servers that support stackers. This
screen is used to configure instances of the 8MM Server and the DLT Server. Table 4.10.2-7
describes the field information related to this pop-up.

4.10.2-15

609-CD-600-001



Server Name: EchStSMMServerl RPC Tag: -

Media Server Block Size {(bytes):

Capacity {(blocks):
Default Block Factor:

File I/0 Block Size (bytes): JiRREELE
Retries:
Sleeptine {(seconds):
Nunmber of Columns:
Number of Rows:

Print Queue: [=1AL
Allow Distribution Across Network: NG —Jl

Staging Threads: n b{j‘i.fg?_;é?f;;y

Stacker
Operations

Save New
] | Cancel |

Figure 4.10.2-7. Media Server Configuration Window (Stacker-based)
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Table 4.10.2-7. Media Server Configuration Field Description (Stacker-based)

(1 0f2)

Field Name Data Type Size Entry Description

Server Name character |6 Required Name of this instance of the Media
Server.

RPC Tag character |4 Required The four-character tag which will appear
in RPC Ids submitted by the Media
Server. Recommended values for SMM
servers are ATEA, ATEB, etc., and for
the DLT server are DLTA, DLTB, etc.

Media Server integer 16 Required The block size to be used for tape /0.

Block Size (bytes) This block size is also the basis unit for
specifying media capacity.

Capacity (blocks) |integer 16 Required The maximum aggregate size of files
which may be transferred on a single
piece of media. The size is specified in
terms of Media Server Block Size.

Default Block integer 16 Required The number of blocks which will be

Factor read/written at once when performing
I/O.

File I/O Block Size |integer 16 Required The block size to be used for file 1/O.

(bytes)

Retries integer 16 Required The number of times to retry failed
operations.

Sleeptime integer 16 Required The time to sleep, in seconds, between

(seconds) retries.

Number of integer 16 Required The column width to which packing slips

Columns should be formatted.

Number of Rows [integer 16 Required The page length to which packing slips
should be formatted.

Print Queue character |64 Required The Unix named print queue to which
packing slips should be sent for requests
serviced by this Media Server instance.

Allow Distribution [boolean N/A Required Indicates whether or not this Media

Across Network Server instance will permit media
distribution from a staging disk which is
NFS-mounted in the event that the data
cannot be locally staged.
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Table 4.10.2-7. Media Server Configuration Field Description (Stacker-based)
(20f2)

Field Name Data Type Size Entry Description

Staging Threads |integer 16 Required The number of Service Threads
available to locally stage data for media
distribution by this Media Server
instance. Note: This neither refers nor
correlates to DCE Listen Threads. It
also does not correspond to the number
of devices available for media
distribution. A separate thread pool is
automatically created for actual media
I/O, based on the number of media
devices configured for use by this Media
Server instance.

Stacker ID character |64 Required A unique identifier that identifies a
stacker associated with this Media
Server instance.

Description character  [100 Optional Additional mnemonic information
provided by the operator during
configuration to assist in identifying the
listed stacker.

The Media Server Configuration window includes two buttons not found on other server
configuration windows: Allow Distribution Across Network and Save New Server.

Allow Distribution Across Network Toggles whether or not the server instance will permit
distribution to media from an NFS-mounted directory. Some media types (e.g. CD-ROM)
required a sustained I/O level which cannot be guaranteed when 1/0O is being done across a
network. For such media types, this flag should be toggled to No.

Save New Server This button forces the displayed configuration information to be added to the
database without closing the server configuration window. It must be pressed prior to adding
new stackers.

The Media Server Configuration window also includes a pull-down menu — Stacker Operations
— with the following options:

Add Stacker... Allows the operator to add and configure a new stacker resource. A list of
pre-configured stacker models is shown when this menu option is selected. The operator
may select from the list of pre-configured stacker models, or select the Unknown option.
In either case, the window shown below in Figure 4.10.2-8 is presented. If a pre-
configured model is selected, the fields in the Stacker Configuration window will be pre-
populated with the appropriate values for the selected model.

Modify Stacker/View Drives If a stacker is selected, this option will permit the operator to
modify the configuration of the selected stacker resource. This also brings up the
window shown in Figure 4.10.2-8.

4.10.2-18 609-CD-600-001



Delete Stacker If a stacker is selected, this option permits the operator to remove the
selected stacker as a configured resource for this server instance. Note that removing a
stacker automatically removes all configured devices associated with that stacker.

Whether adding or modifying configuration for a stacker resource, the window shown below in
Figure 4.10.2-8 is presented. (Note: When adding a stacker, the Save Modified Stacker button is
re-labeled Save New Stacker).
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Figure 4.10.2-8. Stacker Configuration Window
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Table 4.10.2-8 provides a detailed description of the Stacker Configuration window fields.

Table 4.10.2-8. Stacker Configuration Field Description

Field Name Data Type Size Entry Description
Server Name character |64 Required The name of the Media Server instance
which manages this stacker.
Stacker ID character |64 Required A unique identifier which identifies this
particular stacker.
Stacker Model character |64 Optional The model of stacker, if known.
Description character |100 Optional A mnemonic description of the stacker

used by the operator to clarify which
stacker is intended.

Stacker Path character |250 Required The Unix fully-qualified path to the
device path for the stacker robotic arm.

Element Number |integer 16 Required The element number of the stacker.

Stacker Number integer 16 Required The stacker number for this Media
Server instance (e.g. 1, 2, 3).

Number of Slots integer 16 Required The number of usable slots provided by

the stacker. Do not count the cleaning
tape slot in this count — it is automatically
accounted for.

Note that by pushing down the Barcode Enabled button, the server will have the capability to
initiate an automated resynchronization with the database.

The Stacker Configuration window also includes a pull-down menu — Drive Operations — with
the following options:

Add Drive... Allows the operator to add and configure a new drive which is located inside
this stacker. A list of pre-configured drive models is shown when this menu option is
selected. The operator may select from the list of pre-configured drive models, or select
the Unknown option. In either case, the window shown below in Figure 4.10.2-9 is
presented. If a pre-configured model is selected, the fields in the Device Configuration
window will be pre-populated with the appropriate values for the selected model.

Modify Drive If a drive is selected, this option will permit the operator to modify the
configuration of the selected device. This also brings up the window shown in Figure
4.10.2-9.

Delete Drive If a drive is selected, this option permits the operator to remove the selected
device as a configured resource for this stacker.

Whether adding or modifying configuration for a device, the window shown below in
Figure 4.10.2-9 is presented.
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Figure 4.10.2-9. Stacker Device Configuration Window

Table 4.10.2-9 provides a detailed description of the Stacker Device Configuration window
fields.

Table 4.10.2-9. Stacker Device Configuration Field Description (1 of 2)

Field Name Data Type Size Entry Description
Server Name character |64 Required The name of the Media Server instance
which manages this device.
Stacker ID character |64 Required A unique identifier which identifies the
stacker in which this device resides.
Drive Number integer 16 Required The ordinal index of the device within the
stacker (e.g., 1, 2).
Model character |64 Optional The model of device, if known.
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Table 4.10.2-9. Stacker Device Configuration Field Description (2 of 2)

Field Name Data Type Size Entry Description
Capacity (Blocks) |integer 16 System- Tape capacity, as expressed in Media
generated Server blocks. This cannot be changed

in 6A, and is presented as a courtesy to
the operator.

Element Number [integer 16 Required The element number of the device.

Description character  [100 Optional A mnemonic description of the device
used by the operator to clarify which
device is meant (e.g., Topmost).

Pathname character |250 Required The Unix fully-qualified path to the

device path for the drive.

4.10.2.2.1.6 D3 and CD-ROM Server Configuration

Figure 4.10.2-10 shows the configuration screen for media servers which support standalone
devices. This screen is used to configure instances of the D3 Server and the CD-ROM Server.

Table 4.10.2-10 describes the field information related to this pop-up.
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Figure 4.10.2-10. Media Server Configuration Window (Standalone-based)
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The Media Server Configuration window includes two buttons not found on other server
configuration windows: Allow Distribution Across Network and Save New Server.

Allow Distribution Across Network Toggles whether or not the server instance will permit
distribution to media from an NFS-mounted directory. Some media types (e.g. CD-ROM)
required a sustained I/O level which cannot be guaranteed when 1/0O is being done across a
network. For such media types, this flag should be toggled to No.

Save New Server This button forces the displayed configuration information to be added to the
database without closing the server configuration window. It must be pressed prior to adding
new devices.

Table 4.10.2-10. Media Server Configuration Field Description (Standalone-based)

(1 0f2)
Field Name Data Type Size Entry Description

Server Name character |6 Required Name of this instance of the Media
Server.

RPC Tag character |4 Required The four-character tag that will appear in
RPC Ids submitted by the Media Server.
Recommended values for D3 servers are
DEEA, DEEB, etc., and for the CDROM
server are CDRA, CDRB, etc.

Media Server integer 16 Required The block size to be used for media I/O.

Block Size (bytes) This block size is also the basis unit for
specifying media capacity.

Capacity (blocks) |integer 16 Required The maximum aggregate size of files
which may be transferred on a single
piece of media. The size is specified in
terms of Media Server Block Size.

Default Block integer 16 Required The number of blocks which will be

Factor read/written at once when performing
I/O.

File 1/0 Block Size [integer 16 Required The block size to be used for file 1/0.

(bytes)

Retries integer 16 Required The number of times to retry failed
operations.

Sleeptime integer 16 Required The time to sleep, in seconds, between

(seconds) retries.

Number of integer 16 Required The column width to which packing slips

Columns should be formatted.

Number of Rows [integer 16 Required The page length to which packing slips
should be formatted.

Print Queue character |64 Required The Unix named print queue to which
packing slips should be sent for requests
serviced by this Media Server instance.
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Table 4.10.2-10. Media Server Configuration Field Description (Standalone-based)

(2 of 2)

Field Name Data Type Size Entry Description
Allow Distribution [boolean N/A Required Indicates whether or not this Media
Across Network Server instance will permit media

distribution from a staging disk which is
NFS-mounted in the event that the data
cannot be locally staged. The CDROM
server is not reliable for distribution from
NFS-mounted disks, as I/O to the CD-
ROM device must be sustained.

Staging Threads |integer 16 Required The number of Service Threads
available to locally stage data for media
distribution by this Media Server
instance. Note: This neither refers nor
correlates to DCE Listen Threads. It
also does not correspond to the number
of devices available for media
distribution. A separate thread pool is
automatically created for actual media
I/O, based on the number of media
devices configured for use by this Media
Server instance.

Drive Name character |64 Required A unique identifier which identifies a
drive associated with this Media Server
instance.

Description character  [100 Optional Additional mnemonic information

provided by the operator during
configuration to assist in identifying the
listed drive.

The Media Server Configuration window also includes a pull-down menu — Drive Operations —
with the following options:

Add Drive... Allows the operator to add and configure a new drive to be managed by this
media server instance. A list of pre-configured drive models is shown when this menu
option is selected. The operator may select from the list of pre-configured drive models,
or select the Unknown option. In either case, the window shown below in Figure 4.10.2-
11 is presented. If a pre-configured model is selected, the fields in the Device
Configuration window will be pre-populated with the appropriate values for the selected
model.

Modify Drive If a drive is selected, this option will permit the operator to modify the
configuration of the selected device. This also brings up the window shown in Figure
4.10.2-11.

Delete Drive If a drive is selected, this option permits the operator to remove the selected
device as a configured resource for this server instance.

Whether adding or modifying configuration for a device, the window shown below in
Figure 4.10.2-11 is presented.
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Figure 4.10.2-11. Standalone Device Configuration Window

Table 4.10.2-11 provides a detailed description of the Standalone Device Configuration window
fields.
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Table 4.10.2-11. Standalone Device Configuration Field Description

Field Name Data Type Size Entry Description

Server Name character |64 Required The name of the Media Server instance which
manages this device.

Drive Number integer 16 Required The ordinal index of the device for the Media
Server instance (e.g., 1, 2).

Model character |64 Optional The model of device, if known.

Capacity (Blocks) integer 16 System- Media capacity, as expressed in Media

generated Server blocks. This cannot be changed in

6A, and is presented as a courtesy to the
operator.

Element Number integer 16 Required The element number of the device.

Description character  [100 Optional A mnemonic description of the device used by
the operator to clarify which device is meant
(e.g., Left side of table).

Pathname character  |250 Required The Unix fully-qualified path to the device
path for the drive.

4.10.2.2.1.7 Archive Server Configuration

Figure 4.10.2-12 shows the configuration screen for configuring instances of the Archive Server.
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Figure 4.10.2-12. Archive Server Configuration Window
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Table 4.10.2-12 describes the fields shown on the Archive Server Configuration pop-up.

Table 4.10.2-12. Archive Server Configuration Field Description (1 0of2)
Field Name Data Type Size Entry Description

Server Name character |6 required Name of this instance of the Archive
Server.

RPC Tag character |4 required The four-character tag which will appear
in RPC Ids submitted by the Archive
Server. Recommended values are
ARCA, ARCB, etc.

File I/O Block Size [integer 16 required The block size to be used for file 1/O.

(bytes)

Retries integer 3 required The number of times to retry failed
operations.

Sleeptime integer 5 required The time to sleep, in seconds, between

(seconds) retries.

Enable boolean N/A required If set to Yes, the Archive Server will

Checksumming on compute a CRC-32 checksum for each

Store file stored in the archive.

Enable boolean N/A required If set to Yes, the Archive Server will

Checksumming on direct the Cache Manager to compute a

Retrieve CRC-32 checksum for each file retrieved
from the archive and validate it against
the checksum previously computed.

Service Threads integer 5 required The number of Service Threads
available to process requests which do
not directly involve AMASS devices.
High-level Store and Retrieve requests
will be split into subordinate StoreFile
and RetrieveFile requests which will be
serviced by read and write threads
respectively. Note: This configuration
value neither refers nor correlates to
DCE Listen Threads.

Read Threads integer 5 required The number of Service Threads

available to process requests which will
be sent to a Cache Manager to read
from an AMASS device. Note: This
configuration value neither refers nor
correlates to DCE Listen Threads.
Rather, it should reflect the number of
devices available in the AMASS silo for
reading, adjusted to allow for caching of
files.
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Table 4.10.2-12. Archive Server Configuration Field Description (2 of 2)

Field Name

Data Type

Size

Entry

Description

Write Threads

integer

required

The number of Service Threads
available to process requests which write
to an AMASS device. Note: This
configuration value neither refers nor
correlates to DCE Listen Threads.
Rather, it should reflect the number of
devices available in the AMASS silo for
writing, adjusted to allow for caching of

files.

4.10.2.2.2 Volume Group Configuration Tab

This tab, shown if Figure 4.10.2-13, displays information about the volume groups configured to
store archive data. It also allows the operator to create new volume groups, browse the history of
volume group configuration, and redirect volume groups from one physical location to another.
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Figure 4.10.2-13. Volume Group Configuration Tab

Table 4.10.2-13 provides a detailed description of the Volume Group Configuration Tab fields.

4.10.2-31 609-CD-600-001



Table 4.10.2-13. Volume Group Information Field Description

Field Name Data Type Size Entry Description

Data Type Name [character (16 required An ESDT shortname with version
identifier.

Current Hardware |character |16 Required The Hardware CI of the Archive Server

Cl instance that is currently responsible for
storing data of the specified data type.

Current Volume character |255 required The fully-qualified Unix path to where

Group Path data will be stored for the specified data
type.

UNIX character |3 required The extent to which a file of the specified

Compression data type is expected to be compressed

Factor using the Unix compress algorithm. For
example, if the Unix compression factor
were 80%, a 10MB file would have an
expected compressed size of 2MB using
the Unix compress algorithm.

GZIP character |3 required The extent to which a file of the specified

Compression data type is expected to be compressed

Factor using the GNU gzip compress algorithm.
For example, if the GNU gzip
compression factor were 80%, a 10MB
file would have an expected compressed
size of 2MB using the GNU gzip
compress algorithm.

Find Next character  [N/A optional Allows the operator to perform a keyword

search for items in the Volume Group
Information box.

The following buttons provide the operator with several configuration operations with regard to
the Volume Groups:

Add... Allows the operator to add a Volume Group.

Modify Allows the operator to modify the configuration of one or more VVolume Groups.
Also used to version a set of ESDTSs.

Display History Allows the operator to review the set of physical file storage locations
which have been associated with a Volume Group over time.

Display Statistics Allows the operator to review historical compression statistics which may
be used to guide the selection of a configured compression factor.

Reset Allows the operator to un-select the selections in the Volume Group Information

box.

Each of the windows associated with the above buttons is described in the following sections.

4.10.2.2.2.1 Add Volume Group

Figure 4.10.2-14 displays the window that is used to manually add VVolume Group configuration
information. This window is presented when the Add...button is pressed.
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Figure 4.10.2-14. Add Volume Group Pop-up

The fields are described in Table 4.10.2-14.
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Table 4.10.2-14. Add Volume Group Field Description

Field Name Data Type Size Entry Description

Data Type. character |16 required An ESDT shortname with version

Version identifier.

Hardware CI character |16 required The Hardware CI of the Archive Server
instance that will be responsible for
storing data of the specified data type.

Volume Group character  |unlimited |[required The fully-qualified Unix path to where

Path data will be stored for the specified data
type.

Unix Compression |integer 3 required The extent to which a file of the specified

Factor (%) data type is expected to be compressed
using the Unix compress algorithm. For
example, if the Unix compression factor
were 80%, a 10MB file would have an
expected compressed size of 2MB using
the Unix compress algorithm.

GZIP integer 3 required The extent to which a file of the specified

Compression data type is expected to be compressed

Factor (%) using the GNU gzip compress algorithm.
For example, if the GNU gzip
compression factor were 80%, a 10MB
file would have an expected compressed
size of 2MB using the GNU gzip
compress algorithm.

Volume Group radio button |N/A required Indicates whether this is the primary

Type

volume group from which data will be
retrieved, a backup volume group for
recovery from primary volume group
failures, or an offsite volume group
where media is expected to be exported
and stored offsite.

4.10.2.2.2.2 Modify Volume Group

Figure 4.10.2-15 displays the window which may be used to modify Volume Group
configuration information. This window is presented when the Modify button is pressed.
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Figure 4.10.2-15. Modify Volume Group Pop-up
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Table 4.10.2-15 provides a detailed description of the Modify Volume Group Pop-up window
fields. Note that multiple Volume Groups may be selected for simultaneous modification.
Those fields for which new values are specified will be updated; fields which are left blank will
retain their existing values for each affected VVolume Group.

This also provides a simple mechanism for versioning ESDTs as a group. By specifying a new
ESDT Version, new entries may be created for Volume Groups for each of the selected Volume
Groups, updating the ESDT version of the original Volume Group with the new ESDT version.
All other configuration information for the new version Volume Groups will be retained, unless
explicitly altered by placing an entry in one or more of the other fields on the window.

Pressing the Compression Factor Statistics button will bring up the Compression Statistics
window for each of the selected VVolume Groups. This permits the operator to review historical
statistics regarding compression rates for each selected Volume Group. See section 4.10.2.2.2.4
for more information regarding the Compression Statistics window.

Table 4.10.2-15. Modify Volume Group Field Description (1 of 2)

Field Name Data Type Size Entry Description

Data Type Name [character (16 required An ESDT shortname with version
identifier.

Current Hardware |character |16 required The Hardware CI of the Archive Server

Cl instance that is currently responsible for
storing data of the specified data type.

Current Volume character  |unlimited |[required The fully-qualified Unix path to where

Group Path data is currently being stored for the
specified data type.

Unix Compression |character |3 required The extent to which a file of the specified

Factor data type is currently expected to be

compressed using the Unix compress
algorithm. For example, if the Unix
compression factor were 80%, a 10MB
file would have an expected compressed
size of 2MB using the Unix compress

algorithm.
GZIP character |3 required The extent to which a file of the specified
Compression data type is currently expected to be
Factor compressed using the GNU gzip

compress algorithm. For example, if the
GNU gzip compression factor were 80%,
a 10MB file would have an expected
compressed size of 2MB using the GNU
gzip compress algorithm.
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Table 4.10.2-15. Modify Volume Group Field Description (2 of 2)

Field Name Data Type Size Entry Description

New ESDT character |3 optional The new version identifier to be applied

Version to all displayed ESDTs. If specified, the
set of selected volume groups will be re-
added as new volume groups for the
new version identifier.

New Hardware character |16 optional The Hardware CI of the Archive Server

Cl instance that should be made
responsible for the volume group. If this
is not specified by the operator, the
currently configured value will be
retained.

New Path character |255 optional This entry identifies the new path in
which data will be stored. If this is not
specified by the operator, the currently
configured value will be retained.

New Unix integer 3 optional The new expected compression rate for

Compression files compressed using the Unix

Factor (%) compress method. If this is not specified
by the operator, the currently configured
value will be retained.

New GZIP integer 3 optional The new expected compression rate for

Compression
Factor (%)

files compressed using the GNU gzip
compress method. If this is not specified
by the operator, the currently configured
value will be retained.

4.10.2.2.2.3 Volume Group History

Figure 4.10.2-16 displays the window that may be used to view historical Volume Group
configuration information.
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Figure 4.10.2-16. Volume Group History Pop-up

Table 4.10.2-16 provides a detailed description of the Volume Group History Pop-up window
fields.
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Table 4.10.2-16. Volume Group History Field Description

Field Name Data Type Size

Entry

Description

Volume Group character |16
(ESDT Data Type.

Version)

required

An ESDT shortname with version
identifier.

Hardware ClI character 16

History

required

In reverse chronological order, the
Hardware CI of the Archive Server
instances that have been responsible for
storing data of the specified data type.
The current instance is listed first.

Path History character  |unlimited

required

In reverse chronological order, the fully-
qualified Unix paths to where data has
been stored for the specified data type.
The current path is listed first.

Start Date date 16

required

The date on which this configuration
became active for the listed data type.

End Date date 16

required

The date on which this configuration was
superseded by new configuration
information. If blank, this row reflects the
current configuration for the volume
group. If no row has a blank end date,
the volume group is closed, and no
further data will be accepted for that
volume group.

4.10.2.2.2.4 Compression Statistics

Figure 4.10.2-17 displays the window which may be used to view historical compression
statistics information. This window is presented when the Display Statistics button is pressed
from the Volume Group Configuration tab, or when the Compression Factor Statistics button is
pressed from the Modify Volume Groups window.
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Figure 4.10.2-17. Volume Group Compression Factor Statistics Pop-up
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Table 4.10.2-17 provides a detailed description of the Volume Group Compression Factor
Statistics Pop-up window fields.

Table 4.10.2-17. Volume Group Compre ssion Factor Statistics Field Description

Field Name Data Type Size Entry Description

Volume Group character |16 Required An ESDT shortname with version

(ESDT Data Type. identifier.

Version)

Configured character |4 Required The extent to which a file of the specified

Compression data type is currently expected to be

Factor compressed. For example, if the Unix
compression factor were 80%, a 10MB
file would have an expected compressed
size of 2MB using the Unix compress
algorithm.

Suggested character |4 Calculated The recommended compression factor

Compression based on a statistical analysis of

Factor historical compression data for the data
type.

Confidence Level |character |4 Calculated Each of these fields specifies the

(99%, 95%, 90%, minimum compression that may be

85%, 80%) reasonably expected at each of the five
confidence levels, based on statistical
analysis. As the confidence level
increases, the expected minimum
compression factor will drop.

Number of Files  [integer 16 Calculated The number of files of this data type

Compressed which have been compressed to date.

Mean character |4 Calculated The average compression for the set of

Compression files of this data type which have been
compressed to date.

Standard character |4 Calculated A statistical factor which is computed

Deviation based on the variation from the average

compression experienced for files of this
data type. The greater the standard
deviation, the less reliably predictable
the expected compression factor is.

4.10.2.2.3 Resource Management Tab

The Resource Management tab allows the operator to monitor and adjust the availability of given
storage devices as shown in Figure 4.10.2-18.
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Figure 4.10.2-18. Resource Management Tab

4.10.2-42 609-CD-600-001



When the operator highlights a server ID, the related Request IDs appear. Clicking on one of the
Request IDs, the corresponding media IDs are displayed on the screen, and the current known
location and state are displayed for each media.

The following functionality is provided through the three buttons present on the Resource
Management Tab.

Media Type allows the operator to select different media type.

Manage Hardware allows the operator to manage Stackers, Drivers and Slots by means of
the pop-up window shown in Figure 4.10.2-19. Table 4.10.2-19 provides details on the
data fields of the Manage Stackers popup.

Manage Media Sets allows the operator to define and manage groups of logically related
media by means of the pop-up window shown in Figure 4.10.2-21. Table 4.10.2-21
provides details on the data fields of the Manage Media Sets popup.

Table 4.10.2-18 describes the data fields shown in the Resource Management Tab.

Table 4.10.2-18. Resource Management Tab Field Description

Field Name | Data Type | Size Entry Description

Server ID character [N/A |System provided |Server ID for this media type.

Status character [N/A |System provided |Status of the server.

Request ID [character |N/A |System provided [ldentifier of the resource request.

Media ID character [N/A |System provided |Media related to this request (tape.

Location character [N/A |System provided |Location of the media listed in the media ID field
(drive, slot and stacker).

State character [N/A |System provided |State of the media (e.g. Tape writing, distribution
finished, drive loaded, etc.)

Find Media [character |50 |Optional The operator may use the Find Media capability to

locate a specific piece of media, as well as identifying
which request the media is associated with.

4.10.2.2.3.1 Manage Hardware

Figure 4.10.2-19 displays the window which may be used to manage the availability and status
of physical hardware. This window is presented when the Manage Hardware button is pressed.
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Figure 4.10.2-19. Manage Stackers Pop-up
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The following functionality is provided through the several buttons present on the Manage
Stackers window:

Find. The operator may enter information into the field area to search the list for a specific
stacker, device, or piece of media.

Online Status. The scheduling of Stackers, Slots and Drives is allowed through Online
Status buttons. Once a Stacker, Slot or Device has been selected, it can be either put
Online or taken Offline by clicking on the provided button.

Loaded Status button allows the operator change the state of a drive to loaded or unloaded.
Once a Device has been selected, it can be either marked Loaded or marked Unloaded
by clicking on the provided button.

Media ID Assignment. If set to Manual, the operator must manually enter the media ID for
each piece of media loaded. If set to Auto Increment, the operator may enter the first
media ID, and any additional slots to be filled will be assigned media IDs which
sequentially follow the media ID entered by the operator. When using a handheld bar
code reader, the Media ID Assignment button should be set to Manual.

Access Mode button allows the operator to change the access mode of a piece of media to
read only (RO) or read/write (RW).

Table 4.10.2-19 provides a detailed description of the Manage Stackers window fields.

Table 4.10.2-19. Manage Stackers Field Description

Field Name Data Type | Size Entry Description

Stacker ID character [N/A |System Provided |ldentifier of the stacker that is being scheduled

Status character [N/A |System Provided |Current availability of the stacker (online or
offline).

Drive Name character [N/A |System Provided |ldentifier of the drive that is being scheduled.
The Drive Names are displayed corresponding to
the highlighted Stacker ID.

Online Status character [N/A |System Provided |Current availability of the device or slot (online or
offline).

Loaded Status |character |N/A |System Provided |Indicates whether the drive or slot is Occupied or
Empty.

Allocated Status |character |N/A |System Provided |Indicates whether or not the drive or slot has
been allocated for use by a request.

Slot Number integer N/A [System Provided |The slot numbers corresponding to the
highlighted Stacker ID.

Access Mode character [N/A |System Provided |Read-only or read/write.

Media ID character [N/A |System Provided |ldentifier for the piece of media. The barcode
printed on the media is typically used as the
media identifier.

The Media Operations pull-down menu offers several facilities to the operator for loading and
unloading media:

Load Media allows the operator to load one or more pieces of media.
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Unload Media allows the operator to unload one or more pieces of media.

Replace Media allows the operator to both load and unload pieces of media as a single
operation.

Load Media Set allows the operator to load a group of associated media which have been
identified as a media set. Selecting the Load Media Set menu option brings up the
popup shown in Figure 4.10.2-20.

B ToadMedmse |

Load media according to table below.
After media set is loaded. choose OK.

Slot
Number

Media Access
ID Mode

N

Cance1|
-

Figure 4.10.2-20. Load Media Set Pop-up

Table 4.10.2-20 provides a detailed description of the Load Media Set window fields.

Table 4.10.2-20. Load Media Set Field Description

Field Name Data Type | Size Entry Description

Select Media Set |character [N/A |System Allows the operator to select the media set to be
Provided loaded from a pull-down list of available media sets.

Slot Number integer N/A |System The slot numbers corresponding to the highlighted
Provided Stacker ID.

Media ID character |N/A |[System Indicates which media from the media set should be
Provided loaded into the associated slot ID.

Access Mode character |N/A [Optional Indicates whether the media will be loaded with an

Access Mode of read-only or read/write.
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4.10.2.2.3.2 Manage Media Sets Screen
The Manage Media Sets screen is shown in Figure 4.10.2-21.
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Figure 4.10.2-21. Manage Media Sets Pop-up

Table 4.10.2-21 describes the Manage Media Sets window fields.

Table 4.10.2-21. Manage Media Sets Field Description

Field Name | Data Type | Size Entry Description

Media Set |character [N/A |System Provided |The mnemonic identifier used to refer to a logical
aggregation of media.

Media ID character |N/A |[System Provided |ldentifier for a piece of media in the highlighted media
set. The barcode printed on the media is typically
used as the media identifier.

Location character |N/A |[System Provided |Location of the media.

Status character |N/A [System Provided |Status of the media.

The Manage Media Sets window provides three buttons to manage media sets:
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Add Media Set Allows the operator to define a new media set. This brings up the window
shown in Figure 4.10.2-22.

Modify Media Set Allows the operator to add to or remove from the media in the selected
media set. This also brings up the window shown in Figure 4.10.2-22.

Delete Media Set If a media set is selected, this option permits the operator to remove the
definition for the selected media set.

Whether adding or modifying a defined media set, the window shown below in Figure 4.10.2-22
IS presented.
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Figure 4.10.2-22. Add/Modify Media Set Pop-up

Table 4.10.2-22 describes the Add/Modify Media Set window fields.

Table 4.10.2-22. Add/Modify Media Set Field Description

Field Name Data Type | Size Entry Description
Media Set character |N/A |System Provided [The mnemonic identifier used to refer to a
Description logical aggregation of media.
Media ID character |N/A |System Provided [ldentifier for a piece of media in the media set.

The barcode printed on the media is typically
used as the media identifier.

Location character |N/A |System Provided |Location of the media

Status character |N/A |System Provided |Status of the media
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The << and >> buttons permit media to be moved between the list of media in the named media
set and the list of available media which are not in the media set.

4.10.2.2.4 Cache Stats. Tab

This Tab displays all of the files that are in the selected cache, which may be a Read-Only Cache
or the Pull Area (see Figure 4.10.2-23).

It reports general statistics on the entire cache and allows the operator to delete expired liens
against files in the cache area. If the cache reaches an operator configurable threshold the
operator is warned with a message in the operator messages area. If the operator does not delete
expired liens and allows the cache to fill, the server will not be able to copy new files to the
cache area.

When the Mark Delete button is pressed, all liens against the selected item in the list are marked
for deletion. Multiple items may be selected. When the Unmark Delete button is pressed the
delete flag is removed for all items selected in the list.
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Figure 4.10.2-23. Cache Stats. Tab
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Fields belonging to the Cache Stats Tab are described in the following Table 4.10.2-23.

Table 4.10.2-23. Cache Stats. Field Description

Field Name Data Type Size Entry Description
Current Utilization |float N/A system generated |Percent of cache space that is full
Used Space integer N/A system generated |Amount of space in cache that is being

used.

Free Space integer N/A system generated |Amount of space in cache that is free
Total Space integer N/A system generated |The total space in the cache
Number of integer N/A system generated |The number of files in the cache.
Resident Files
Maximum File integer N/A system generated |The size of the largest file in the cache.
Size
Minimum File Size |integer N/A system generated |The size of the smallest file in the cache.
Average File Size [integer N/A system generated |The average size of the files in the

cache.

4.10.2.2.5 Storage Events Tab

This Tab, shown in Figure 4.10.2-24, allows the operator to search for events in the Event Log.
Various search parameters are shown in the Event Log Search Parameter box. When the Search
button is selected, the results are shown in the Event Log box.
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The Clear Parameters button deletes entries made in the Event Log Search Parameters data
fields. The Purge Selected button, when selected, deletes the entries in the Event Log which are
highlighted (“Selected”) by the operator. A context sensitive Help button provides the operator
with information on the listed events,

Table 4.10.2-24 describes the Event Log fields.

Table 4.10.2-24. Event Log Field Description

Field Name Data Type Size Entry Description

Date date/time |21 system generated |Date and time event was entered into the
Event Log. GMT in the format:
mm/dd/yy hh:mm:ss.sss

Level character |11 system generated |Classification of event into various
defined (TBS) Levels.

Type character |10 system generated |Classification of event into various
defined (TBS) Types.

Message character |255 system generated |Message as entered in the Event Log.

Note: the same fields are reported in the “Operator Messages” box in Figure 4.10.2-23. The data
type, size, and the description are the same while the entry is “optional” based on the search
criteria that the operator uses.

4.10.2.2.6 Request Status Tab

This Tab, shown in Figure 4.10.2-25, allows the operator to monitor processing activity in all of
the Storage Management servers for a given mode. The main table lists the requests which are
currently being serviced by Storage Management servers, and those which completed in the last
24 hours. Four filters are provided via the pull-down menu to control how much information is
displayed, so that the operator can focus in on particular areas.
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Figure 4.10.2-25. Request Status Tab
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The Filtering menu provides four filtering options:

Server The Server filter controls what activity is displayed by limiting the list to the requests
being/having been serviced by a specific server. Selecting All displays all requests
throughout the Storage Management CI.

Operation The Operation filter allows the operator to focus on a specific type of operation.
The list of operations is dynamically generated to reflect those operations for which
requests are currently in queue.

Processing State The Processing State filter allows the operator to differentiate between
requests which are being actively processed; which have been completed, either to
successful completion or a retryable error state; or which are suspended, awaiting the
outcome of another event.

Submitter The Submitter filter allows the operator to see the status of requests submitted by
a specific client process. The list of possible clients is dynamically generated to reflect
the list of clients with outstanding requests.

The main area of the Server Activity screen provides a tabular listing of the requests in the
system, as constrained by the various pull-down filters. The columns shown are described in
Table 4.10.2-25. Clicking on any of the column headers will sort the listed requests in order by
the column selected. For example, clicking on the Last Updated column header will list the
requests in order from the least recently updated to the most recently updated.

Table 4.10.2-25. Server Activity Column Description

Column Heading Description
Operation The type of operation represented by the request. For example, an
ArStore operation refers to a Store operation being serviced by an Archive
Server.
Request ID The identifier by which a request can be recognized by operations staff.

Right clicking on a request ID will display the full RPC ID associated with
the request.

Progress The stage of processing which the request is currently working. For
operations which provide incremental progress (e.g., file copies), this may
include a numeric progress indication (e.g., 100 of 750 KB).

Status The status of the request. OK indicates a request which has completed
successfully.

Priority The priority of the request. Requests may have any of the following
priorities: LOW, MEDIUM, HIGH, VHIGH, and XPRESS.

When Submitted The time and date when the request was received by the Storage
Management server which is responsible for the request.

Last Updated The time and date when the status was last updated for the request.

4.10.2.2.7 Storage Management Control Menu Screens Available

The Restart Backup pop-up window, shown in Figure 4.10.2-26, appears by selecting the
Restart option on the Backup menu. This pop-up allows for restarting a backup.
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Figure 4.10.2-26. Restart Backup Pop-up

Table 4.10.2-26 describes the Restart Backup window fields.

Table 4.10.2-26. Restart Backup Field Description

Field Name Data Type Size Entry Description

Filename character 100 system generated |File name which uniquely identifies file.

Start Date date/time 21 system generated |Date and time at the start of the file.
GMT in the format: mm/dd/YY
hh:mm:ss.sss

Backup Transfer |character 9 system generated |Stage of file transfer with respect to the

Stage backup volume group.

Backup Transfer |character 9 system generated |Status of file transfer with respect to the

Status backup volume group.

Offsite Transfer character 9 system generated |Stage of file transfer with respect to the

Stage offsite volume group.

Offsite Transfer character 9 system generated |Status of file transfer with respect to the

Status offsite volume group.

Archive ID character 30 system generated |ldentification of data in Archive files.

Backup ID character 30 system generated |ldentification of data in Backup files.

Offsite ID character 3 system generated |ldentification of Site where files are
located.

Find character 255 optional Allows the operator to perform a keyword
search for items in the Device Name field
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The screen, shown in Figure 4.10.2-27, is presented when the Restart button is pressed from the
Restart Backup window.

_| change priority for backup restart

o |

Figure 4.10.2-27. Change Priority Pop-up

Table 4.10.2-27 describes the Change Priority window fields.

Table 4.10.2-27. Change Priority Field Description

Field Name Data Type Size Entry Description
Change priority for |Toggle N/A optional Allows the operator to change the priority
backup restart button before restarting backup.
Priority character 6 optional Backup may have any of the following
priorities: LOW, MEDIUM, HIGH,
VHIGH, and XPRESS.

Selecting the System Settings menu function from the Options menu shows the pop up window

that allows the operator to select the polling rates for various GUI displays — see Figure 4.10.2-
28.
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The affected parameters are shown in Table 4.10.2-28.

Figure 4.10.2-28. Polling Rate Selection Pop-up

Table 4.10.2-28.

Polling Rate Field Description

Field Name Data Type Size Entry Description

Database integer unlimited |optional Rate at which the event log is update

Polling Rate

Error Retry Rate |integer unlimited |optional Rate at which an update of the event log
is attempted after error condition
detection.

Database integer unlimited |optional Rate at which the cache statistics are

Polling Rate updated

The Ok button implements the new selections and closes the pop-up window.

The Cancel button ignores the changes and closes the window.

4.10.2.3 Required Operating Environment

For information on the operating environment, tunable parameters, and environment variables of
the Storage Management Control Tool refer to the 920-TDx-013 “Custom Code Configuration
Parameters” documentation series . The “x” refers to the installed location, e.g. 920-TDG-013 is

for GSFC DAAC.
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The following 4.10.2-29 table identifies the supporting products this tool depends upon in order
to function properly.

Table 4.10.2-29. Support Products for Storage Management Control

Product Dependence Protocol Used Comments

Sybase SQL Checkpoint, configuration and
request management for the
server.

DCE OODCE Interprocess communication

4.10.2.4 Databases

The Storage Management Tool uses data that is provided by the Storage Management Database.
For details about the Storage Management Database please refer to DID 311-CD-108-005,
Storage Management Database Design and Schema Specifications.

4.10.2.5 Special Constraints

AMASS has to be up in order for the Storage management Tool to archive and retrieve files.
Moreover the FTP server on the ACP host has to have debug logging enabled to write filename
of pulled files to syslog for pull notification to the pull monitor.

4.10.2.6 Outputs
None

4.10.2.7 Event and Error Messages
See Appendix A, Error Messages

4.10.2.8 Reports
None
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